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Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (www.hp.com/
managementsoftware/svi_partner_list), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web 
site and use the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products 
formerly produced by Mercury, we encourage you to visit the Mercury Customer Support 
Web site at: http://support.mercury.com.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 
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Welcome to This Guide

Welcome to the HP Performance Center Administrator’s Guide. This guide 
describes how to use the Performance Center Administration Site to monitor 
and supervise load testing by multiple users.

Performance Center is HP’s Web-enabled global load testing tool, which is 
specially designed to streamline the testing process and increase the test 
efficiency for multiple concurrent load tests across multiple geographic 
locations.

Performance Center consists of two modules:

➤ User Site. Used for conducting and monitoring load tests.

➤ Administration Site. Used for overall resource management, technical 
supervision, and for managing user and project access rights throughout 
Performance Center.

This guide covers the Administration Site. For information about the User 
Site, see the HP Performance Center User’s Guide.

This chapter describes: On page:

How This Guide Is Organized 12

Who Should Read This Guide 13

Performance Center Online Documentation 13

Additional Online Resources 14

Typographical Conventions 15
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Welcome to This Guide
How This Guide Is Organized

This guide contains the following parts:

 Part I Introduction

Introduces you to the Performance Center Administration site.

 Part II Performance Center Resources

Includes information about managing the Performance Center system user 
and other Performance Center resources, including host machines and 
servers.

 Part III Site Management

Includes information about managing test runs, timeslot reservations, and 
events.

 Part IV System Configuration

Describes the System Configuration pages of the Performance Center 
Administration Site, where you configure and view license key information, 
general settings, HP Diagnostics, server configuration information, server 
authentication, and email alerts.

 Part V Performance Center Reports

Describes how to work with Performance Center reports to get an overall 
analysis of Performance Center site users, system resource usage, load test 
runs, and autostart load tests.

 Part VI User and Project Management

Describes the User Management module, which is used for managing user 
information, user roles and privileges, project information, and project-user-
role assignments.

 Part VII Appendixes

Includes instructions for configuring the Performance Center system user 
manually, as well as Performance Center troubleshooting information.
12



Welcome to This Guide
Who Should Read This Guide

This guide is for the following users of Performance Center:

➤ Performance Engineers

➤ Performance Center Administrator

This document assumes that you are moderately knowledgeable about 
enterprise application development and highly skilled in enterprise system 
and database administration.

Performance Center Online Documentation

HP Performance Center includes the following online documentation:

Readme provides last-minute news and information about Performance 
Center. You access the Readme from the Start menu.

What’s New gives a brief description of the new features in this release of 
Performance Center, including links to video walkthroughs. Select 
Miscellaneous > What’s New in the User site.

Books Online/Printer-Friendly Documentation includes PDF versions of the 
Performance Center guides. Select Start > Programs > HP Performance 
Center > Documentation and select the relevant book.

HP Performance Center Online Help is available by clicking the Help button 
at the top of the Performance Center site page or in a dialog box.

HP Performance Center System Configuration and Installation Guide 
explains how to install and configure Performance Center. You access this 
guide from the root directory of the installation disk.
13
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Additional Online Resources

Knowledge Base. This site enables you to browse the Customer Support 
Knowledge Base and add your own articles. The URL for this Web site is 
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp. 

Customer Support Web site. This site enables you to access the Knowledge 
Base, post to and search user discussion forums, submit support requests, 
download patches and updated documentation, and more. The URL for this 
Web site is http://support.mercury.com.

HP Software Web site. This site provides you with the most up-to-date 
information on HP Software products. This includes new software releases, 
seminars and trade shows, customer support, and more. The URL for this 
Web site is www.hp.com/go/software.
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Welcome to This Guide
Typographical Conventions

This guide uses the following typographical conventions:

UI Elements and 
Function Names

This style indicates the names of interface elements on 
which you perform actions, file names or paths, and 
other items that require emphasis. For example, “Click 
the Save button.” It also indicates method or function 
names. For example, "The wait_window statement has 
the following parameters:"

Arguments This style indicates method, property, or function 
arguments and book titles. For example, “Refer to the 
HP User’s Guide.”

<Replace Value> Angle brackets enclose a part of a file path or URL 
address that should be replaced with an actual value. 
For example, <MyProduct installation folder>\bin.

Example This style is used for examples and text that is to be 
typed literally. For example, “Type Hello in the edit 
box.”

CTRL+C This style indicates keyboard keys. For example, “Press 
ENTER.”

[ ] Square brackets enclose optional arguments.

{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument. 

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. In a 
programming example, an ellipsis is used to indicate 
lines of a program that were intentionally omitted.

| A vertical bar indicates that one of the options 
separated by the bar should be selected.
15
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1
Introducing the Administration Site

The Performance Center Administration site is the Web site for 
administrating load tests. 

The customer defines, runs, and analyzes load tests for its Web site from the 
Performance Center User Web site. For details, see the HP Performance Center 
User’s Guide. 

For details on installing the User site and Administration site, see the HP 
Performance Center System Configuration and Installation Guide. 

For details on setting up and configuring HP Diagnostics, see the HP 
Diagnostics Installation and Configuration Guide.

This chapter describes: On page:

About the Administration Site 20

Logging On and Off 21

Moving Around the Site 23

Refreshing the Page 26
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Chapter 1 • Introducing the Administration Site
About the Administration Site

The Performance Center Administration site includes various pages to help 
you manage resources, system configuration, reports, and maintain the site. 
These pages are always available from the left navigation menu. You can 
expand or collapse the menu to show or hide menu links. Click the sideward 
arrow next to a menu item to display the menu links; click the downward 
arrow to collapse the menu. 

Performance Center provides context-sensitive help which enables you to 
get specific information about whatever part of the Administration site you 
are using at any given moment. Context-Sensitive Help is available from the 
Help link at the top of the page, or from the Help button in a dialog box.

Performance Center version and patch information is available from the 
About link at the top of the page.

From the Administration site, you can:

➤ Manage Performance Center servers, monitor the server status, edit server 
information, and check server performance

➤ Manage Performance Center hosts, controlling how hosts are allocated to 
test runs

➤ Manage timeslots, view user reservations, and monitor availability of time 
and resources

➤ Manage test runs, view all the tests in the system, and see which ones are 
running at any time

➤ Manage any events that occur during test runs

➤ Manage your license information

➤ Manage user requests

➤ Manage general system configuration information

➤ View and supply specific System Configuration information

➤ Analyze Performance Center reports

➤ Manage users and user privileges
20



Chapter 1 • Introducing the Administration Site
Logging On and Off

You log on to the Administration site from the URL of the directory on 
which you installed Performance Center.

Important: If this is the first time you are logging on to the system, you need 
to perform some initial system configuration. In this case, the Performance 
Center system user must have administrative privileges.

To log on to the Administration site:

 1 Type the path to the Performance Center Administration Site installation 
directory, for example, http://<Server_Name>/admin. 

If this is the first time you are entering the system, a system configuration 
page opens: 

The page asks you to supply some basic information that is used to 
configure your system.
21



Chapter 1 • Introducing the Administration Site
The System Configuration page displays the following information:

Database

➤ DB host. The machine on which the database resides. If you are using 
Oracle, enter the TNS name defined in your tnsnames.ora file.

➤ DB type. The type of Database installed on the server—either SQLServer 
or Oracle.

➤ User. The user name to connect to the Database.

➤ Password. The password to connect to the Database.

File Server

➤ Name. The name of the machine that contains the File Server installation 
where system files such as scripts are stored.

After you supply the necessary information, click Save.

Note: If Performance Center detects an existing database, a message is 
displayed asking you if you want to use the existing database as part of your 
configuration. Click Continue to use the existing database.

A log listing details of the system configuration process is displayed in the 
lower-left corner of the page. 

If the configuration is not successful, the log provides a detailed message to 
help you correct the problem. After correcting the problem, repeat the save 
process.
22



Chapter 1 • Introducing the Administration Site
If the configuration is successful, click the Log to Site button. The 
Performance Center Administration Site Login page opens. 

 2 In the User Name box, type your user name. The first time you log on, use 
the default user name “Admin”. After you have logged on, you will be able 
to modify your user name and password for the future.

 3 In the Password box, type your password. The first time you log on, use the 
default password Admin.

 4 Click Login. The Administration Site opens.

Note: If this is the first time you are logging on to the system, you are 
redirected to the System Configuration page and asked for additional details 
to complete your system configuration. For more details, see “Supplying 
Server Configuration Information” on page 148.

To log off:

Click the Logout button in the upper-right corner of the Administration site 
window.

Moving Around the Site

To move to a page, click the page name in the left navigation menu. The 
available pages are:

Resources

➤ Hosts. Displays the allocation and availability of Performance Center 
host machines. You can add and remove hosts from the system, define 
each host’s testing function, prioritize host allocation, and monitor host 
state. For details, see Chapter 3, “Managing Hosts.”

➤ MI Listeners. Displays an editable list of MI Listeners that enable you to 
run Vusers over a firewall. For details, see Chapter 4, “Managing MI 
Listeners.”
23
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➤ Host Locations. Displays an editable list of host locations and whether 
they are within or over the firewall. For details, see “Managing Host 
Locations” on page 72.

➤ Host Pools. Displays groups of hosts that you defined in order to control 
which hosts may be accessed by which projects. For details, see 
Chapter 5, “Managing Host Pools.”

➤ Servers. Displays information about the Performance Center server 
machines. You can monitor server status, edit server information, and 
check server performance. For details, see Chapter 6, “Managing Servers.”

Site Management

➤ Test Runs. Displays the state of test runs. For details, see Chapter 7, 
“Managing Test Runs.”

➤ Timeslots. Displays timeslot reservations and availability. For details, see 
Chapter 8, “Managing Timeslots.”

➤ Event Log. Displays reported events and errors. For details, see Chapter 9, 
“Managing Events.”

System Configuration

➤ License. Displays license information. For details, see Chapter 11, 
“Configuring and Viewing License Information.”

➤ General Settings. Displays general system configuration information. For 
details, see Chapter 12, “Configuring General Settings.”

➤ Diagnostics. Displays a list of mediator machines upon which you can 
run ERP/CRM Diagnostics and information about the J2EE/.NET 
Diagnostics server environment. You can add additional mediators or 
configure the J2EE/.NET Diagnostics server environment from this page. 
For details, see Chapter 14, “Configuring Diagnostics.”

➤ Server Configuration. Displays where key components of Performance 
Center are located. For details, see Chapter 13, “Configuring Server 
Information.”

➤ Authentication Server. Displays the authentication configuration details 
for logging on to Performance Center. For details, see Chapter 15, 
“Configuring Server Authentication.”
24
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➤ Alerts Configuration. Displays the alert conditions and email preferences. 
For details, see Chapter 16, “Configuring Alerts.”

Reports

➤ Site Users. Displays individual user information.

➤ Resource Usage. Displays system resource usage information.

➤ Test Run Information. Displays general information about the test run.

➤ Autostart Viewer. Displays information about autostart load tests.

For details, see Chapter 18, “Understanding Performance Center Reports.”

User Management

➤ Personal Information. Displays the personal information of the currently 
logged on user. For details, see “Managing Your Personal Information” on 
page 201.

➤ Users. Displays a list of users and user information. For details, see 
“Managing User Information” on page 202.

➤ Roles. Displays a list of user roles and the permissions included in each 
role. For details, see Chapter 20, “Defining User Roles.”

➤ Privilege Management. Displays a list of Performance Center containers 
and user-role assignments in these containers. For details, see 
Chapter 21, “Managing User Privileges.”

➤ Projects. Displays a list of Performance Center projects and project 
information. For details, see Chapter 22, “Managing Performance Center 
Projects.”
25



Chapter 1 • Introducing the Administration Site
Refreshing the Page

You can refresh and alter the auto-refresh frequency for the Resources and 
Site Management pages in the Administration Site.

To refresh the page:

➤ Click the Refresh Now button in the upper-right corner of the page. The 
information on the page is updated.

To modify the default refresh rate: 

 1 Click the Refresh Frequency button in the upper-right corner of the page. 
The Refresh Frequency dialog box opens.

 2 Select an auto-refresh frequency from the list and click OK. By default, the 
page is refreshed every 90 seconds.

To close the Refresh Frequency dialog box without altering the refresh rate, 
click Close.
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2
Performance Center System User 

The Performance Center Administration Site server is installed with the 
System Identity Utility. Using this utility, you can manage the Performance 
Center system user (by default, IUSR_METRO) for all servers and hosts in the 
Performance Center environment from one convenient centralized location. 

About Performance Center System User

During installation of Performance Center servers and hosts, a default 
Performance Center system user, IUSR_METRO, is created in the 
Administrators user group of the server/host machines.

To prevent security breaches, you can replace Performance Center’s default 
system user by creating a different local system user, or by using a domain 
user. 

For stronger security, you can create a non-administrator Performance 
Center system user in a local group under the Users group. This system user 
has the permissions granted to any user in the Users group with extended 
rights to Web services and the HP file system and registry. 

This chapter describes: On page:

About Performance Center System User 29

Changing the System User 31

Checking Host Status 36

Remote Performance Center Server and Host  Administration 37
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Chapter 2 • Performance Center System User
With these limited permissions, such a system user cannot perform all 
administrative system tasks. You need to specify a configuration user (a user 
with administrative privileges that is defined on all the Performance Center 
servers and hosts) that Performance Center uses when administrative tasks 
are required on the system. After the tasks are complete, the system user 
reverts back to itself, with its limited Performance Center User permissions.

Note: You can save the configuration user in the database so that whenever 
an administrative-level system user is required to perform a task, the system 
automatically uses the configuration user, without asking for its credentials.

The Performance Center Administration Site server is installed with the 
System Identity Utility that enables you to manage the Performance Center 
system user for all servers and hosts in the Performance Center environment 
from one centralized location.

Using this utility, you can periodically update the Performance Center 
system user name and password. For more information, see “Changing the 
System User” below.

For information about troubleshooting the Performance Center system 
identity, see “Troubleshooting System Identity” on page 304.
30



Chapter 2 • Performance Center System User
Changing the System User

You use the System Identity Utility, installed with Performance Center, to 
change the system user for all servers and hosts in the Performance Center 
environment.

When you change the system user, or a user’s password, the System Identity 
Utility updates all the Performance Center servers and host machines. 

Notes: 

➤ You cannot change the system user while a load test is running. 

➤ For Windows 2000, the login user on the Administration site server must 
have the Act as part of the operating system policy to run this System 
Identity Utility.

Important: In the case of a domain user, when the domain IT team notifies 
you that the password is to be changed, you need to temporarily change the 
Performance Center system user on all the servers and hosts to a different 
user. After the domain IT team has changed the password of the domain 
user and has notified you of this change, you need to change the 
Performance Center system user back to the domain user on all the servers 
and hosts.
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Chapter 2 • Performance Center System User
To change the system user:

 1 In the Performance Center Administration site server installation’s bin 
directory, open the System Identity Utility (<PC Admin Site Server 
Installation directory>/bin/IdentityChangerUtil.exe).

The System Identity Utility opens and displays the Performance Center 
system user name and status for all server and host machines in the 
Performance Center environment.

Note: The System Identity Utility does not display UNIX machines, or 
machines that are located over the firewall.
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Chapter 2 • Performance Center System User
 2 In the Performance Center User area: 

 a Select the type of change that you want to make to the user.

➤ Password Only. Select this option to change the current user’s 
password only. (Regarding change the password of a domain user, see 
note before this procedure.)

➤ User. Select this option to change the Performance Center system user. 

 b Enter the required information according to the type of change you 
selected.

 c If you are changing the user, you can delete the previous user from the 
computer. To delete the previous user, select Delete Old User. 

Note: You cannot delete a domain user.

 3 In the User Group area, select the type of group to which the user is to 
belong:

➤ Administrator Group. Creates a user in the Administrators group with 
full administrator policies and permissions.

➤ Other. Creates a local group under the Users group, granting User policies 
and permissions as well as other Performance Center permissions.

If you selected Administrator Group, continue with step 5.

 4 If you are creating a non-administrator Performance Center system user, you 
need to configure a configuration user (a system user with administrative 
privileges) that the Performance Center system user can impersonate when 
it needs to perform administrative tasks (see “About Performance Center 
System User” on page 29). 

 a In the Configuration User area, enter the name and password of a system 
user that has administrator privileges on all the Performance Center 
servers and hosts. 

 b To save the configuration user on the Performance Center database, 
select Save Configuration in Database. If you save the configuration user 
in the database, the Performance Center user automatically impersonates 
this user whenever necessary, without asking for credentials each time.

Note: For the Task Manager to perform IIS Reset, the configuration user 
must be saved in the database. 
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Chapter 2 • Performance Center System User
 5 Click Apply. The utility updates all the Performance Center servers and 
hosts, starting with the Administration Site server. 

In the lower part of the utility window, the Machines table displays the 
status of each machine during the configuration process:

If the utility is unable to change the user on the Administration Site server, 
it stops the configuration, rolls back the change on that server, and issues a 
message explaining why the change cannot be made. Correct the error and 
click Apply again.

After successful configuration of the Administration site server, if the utility 
is unable to change the user on a particular server, the utilty stops, rolls back 
the change on that server, and issues a message explaining why the change 
cannot be made. Correct the error and click Reconfigure. The utility starts 
running again. 

Status Description

Configuration complete The system user configuration was completed

Needs to be configured The server/host is pending configuration

Displayed only after the Administration Site server 
configuration is complete

Configuring.... The server/host in being configured

Configuration failed The server/host configuration failed

The utility displays the reason for failure together 
with this status
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Chapter 2 • Performance Center System User
When configuration completes successfully on all the servers, Performance 
Center proceeds with the configuration of the hosts. The utility attempts to 
configure all the hosts, even if the configuration on one or more hosts is 
unsuccessful. In this case, after the utility has attempted to configure all the 
hosts, correct the errors on the failed hosts, and click Reconfigure. The 
utility runs again on the whole system. 

Note: If the configuration continues to fail, you can configure servers and 
hosts manually. However, all attempts should be made to correct errors that 
cause the configuration to fail. Manual configuration should be left as a last 
resort. For details on configuring servers and hosts manually, see 
Appendix A, “Configuring Performance Center  System User Manually.”

 6 When configuration is complete on all the servers and hosts, close the 
System Identity Utility window. 

In the Performance Center Administration site, the name of the new user is 
displayed on the General Settings page under the Global settings.

Note: To run a load test after changing the system user password, you need 
to wait approximately 20 minutes, or reboot all of the hosts. 
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Checking Host Status

You can check that the system user name and password are properly 
configured on the host machines from the Check Hosts dialog box.

To check the host machines:

 1 From the Hosts page, select the hosts that you want to check and click the 
Check Hosts button. The Check Hosts dialog box opens displaying the 
selected hosts together with an icon next to the host name indicating the 
host’s purpose.  

 2 Click Check Hosts.

If the system user name and password are properly configured, green 
checkmarks are displayed in the File Server, Database, and Ping URL 
columns.

Note: To ping to a host or to a URL, the system user must be a user with 
administrator privileges.

For additional host checks, see “Checking Hosts” on page 70.
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Remote Performance Center Server and Host 
Administration

To perform administrative tasks on Performance Center servers or hosts 
(such as adding, configuring, or resetting a Performance Center server/host), 
Performance Center must use a user with administrative privileges. This 
must be the Performance Center system user with administrative privileges 
or a configuration user.

When the Performance Center system user has administrative privileges and 
is defined on the remote machine, the task is performed upon request. 

However, in the following cases you are prompted for a configuration user:

➤ If the Performance Center system user has administrative privileges, but 
is not defined on the remote machine

➤ If the Performance Center system user does not have administrative 
privileges, and the configuration user is not saved in the database (see 
step 4 of “Changing the System User” on page 31)

Note: When the configuration user is a domain user, you must supply the 
fully qualified domain name.

After validating the Performance Center system user or configuration user, 
Performance Center can perform the required task. If the Performance 
Center system user is not defined on the remote machine, it is created at 
this point. (If the Performance Center system user is a domain user, the 
required task is performed but the user is not created on the remote 
machine.)
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Important: If the Performance Center system user is a non-administrative 
user and the configuration user is not saved in the database, Performance 
Center prompts you for the configuration user credentials every time it 
needs to perform an administrative task. To avoid having to enter the 
credentials each time, save the configuration user in the database as 
described in step 4 of “Changing the System User” on page 31.
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Managing Hosts

Host machines are used for test runs. Managing the host machines involves 
adding and removing hosts from the system, defining each host’s testing 
function, prioritizing host allocation, monitoring host conditions, and 
identifying the host location.

This chapter describes: On page:

About Managing Performance Center Hosts 40

Understanding the Hosts Page 40

Adding Hosts 46

Editing Host Details 53

Managing Host Details 54

Rebooting Hosts 63

Uploading and Installing Patches 64

Understanding Host Allocation 68

Handling Resource Failure 69

Checking Hosts 70

Managing Host Locations 72

Removing Hosts 74
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About Managing Performance Center Hosts

The Administrator manages the information stored in the system about the 
hosts. Performance Center uses the information to allocate hosts to load test 
runs. This involves defining the purpose of each host, controlling which 
projects can use which hosts, prioritizing the use of certain hosts over 
others, monitoring host performance, checking the condition of the hosts, 
and following up on any operation problems.

Performance Center gives a user the ability to create a load test from the 
main site. The load test specifies how many hosts it requires and reserves the 
necessary number of hosts for a specific time period. Since the availability of 
hosts is limited, Performance Center allocates specific time periods called 
timeslots. Reserving a timeslot, actually reserves the required hosts for the 
specified timeslot.

When the user tries to reserve a timeslot, Performance Center allocates hosts 
according to parameters that you control from the Hosts page in the 
Administration site.

Understanding the Hosts Page

The Hosts page displays information about the host machines in the 
Performance Center system, and enables you to reboot hosts, install 
patches, check host connectivity, add and delete hosts, and modify host 
details.

To access the Hosts page:

➤ On the Performance Center left menu, select Resources > Hosts. The Hosts 
page opens.

The Hosts page is comprised of the following areas:

➤ Filter area. Enables you to set the number of hosts displayed, and filter 
the Hosts table according to pool, location, name, and run status criteria. 
For more information, see “Filter Area” on page 41.

➤ Hosts table. Displays information about the hosts in the Performance 
Center system, and enables you to perform actions on the hosts. For 
more information, see “Hosts Table” on page 42.
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➤ Edit Details for Host area. Enables you to modify host details. For more 
information, see “Editing Host Details” on page 53.

Filter Area
The Filter area of the Hosts page enables you to customize the host 
information displayed. You can set the number of hosts displayed on the 
page, and filter the host display.

Setting the Number of Hosts Displayed

You can set the number of hosts that are displayed on the page. You can 
choose to display 10, 20, 50, 100, or all hosts on a page.

To set the number of hosts displayed:

 1 In the Filter by section, in the Per Page list, select the number of hosts to 
display per page.

 2 Click Filter. The display updates according to the option you choose.

Filtering the Hosts Display

You can use the filter lists to display a specified subset of the hosts, 
according to pool, location, name, and run status criteria.

To filter the display:

 1 From one or more of the filter lists, select the desired filtering options.

Note:

➤ In the Pool list, pool names that are marked with an asterisk (*) are 
merged pools. For more information about merged pools, see “Assigning 
Merged Pools to Projects” on page 84.

➤ The Run Status options are:

➤ All Statuses. Displays all hosts regardless of status.

➤ Idle. Displays hosts in the following states: Finished, Run Failure, Failed 
Collating Results, Failed Creating Analysis Data, Deleting Temporary 
Results, Temporary Results Deleted. A short time after the run, it also 
displays hosts in the Collating Results, Creating Analysis Data, Before 
Collating Results, and Before Creating Analysis Data state.
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➤ Run. Displays hosts in the following states: Ready, Running, Stopping. 
Immediately after the run, it also displays hosts in the Collating 
Results, Creating Analysis Data, Before Collating Results, and Before 
Creating Analysis Data state. 

 2 Click Filter. The display updates according to the options you choose.

Hosts Table
The Hosts table displays the host details. You can sort the table by any of the 
columns. For instructions on sorting the table, see “Sorting the Hosts Table” 
on page 45.

The Host table displays the following information about the hosts:

➤ Status light. An indicator of the current system performance of the host, 
represented by a color. A combination of the State and the SiteScope 
measurement determines the indicator color. A color other than green is a 
warning that the system performance is less than optimal and warrants 
investigation. The performance is assessed according to four parameters: 
CPU usage, memory usage, disk space, and running services. There is a 
threshold for each parameter. If a Performance Center service stops for any 
reason, the machine state turns red (Error). For an explanation of the 
indicator color and the associated host state, see the table in the State 
description below.

➤ Name. The host name that you assign when you add a new host. You can 
click the name to open the Host Details page for the host. For details, see 
“Managing Host Details” on page 54.

➤ Purpose. The type of purpose configuration on the host machine.

Icon Purpose Description

Controller The Controller host manages the load test. Each 
test requires one host as a Controller. 

Load Generator Load generator hosts run the Vusers in a load test. 
There can be any number of load generators in a 
given test. 
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➤ Pool. The host pool to which the host is assigned. Host pools allow you to 
control which hosts are allocated to which projects. When allocating hosts 
for a test, the system allocates hosts with the pool specified for the project in 
the project profile. For more information about host pools, see Chapter 5, 
“Managing Host Pools.”

➤ Location. Describes the location of the host so that you can determine if the 
host is within or outside the firewall.

➤ State. The state of the host. An indicator is displayed next to the host name, 
according to its current state. The following table lists the possible states and 
the associated indicator color.

Controller + 
Load Generator 

Enables you to use the host as a Controller and a 
load generator. You can use the Controller as a 
load generator, and assign Vusers to run on the 
Controller. This type of configuration is not 
recommended.

Data Processor The data processor is used for publishing 
information to the Dashboard. Although it is 
possible to configure a machine as a Controller 
and a data processor, it is not recommended.

Indicator Host State SiteScope Status

 (green) Operational Host is operational.

 (yellow) Operational Some measurements are out of range, but the 
host is still operational.

 (red) Operational Indicates that at least one of the performance 
parameters is outside of its threshold, and it is 
not recommended to run tests on this host.

 (red) Resource Failure Host is not operational. You should try to fix 
the problem, then change the condition back 
to Operational. If the system detects that the 
host is still not working, the condition reverts 
to Resource Failure.

Icon Purpose Description
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➤ Run Name. The name of the load test that is currently running on the host.

➤ Run Status. The status of the load test that is currently running on the host. 
This field applies only to hosts that are in the Running state. Click the 
Running link to display information for the current run. The Last Run 
Information page contains data only if there is an active run.

➤ Run Time. The start time of the load test that is currently running on the 
host.

 (gray) Unavailable The user manually changed the host status to 
Unavailable.

 (gray) Maintenance An installation is taking place.

 (gray) Rebooting Host reboot is taking place. Displays the time 
(MM:SS) since the rebooting process started.

 (gray) Transferring X% A patch is being transferred from the File Server 
to the host. The percentage shows the progress 
of the patch transfer.

 (gray) Installing X% A patch installation is taking place. The 
percentage shows the progress of the patch 
installation.

Indicator Host State SiteScope Status
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➤ Project. The name of the project that is currently running in the load test on 
the host.

➤ User. The name of the user that is currently running the load test on the 
host.

Below the Hosts table, you can perform the following actions:

➤ Reboot. Enables you to remotely reboot host machines from the 
Administration site. For more information, see “Rebooting Hosts” on 
page 63.

➤ Install Patch. Enables you to remotely install patches on hosts. For more 
information, see “Uploading and Installing Patches” on page 64.

➤ Check Hosts. Enables you to check the connections between various host 
machines within your system. For more information, see “Checking Hosts” 
on page 70.

➤ Delete. Enables you to remove hosts from the Hosts list. For more 
information, see “Removing Hosts” on page 74.

➤ Add Host. Enables you to add hosts to the Hosts list. For more information, 
see “Adding Hosts” on page 46.

To perform actions on all the Performance Center hosts, select all hosts by 
selecting the check box at the top of the check box column. To clear all 
check boxes at once, clear the check box at the top of the check box 
column.

Sorting the Hosts Table

You can sort the hosts according to the values in any column.

To sort the hosts:

Click the column heading of your choice. A downward facing arrow is 
displayed next to the column heading. The hosts are sorted in descending 
order of the values in that column.

When you click the heading again, the arrow reverses direction, and the 
hosts are sorted in ascending order of the values in that column.
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Adding Hosts

You can add hosts in the Hosts page. When you add a host and enter its 
details, the system uses these values to allocate hosts for test runs. For 
details, see “Understanding Host Allocation” on page 68.

To add a new host:

 1 In the Hosts page, click Add Host. The Add Host dialog box opens. 

 2 In the Name box, type a unique name for the host.

 3 In the OS Type box, select the operating system of the host. This can be 
either Windows 2000/2003/XP or UNIX. If you select a UNIX operating 
system, you must provide the UNIX configuration information as described 
in “Configuring Remote UNIX Machines” on page 49.
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 4 In the Purpose box, select a purpose to assign to the host. That is: 

➤ Controller

➤ Load generator

➤ Controller + load generator

For more information about host purposes, see “Assigning a Purpose to a 
Host” on page 52.

Note: If the host is located over the firewall or is a UNIX machine, the only 
purpose it can be assigned is Load Generator.

 5 In the Priority box, type a priority number.

You assign a priority to each host. The system allocates hosts with higher 
priority in preference to those with lower priority. There are a number of 
criteria to consider when assigning priority. The main considerations are 
whether the host a dedicated machine or a shared resource and the type of 
hardware installed on the machine.

 6 In the Location list, select the host’s location. When you select the location, 
if it is over a firewall, the MI Listener list becomes enabled. For more 
information about host locations, see “Managing Host Locations” on 
page 72.

 7 If you selected a location over a firewall, you need to select an MI Listener 
that will enable data collection. In the MI Listener list, select an MI Listener. 
For information about adding MI Listeners, see Chapter 4, “Managing MI 
Listeners.”

Note: The MI Listener list is available only when the host is located over a 
firewall.

 8 In the Host Pool list, select a host pool to which to assign the host. A host 
can be assigned to a single pool only. For more information on host pools, 
see “Adding New Pools” on page 87.
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 9 In the State list, select the appropriate description of the host state (possible 
states are Operational, Unavailable, Resource Failure, or Maintenance).

 10 In the Comments box, type any relevant information about the host.

 11 To enable SiteScope monitoring of the host, select Enable SiteScope 
Monitoring. 

Note: 

➤ SiteScope must be installed on a server in the Performance Center 
environment. You can install SiteScope on the same machine as the 
Controller, or on a dedicated server.

➤ Disk performance counters are disabled by default in standard Windows 
2000 installations. To monitor disk drives using the SiteScope Disk 
monitor on machines running Windows 2000, you must enable these 
disk counters. Run the diskperf -y command line on each Windows 2000 
machine you want to monitor disk space, then reboot the machine. 
Select the disk drives to monitor from the machine’s Resource Status tab.

 12 If you selected a UNIX operating system, the Add Hosts dialog box includes 
a Configuration for Unix section. Provide the UNIX configuration 
information as described in “Configuring Remote UNIX Machines” on 
page 49.

 13 Click Save to add the host. 

If you are prompted for the configuration user credentials, enter them and 
click OK. 

Note: 

➤ For more information about the configuation user prompt, see “Remote 
Performance Center Server and Host  Administration” on page 37.

➤ When supplying the credentials of a domain system user, you must enter 
the fully qualified domain name.
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Configuring Remote UNIX Machines
You configure the remote machine according to the platform your machine 
is running on. If you selected a UNIX operating system, the Configuration 
for UNIX section is displayed in the Add Hosts dialog box. 

Provide the following information to configure the remote UNIX machine:

➤ User Name. Type the user name of the UNIX host machine.

➤ Password. Type the user password of the UNIX host machine.

➤ OS. Select the operating system running on the remote server. The following 
versions of UNIX are supported: AIX, HP/UX, HP/UX 64-bit, Linux, and Sun 
Solaris.

➤ Connection Method. Select the method of connecting to the host machine. 
The supported methods are: 

➤ Telnet. Log in to the remote server using Telnet.

➤ Rlogin. Log in to the remote server using the Rlogin protocol.

➤ HTTP. Connect to an HTTP server on the remote server and run the 
command using a CGI. For this method, the Login and Password are 
optional and are used for authorizing the log on to the remote machine if 
required.

➤ Prompt. Type the prompt to be displayed when the system is ready to 
handle a command - the default is #.

➤ Login Prompt. Type the prompt to be displayed when the system is waiting 
for the login to be entered - the default is "login:".
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➤ Password Prompt. Type the prompt to be displayed when the system is 
waiting for the password to be entered - the default is "password:".

➤ Secondary Prompt. Type the prompt to be displayed if the telnet connection 
to the remote server causes the remote server to prompt for more 
information about the connection. Separate multiple prompt strings by 
commas (,). For example, for Telnet connections to some remote servers, the 
remote server may ask what terminal type should be emulated for the 
connection. In this case you might need to type Terminal type? as the 
secondary prompt. The response to the secondary prompt is entered in the 
Secondary Response field below.

➤ Secondary Response. Type the responses to secondary prompts required to 
establish connections with this remote server. Separate multiple responses 
with commas (,). 

➤ Initialize Shell Environment. Type any shell commands to be executed at the 
beginning of the session. Separate multiple commands with a semicolon (;). 
This option allows you to specify shell commands to be executed on the 
remote machine directly after a Telnet or SSH session has been initiated. 
These commands can be used to customize the shell for each SiteScope 
remote. 

Examples:

➤ The remote shell may not have the correct path set for SiteScope scripts to 
run. The following command will add the directory /usr/local/bin into the 
PATH of the current shell on the remote machine:

➤ The remote shell may not be initializing the pseudo terminal correctly. Type 
the following command to increase the terminal width to 1024 characters:

Note: Commands after a shell invocation will not be executed.

export PATH=$PATH:/usr/local/sbin

stty cols 1024;${SHELL}
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➤ There have been cases where the remote Telnet Server does not echo back 
the command line properly. This may cause strange behavior for monitors 
that rely on this behavior.

Type the following command to force the remote terminal to echo:

➤ Certain UNIX shells have been known to behave erratically with SiteScope. 
This includes bash, ksh, and csh. Type the following command to change 
the shell to sh for the SiteScope connection:

stty echo

/bin/sh
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Assigning a Purpose to a Host
The purpose is the function that you assign to each host. A host can be 
allocated any of the following purposes:

➤ Controller. The Controller host manages the load test. Each test requires one 
host as a Controller.

➤ Load Generator. The Load Generator hosts run the Vusers in a load test. 
There can be any number of load generators in a given test.

➤ Data Processor. The Data Processor host is used for publishing information 
to the Dashboard.

Note: 

➤ To provide greater flexibility (especially where resources are scarce), you 
can allocate a host with dual purposes as a Controller and Load 
Generator. It is not recommended to use Controllers as Load Generators. 
When allocating machines, the system tries to use single function 
machines before dual purpose Load Generator and Controller machines.

➤ Although it is possible to set a machine as a Controller and a Data 
Processor, it is recommended to set up a separate Data Processor 
machine.

➤ A machine that is located over the firewall or is a UNIX machine can 
only be assigned the purpose of Load Generator.
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Editing Host Details

You can view and edit host information for one or multiple hosts in the Edit 
Details for Host area on the Hosts page.

This area displays the following settings:

➤ Priority. A rank assigned to the host. The higher the priority you give the 
host, the more likely the host will be allocated to a test. In this case, you 
would set the priority according to the performance of the hosts. You assign 
this value when you add a host, and you can edit it for any host.

➤ State. The state of the host. The possible states are: Operational, 
Unavailable, Resource Failure, and Maintenance. Additionally, temporary 
states of Rebooting, Transferring, or Installing are assigned while a machine 
goes through a rebooting or patch installation process. 

If the host is in the Resource Failure state, try to fix the problem, then 
change the condition back to Operational.

➤ Pool. The host pool to which the host is assigned. For more information, see 
“Understanding Pool Resources” on page 82.

➤ Comments. Relevant information about the host.

➤ OS. The host operating system.

➤ Details. Opens the Host details pages, allowing you to view and edit host 
properties, statuses, processes, logs, and runs. For more information, see 
“Managing Host Details” on page 54.
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To edit host settings from the Edit Details for Host area:

 1 Select the desired hosts in the Hosts table. The selected hosts are displayed 
in the Edit Details for host list.

 2 Edit the desired settings. You can edit the host’s priority, state, and pool, and 
any comments related to the host. To edit other details, click the Details 
link, or click the name of the host in the Hosts table. For more information, 
see “Managing Host Details” on page 54.

Note: If multiple hosts are selected, Performance Center displays only those 
settings that are identical for all the selected hosts. If settings differ, the box 
remains empty. The Details link is not available when multiple hosts are 
selected.

 3 Click Save to save changes to the hosts. Performance Center displays a 
message informing you that the details were successfully saved. If you move 
away from the page without saving the changes, the settings are not saved.

Managing Host Details

You view and manage host details from the Host details page. In the Host 
details page you can view and edit host properties, status, processes, logs, 
and runs.

To access the Host details page:

 1 From the Hosts page, click the name of any host, or select a host and click 
the Details link in the Edit Details for host area. The Hosts page displays the 
details for the selected host.

 2 Select a tab to view or edit the Host information, as follows: 

➤ Properties tab. Allows you to view and edit host properties.

➤ Status tab. Allows you to view the host status and to perform host 
connectivity checks.

➤ Processes tab. Allows you to view and end processes on a host.
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➤ Logs tab. Allows you to view detailed information about the tasks 
performed on the host, the action status, and a description of any errors.

➤ Runs tab. Allows you to view runs on a specific host.

To return to the Hosts page:

Click the Hosts link at the top of the Hosts detail page.
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Host Properties Tab
The Properties tab provides general information about the host. In this tab 
you can edit host information, and enable SiteScope monitoring. 

The Host Properties tab displays the following details:

➤ Host Name. The name given to the host when it was added to the system.

➤ Host Logical Name. The logical name given to the host when it was added to 
the system.

➤ OS Type. The host operating system.

➤ Purpose. The function the host performs in a test run. You define a host as a 
Controller, Load Generator, Controller + Load Generator, or Data Processor.

➤ Comments. Any relevant information about the host.
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➤ Priority. A rank assigned to the host. The higher the priority you give the 
host, the more likely the host will be allocated to a test. 

➤ Location. The geographical location of the host.

➤ MI Listener. For hosts located over a firewall, the IP address or name of the 
MI Listener that enables data collection.

➤ Host Pool. The host pool to which the host is assigned.

➤ Allocation. The number of timeslot to which the host is allocated. 0 means 
the host is not allocated.

➤ State. The state of the host. The possible states are; Operational, 
Unavailable, Resource Failure, and Maintenance. Additionally, temporary 
states of Rebooting, Transferring, or Installing are assigned while a host goes 
through a rebooting or patch installation process.

When the Remote Machine Agent or SiteScope Monitoring are enabled, the 
following Login information is displayed:

➤ User Name. The user name of the host. 

➤ Password. The password of the host.

➤ Domain. The host domain.

➤ Installed Components. A list of components installed on the host, 
including version and patches.
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To edit host properties:

 1 Click the Properties tab, and click Edit. The Properties tab is displayed with 
editable fields.

 2 Edit the desired fields, as described in “Adding Hosts” on page 46. 

 3 Click Save to update the host properties, or click Cancel to disregard any 
changes made.

 4 Click the Hosts link at the top of the page to return to the Hosts page.
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Host Status Tab
The Check Host area of the Status tab provides information about the 
connections between the selected host and various machines within your 
system. You can also check whether the host is able to create an active 
session. For more details on checking connections, see “Checking Hosts” on 
page 70.

If SiteScope monitoring is enabled, the SiteScope Data table displays 
detailed information about the host, as collected by the SiteScope monitor. 
For more information, see “Adding Hosts” on page 46 and the HP 
Performance Center System Configuration and Installation Guide. 

All functions are automatically performed when the tab is opened, the page 
is refreshed, or when you click the Check Host button. 
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If you want the selected host to ping a remote site, type the URL address in 
the Ping to URL box and click Check Host. Performance Center displays the 
results in the Ping to URL Status field.

Note: To ping to a host or to a URL, the Performance Center system user 
must have administrator privileges.

Click the Hosts link at the top of the page to return to the Hosts page.

Host Processes Tab
The Processes tab provides detailed information about the processes and 
resource usage of the selected host. 
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To end a process, click the Kill Process button in the process’s Kill column.

Click the Hosts link at the top of the page to return to the Hosts page.

Note: Performance Center is unable to display processes and resource usage 
information for UNIX machines.

Host Logs Tab
The Logs tab provides detailed information about the tasks performed on 
the selected host, the action status, and a description of any errors. 

You can filter the information by a specific time frame, refresh the table to 
view the most current tasks, and clear the log. 

To view log files for the action, click the error description link.

Click the Hosts link at the top of the page to return to the Hosts page.
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Host Runs Tab
The Runs tab provides detailed information about load test runs performed 
on the selected host. 

You can filter the information by a specific time frame and refresh the table 
to view the most current tasks. You can also sort the information by clicking 
the header of any column in the table.

The Run Details table displays the following details about each test run: 

➤ Run ID. The identification number of the test run. This number is 
automatically generated by the system when the load test starts running.

➤ Date. The start date and time of the test run.

➤ Load Test. The name given to the test when it was created.

➤ Project. The name of the project running the test.

➤ User. The name of the user running the test.

➤ State. The state of the test run. If a test is stuck in a particular state, you can 
change it.

➤ Duration. The time the load test took to run.

Click the Hosts link at the top of the page to return to the Hosts page.
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Rebooting Hosts

Performance Center enables you to reboot hosts remotely from the 
Administration site. The following conditions and limitations determine 
whether a particular host can be rebooted from the Administration site.

➤ The Remote Management Agent must be installed on the host. For more 
information, see the HP Performance Center System Configuration and 
Installation Guide.

➤ You cannot reboot Controller and Load Generator hosts while they are in 
the Running state. You can only reboot these hosts when they are idle.

➤ You cannot reboot a UNIX host.

To reboot hosts:

 1 From the Hosts page, select the hosts you want to reboot.

 2 Click Reboot. The Reboot Hosts window opens.

If Performance Center is unable to reboot the host—for example, because 
the selected host is the Administration Site server or a task is running on the 
host—a message is displayed in the Message column.
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 3 Supply login information for all hosts that should be automatically logged 
on after the hosts reboot. If you leave the boxes empty, you must log on to 
these hosts at startup.

Note: If you supplied login information when the host was configured, it is 
displayed in the appropriate column.

 4 Click Reboot. 

You can follow the progress of the reboot from the Hosts page. During 
reboot, the state of the host changes to Rebooting and the time (MM:SS) 
since the rebooting process started is displayed.

Uploading and Installing Patches

Performance Center allows you to upload a patch to the system and then 
install the patch on the appropriate Performance Center host.

The process consists of two stages: uploading the patch and installing the 
patch. The following conditions and limitations apply to installing patches 
on a particular host from the Administration site.

➤ The Remote Management Agent must be installed on the host. For more 
information on installing the Remote Management Agent, see the HP 
Performance Center System Configuration and Installation Guide.

➤ The Install Patch feature is not available for the Administration Site and 
Database servers.

➤ You cannot use the Install Patch feature on Controller and Load Generator 
hosts if they are in the Running state. You can only install patches when 
these hosts are idle.

➤ You should use this feature to install Performance Center certified patches 
only.
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To install patches on hosts:

 1 From the Hosts page, select the hosts on which you want to install patches.

 2 Click Install Patch. The Install Patch - Step 1 dialog box opens displaying 
any patches that were previously uploaded to the File Server.

 3 If a patch you want to install is not displayed in the Existing Patches list, 
click Browse, select the patch, and click Upload. The patch is added to the 
list.
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 4 Select the patches you want to install from the Existing Patches list and click 
Next. The Install Patch - Step 2 dialog box opens.

If Performance Center is unable to install a patch (for example, because the 
selected host is the Administration Site server or a task is running on the 
host), a message is displayed in the Message column. 

 5 Supply the login information for all hosts. 

Note: If you supplied the login information when the host was configured, 
it is displayed in the appropriate column. 
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 6 Click Install. The installation process begins.

You can follow the progress of the patch installation from the Hosts page. 
When the patch is being transferred from the File Server to the host, the 
state of the host is Transferring. During the patch installation, the state of 
the host is Installing. The percentage shows the progress of the patch 
transfer/installation. If the installation fails, select the host’s Log tab and 
click the Fail to create task link to view the log file.

Note: If the log file opens in binary instead of .txt format, you should close 
the file and reopen it using Notepad.

 7 After installation is complete, if a reboot is required Performance Center 
prompts you to reboot the host. 

To uninstall a patch:

 1 From the Hosts page, select the hosts from which you want to uninstall a 
patch.

 2 Click Install Patch. The Install Patch dialog box opens and displays any 
patches that were previously uploaded to the hosts.

 3 Click the Delete  button at the end of the line for the patch that you want to 
uninstall.

The patch is now removed from the list and deleted from the File Server.
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Understanding Host Allocation

When creating a test, the user specifies the number of hosts required for the 
test, and reserves a timeslot. To successfully reserve a timeslot, the required 
number of hosts needed for the test must be available.

When the user tries to reserve a timeslot, the system uses some of the 
information that is displayed on the Hosts page to determine if the required 
number of hosts, with the proper purposes, are available. If the required 
hosts are found, and are available for the requested time period, the timeslot 
is successfully reserved and the hosts are allocated. If the system cannot find 
suitable hosts to allocate for the requested time period, the timeslot cannot 
be reserved.

Each test requires one host as a Controller, one or more hosts that are load 
generators (it is possible to designate one host as a Controller + Load 
Generator), and one host for data processing. Performance Center uses 
different criteria to allocate hosts for each of these purposes, and out of all 
the hosts that meet the requirements, allocates those with highest priority. 
The two allocation methods are described below.

Allocating Controller and Load Generator Hosts
For load generation, Performance Center uses the following criteria for 
allocating hosts.

➤ Run ID. null means the host is not currently running.

➤ Allocation. 0 means the host is not allocated to the timeslot.

➤ State. Operational.

➤ Purpose. Controller, Controller + Load Generator, or Load Generator as 
indicated.

➤ Pool. The same pool as specified for the project for which the test is being 
run. For each project, Performance Center assigns hosts from a specific pool. 
This pool is specified in the project information page. For details, see the HP 
Performance Center User’s Guide.

➤ Project. Either none or the name of the test’s project for which the test is 
being run. Priority goes to hosts already assigned to the project.
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Allocating Data Processor Hosts
For data processing, Performance Center allocates a host with the following 
values:

➤ State. Operational.

➤ Purpose. Data Processor.

➤ Pool. The same pool as specified for the project for which the test is being 
run.

➤ Allocation. 0 - 5, because one host can be used for up to 5 concurrent 
operations.

Handling Resource Failure

If any of the hosts fail when Performance Center tries to run a test on the set 
of allocated hosts, the condition of the failed hosts changes from 
Operational to Resource Failure, and an error log describing the problem is 
sent to the main site.

You can try to fix the problem according to the description in the error log, 
then change the condition back to Operational. If the host is still not 
operational, the condition automatically returns to Resource Failure in the 
next test run. 

If you are using the Host Checkup Service (enabled from the General 
Settings of the Administration site), Performance Center automatically 
detects host resource failure and attempts to restore the host to the 
Operational state.
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Checking Hosts

You can check the connections between your project’s hosts and the various 
machines within your system. You can also check whether a load generator 
host is able to create an active session.

To check hosts:

 1 From the Hosts page, select the hosts that you want to check and click the 
Check Hosts button. The Check Hosts dialog box opens displaying the 
selected hosts together with an icon next to the host name indicating the 
host’s purpose.  

By default, all the selected hosts are enabled. If you not do want to check a 
specific host, clear that host’s check box.

Tip: Selecting or clearing the check box in the check box column header 
selects or clears all the check boxes respectively.

 2 If you want the selected hosts to ping a remote site, in the Ping URL column 
header, type the URL address.
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 3 Click Check Hosts. Performance Center performs the following actions for 
the selected hosts:

➤ Ping to Host. The Administration Site server pings the selected host.

➤ File Server. The selected host attempts to write, read, and delete from the 
File Server.

➤ Database. The selected host connects to the Database Server.

➤ Ping URL. The selected host pings the listed URL.

The Check Hosts table displays the success or failure of the actions.

Note: To ping to a host or to a URL, the Performance Center system user 
must be a user with administrator privileges.

 4 Select a host to view the results of the host check. Details for each action are 
listed in the Result Status area.

 5 Click Close to return to the Hosts page.
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Managing Host Locations

The Host Locations page displays the location information about the hosts 
available for load testing. 

When a user creates a load test from the main Performance Center site, the 
user specifies which hosts to use for the test. It is possible for the hosts to be 
located across a wide physical area. The location of the host might be a 
consideration when creating a test.

The Host Locations page also specifies whether a host is over or within the 
firewall. This information is crucial when assigning a purpose for the host. 
Hosts over the firewall can be designated as load generators only.

To view the Host Locations page:

➤ On the Performance Center left menu, select Resources > Host Locations. 
The Host Locations page opens.
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The page displays the following information about the hosts:

➤ ID. The host location ID number. This is automatically assigned when 
you add a host location.

➤ Name. The name of the location of the host. This is the name that you 
assign when you add a host location. 

➤ Over Firewall. This indicates whether or not the location of the host is 
over the firewall. Hosts that are located over the firewall may be 
designated as load generators only.

To add a host location:

 1 In the Host Locations page, click Add Host Location. The Add Host Location 
dialog box opens.

 2 Type a location name. The name should have a logical connection to the 
location.

 3 Indicate whether or not the location is over the firewall.

 4 Click OK. The location is added to the list of host locations.

To edit a host location:

 1 In the Host Locations page, select the location you want to edit.

 2 In the Edit Location Details area in the lower part of the page, type a new 
name, or indicate whether it is located over a firewall.

 3 Click Save. The host location information is updated.
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Removing Hosts

You can remove a host from the Hosts page. If you remove a host, it is no 
longer available for allocation to a test run, even if the host still has the 
Performance Center software installed.

To remove a host from the Hosts table:

 1 In the Hosts table, select the host you want to delete.

 2 Click Delete. A message appears asking you to confirm this action.

 3 Click OK to confirm. 

The host is removed from the list, and is no longer available to the system to 
be used for a test.
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Managing MI Listeners

This chapter describes how to manage MI Listener resources in Performance 
Center. MI Listeners enable running of Vusers over a firewall and collecting 
server monitor data and application diagnostics data over a firewall. 

This chapter describes: On page:

MI Listeners Page 76

Running Vusers over a Firewall 77

Collecting Data From Outside a Firewall 78
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MI Listeners Page

You manage the MI Listeners from the MI Listeners page (Resources > MI 
Listeners).

The MI Listeners page comprises the following areas:

➤ Firewall Vusers Communicators. Specify one or more MI Listener machines 
that enable you to run Vusers over the firewall. See “Running Vusers over a 
Firewall” on page 77.

➤ Firewall Monitoring Communicator. Specify the MI Listener machine that is 
configured to collect server monitor data from over the firewall. See 
“Collecting Data From Outside a Firewall” on page 78.

➤ Firewall Diagnostics Communicator. Specify the MI Listener machine that is 
configured to collect application diagnostics data from over the firewall. See 
“Collecting Data From Outside a Firewall” on page 78.
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Running Vusers over a Firewall

You can specify one or more MI Listeners that will enable running Vusers 
over a firewall. You can specify these MI Listeners in the MI Listeners page, 
in the Firewall Vusers Communicators MI Listeners table. You can add, edit, 
and delete MI Listeners in this table.

The MI Listeners table displays the following details: 

➤ MI Listeners. The IP address or name of the MI Listener.

➤ Comments. Information and comments about the MI Listener.

To add an MI Listener (running Vusers):

 1 On the Performance Center left menu, select Resources > MI Listeners to 
open the MI Listeners page.

 2 In the Firewall Vusers Communicators area, click Add. The Add New 
MI Listener dialog box opens.

 3 In the IP Address / Name box, type the IP address or name of the 
MI Listener.

 4 In the Comments box, type any comments that you want to note about the 
MI Listener.

 5 Click OK. The MI Listener is added to the table.

 6 Click Save at the bottom of the page.

To edit an existing MI Listener (running Vusers):

 1 On the Performance Center left menu, select Resources > MI Listeners to 
open the MI Listeners page.

 2 In the Firewall Vusers Communicators area, select an MI Listener in the 
table.

 3 Click Edit. The Edit MI Listener dialog box opens.

 4 Edit the details, and click OK. The changes that you made are updated in the 
table.

 5 Click Save at the bottom of the page.
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To delete an MI Listener (running Vusers):

Important! Deleting an MI Listener from Performance Center permanently 
removes it from the system, and may influence hosts that use the 
MI Listener.

 1 On the Performance Center left menu, select Resources > MI Listeners to 
open the MI Listeners page.

 2 In the Firewall Vusers Communicators area, select an MI Listener in the 
table.

 3 Click Delete.

 4 In the message box that opens, click OK to proceed.

 5 Click Save at the bottom of the page.

Collecting Data From Outside a Firewall

You can specify MI Listeners to collect monitoring or diagnostics data from 
outside a firewall.

To specify an MI Listener for collecting server monitor data:

 1 On the left menu, select Resources > MI Listeners to open the MI Listeners 
page.

 2 In the Firewall Monitoring Communicator area, in the IP Address / Name 
box, type the IP address or name of the MI Listener that is configured to 
collect server monitor data from over the firewall. 

 3 Click Save at the bottom of the page.
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To specify an MI Listener for collecting application diagnostics data:

 1 On the left menu, select Resources > MI Listeners to open the MI Listeners 
page.

 2 In the Firewall Diagnostics Communicator area, in the IP Address / Name 
box, type the IP address or name of the MI Listener that is configured to 
collect application diagnostics data from over the firewall. 

 3 Click Save at the bottom of the page.
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Managing Host Pools

Host pools are groups of hosts that you define in order to control which 
hosts may be accessed by a particular project. Managing host pools involves 
adding, deleting, editing, and assigning pools to projects. 

This chapter describes: On page:

Understanding Pool Resources 82

Assigning Pools to Projects 82

Understanding the Host Pools Page 85

Adding New Pools 87

Editing Pools 89

Deleting Pools 90
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Understanding Pool Resources

A host pool is a single pool made up of multiple hosts. When managing a 
pool, it is important to understand the total available resources. That is, how 
many Controllers, load generators, or other machines are a part of a pool. 

Note: A host can be assigned to a single pool only.

As hosts are added to a pool, the statistics for that pool are increased 
accordingly. Suppose you have a pool named General, and the pool consists 
of one Controller and two load generators. If you assign a new Controller 
host to the pool, the number of Controllers is increased by one, and a 
quantity of two Controllers is displayed.

Aquantity is displayed for each type of machine (Controller, load generator, 
Controller + load generator).

Assigning Pools to Projects

You can assign single pools or merged pools to a project. If you assign a 
single pool to a project, the project can use only the machines available in 
that pool. Assigning a single pool limits flexibility in managing the 
Performance Center, and the utilization of shared resources.

When a customer is assigned to a project, he has access only to those pools 
assigned to his projects.

Typically, host pools are divided according to a variety of schemes that 
include geographical location, type of machine, machine properties, and 
software installed on the machine.
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For example, say you have two pools—Pool 1 (machines in New York) and 
Pool 2 (machines in Los Angeles), and two projects—Project 1 and Project 2. 
If you want Project 1 to access only the machines in New York, and 
Project 2 to access the machines both in New York and in Los Angeles, you 
can either:

➤ Split Pool 1 and assign some of its resources to Pool 2. 

Pool 1 is assigned to Project 1, and Pool 2 is assigned to Project 2. 
However, both projects have access to fewer machines, and lose the 
benefit of shared resources.

➤ Merge Pool 1 and Pool 2 into a new pool, Pool 3, and assign it to both 
projects. 

This gives Project 1 access to machines in Los Angeles—which it need 
not have. 
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Assigning Merged Pools to Projects

To increase the flexibility and utilization of Performance Center resources, 
you can assign a merged pool to one project. A merged pool is a logical pool 
that combines the physical resources of existing host pools. This enables the 
project to access and utilize the resources of a number of different pools.

Using the example discussed above, to maximize resource usage, you can 
create a merged pool, Pool 3, that combines the resources of the existing 
host pools, Pool 1 and Pool 2. You can assign Pool 3 to Project 2, allowing 
access to New York and Los Angeles machines, and, at the same time, you 
can assign Pool 1 to Project 1, allowing access to New York machines only.

Merged pools allow projects, and customers working on those projects, to 
access resources from an unlimited number of pools.
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Understanding the Host Pools Page

Host pools are groups of hosts. You define host pools in order to control 
which hosts may be accessed by which projects. You can view a list of host 
pools and merged pools, and their total resources, in the Host Pools page. To 
access the Host Pools page, on the Performance Center left menu, select 
Resources > Host Pools.  

The Host Pools page is comprised of the following areas:

➤ Host Pools table. Displays information about the host pools in the 
Performance Center system. You can add and delete pools, and merge pools 
that are listed in the table. For more information, see “Host Pools Table” on 
page 86.

➤ Edit Pool Details area. Displays the details of a selected host pool or merged 
pool. 
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Host Pools Table
The Host Pools table displays the following information about the pools: 

➤ Pool ID. The ID that was assigned to the pool when it was created.

➤ Pool Name. The name that was assigned to the pool when the pool was 
created. 

If a pool is a merged pool, you can expand it to see which host pools it 
comprises, and the total physical resources contained in each pool.

➤ Total C. The total number of Controller hosts in the pool.

➤ Total L. The total number of load generator hosts in the pool.

➤ Total C + L. The total number of Controller and load generator hosts in the 
pool.

➤ Merged. Y indicates that the pool is a merged pool—a pool comprised of 
existing host pools. N indicates that the pool is not a merged pool.

➤ Host Count. The total number of machines in the pool.

➤ Description. A description of the pool.

You can sort table by any column.

To sort the table: 

Click a column heading. The arrow indicates whether the column is sorted 
in ascending or descending order. 

Clicking the column again reverses the arrow's direction and the entries are 
displayed in the opposite order. 
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Adding New Pools

You can add new pools and create merged pools in the Host Pools page. 

To add a new host pool:

 1 Click Add Pool. The Add New Pool dialog box opens.

 2 In the Pool Name box, type a unique name for the pool. 

The name may contain up to 128 characters, excluding spaces, periods, and 
any of the following characters: : ; * \ / ” ~ & ? { } $ % | < > + = ^ [ ] ( )

 3 In the Description box, type a description for the pool.

 4 Click OK to add the new pool.
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To create a merged pool:

 1 At the bottom of the Hosts Pools table, click the Create Merged Pool 
button. The Create Merged Pool dialog box opens.

 2 In the Pool Name box, type a unique name for the merged pool.

The name may contain up to 128 characters, excluding spaces, periods, and 
any of the following characters: : ; * \ / ” ~ & ? { } $ % | < > + = ^ [ ] ( )

 3 In the Description box, type a description for the merged pool.

 4 Select the host pools to include in the merged pool. To select all the host 
pools at once, select the check box at the top of the check box column.

 5 Click Save to add the merged pool.
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Editing Pools

You edit pools in the Edit Pool Details area of the Host Pools page.

To edit a pool:

 1 In the Host Pools table, select a pool to edit.

 2 The Edit Pool Details area displays the following:

➤ Pool ID. Identifies the pool.

➤ Included In/Merged Pools.

➤ If you selected a host pool that is included in one or more merged 
pools, then Included In lists those merged pools.

➤ If you selected a merged pool, then Merged Pools list the host pools 
included in the merged pool.

➤ Name. Displays the name of the pool. To rename the pool, type a new 
name. 

➤ In the Description box, edit the description of the pool.

Click Save.

 3 If you are editing a merged pool, to edit the selection of pools included in 
the merged pool:

 a Click the Edit Merged Pool button. The Edit Merged Pool dialog box 
opens. 

 b Select the host pools to include in the merged pool, or clear selected host 
pools if you do not want to include them, and click Save.
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Deleting Pools

You can delete a host pool or merged pool from the Performance Center 
system, provided the pool has no hosts assigned to it.

To delete a pool:

 1 Select the pool you want to delete.

 2 Click Delete Pool. Performance Center validates whether the pool can be 
deleted.

➤ If the pool is a merged pool, Performance Center deletes the pool.

➤ If the pool is a host pool, Performance Center checks the following:

➤ If the pool has any hosts assigned to it, it cannot be deleted.

➤ If the pool has future timeslots assigned to it, Performance Center 
warns you that if you delete the pool, tests scheduled to use that pool 
will fail.

➤ If the pool is included in any merged pools, it cannot be deleted.
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Managing Servers

Servers are configured machines that provide information and resources 
needed for Performance Center functionality. Managing servers involves 
monitoring the server status, editing server information, and checking 
server performance.

This chapter describes: On page:

About Managing Servers 92

Using the Servers Page 92

Managing Server Information 95

Rebooting Servers 102

Uploading and Installing Patches 103

Checking Servers 107
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About Managing Servers

The Administrator manages server performance to ensure that the required 
server resources are available for Performance Center. The Servers page 
provides information on server performance, status, and properties. 

Using the Servers Page

The Servers page displays information about the Performance Center 
servers. It also enables you to reboot machines, install patches, and check 
server connectivity.

When performing administrative tasks on the any of the servers, if you are 
prompted for the configuration user credentials, enter them and click OK.

Note: When supplying the credentials of a domain system user, you must 
enter the fully qualified domain name.
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To open the Servers page:

On the Performance Center left menu, select Resources > Servers. The 
Servers page opens. 

The Servers page displays the following information about the servers:

➤ Status. An indicator of the current system performance of the server, 
represented by a color. A combination of the state and the SiteScope 
measurement determines the indicator color. A color other than green is a 
warning that the system performance is less than optimal and warrants 
investigation. The performance is assessed according to four parameters: 
CPU usage, memory usage, disk space, and running services. There is a hard-
coded threshold for each parameter. If a Performance Center service stops 
for any reason, the machine state turns red (Error). The following table lists 
the possible combinations and the associated indicator color.

Indicator Server State SiteScope Status

 (green) Operational OK

 (yellow) Operational Warning

 (red) Operational Error - Measurement Problem

 (gray) Unavailable Any
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➤ Name. The server name that you assign when you configure a new server. 
You can click the name to view server details. For details, see “Managing 
Server Information” on page 95.

➤ Purpose. The type of servers configured on the machine. A server symbol 
indicates each type of configured server. For more information on 
Performance Center servers, see the HP Performance Center System 
Configuration and Installation Guide.

➤ State. The condition of the server. The possible conditions are:

➤ Operational. The server is working.

➤ Unavailable. The server is not available.

➤ Maintenance. The server is not working.

➤ Rebooting. The server is rebooting and is temporarily unavailable. The 
time (MM:SS) since the rebooting process started is displayed.

➤ Transferring. The installation patch is being transferred from the File 
Server to the host, and the server is temporarily unavailable. The 
percentage shows the progress of the patch transfer.

➤ Installing. The installation patch is being installed on the server, and the 
server is temporarily unavailable. The percentage shows the progress of 
the patch installation.

The various states are descriptive in nature and provide clues as to where a 
problem has occurred. You should try to fix the problem, and then change 
the condition back to Operational. If the system detects that the server is 
still not working, the condition reverts to its prior state.

 (gray) Maintenance Any

 (gray) Operational Not Defined

 (gray) Rebooting Any

 (gray) Transferring Any

 (gray) Installing Any

Indicator Server State SiteScope Status
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In addition, you can perform the following actions from the Servers page:

➤ Reboot. Enables you to reboot server machines remotely from the 
Administration Site. For more information, see “Rebooting Servers” on 
page 102.

➤ Install Patch. Enables you to install patches remotely on servers. For more 
information, see “Uploading and Installing Patches” on page 64.

➤ Check Servers. Enables you to check the connections between various 
servers and machines within your system. For more information, see 
“Checking Servers” on page 107.

To perform actions on all the Performance Center servers, select the check 
box at the top of the check box column. A check is displayed in the check 
box for each server. Click the check box again to clear all the check boxes.

Managing Server Information

You can manage servers by entering the Server details tabs. The tabs enables 
you to view and edit server properties, status, processes, and logs.

To enter the Servers details tabs:

 1 On the Performance Center left menu, select Resources > Servers. The 
Servers page opens.

 2 Click the name of a server to view server details. Server information is 
divided into the following tabs:

➤ Properties tab. Allows you to view and edit server properties.

➤ Status tab. Allows you to view server status and to perform server 
connectivity checks.

➤ Processes tab. Allows you to view and kill processes on a server.

➤ Logs tab. Allows you to view detailed information about the tasks 
performed on the server, the action status, and a description of any 
errors.

To return to the Servers page:

Click the Servers link at the top of the page to return to the Servers page.
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Servers - Properties Tab
The Properties tab provides general information about the properties of the 
server. The tab enables you to change a server’s state, add comments, and 
enable SiteScope monitoring. 

➤ Server Name. The server name.

➤ OS Type. The server operating system.

➤ Purpose. The function the server performs. Purposes include: User Site 
Server, File Server, Utility Server, Administration Site Server, and Database 
Server.

➤ Comments. Relevant information about the host.

➤ State. The state of the server. Possible states are: Operational, Unavailable, 
and Maintenance. Additionally, temporary states of Rebooting, 
Transferring, or Installing are assigned while a machine goes through a 
rebooting or patch installation process.
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Login Information

➤ User Name. The user name of the server machine.

➤ Password. The password of the server machine.

➤ Domain. The server machine domain.

➤ Installed Components. A list of components installed on the server 
machine, including version and patches.

To change the server state or enable SiteScope monitoring:

 1 Click the Properties tab, and click Edit. The Properties tab is displayed with 
editable fields.

 2 Select the desired server state. The available states are: Operational, 
Unavailable, and Maintenance.
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 3 If you are editing the properties of your database server, the Database 
Instance field is displayed. Type the database instance name.

Note: Do not enter the instance port number as the service name will always 
be the instance name.

 4 If you are editing the properties of a UNIX server, the UNIX login 
configuration details are displayed. For more details, see “Configuring 
Remote UNIX Machines” on page 49.

 5 To enable SiteScope monitoring, select Enable SiteScope Monitoring.

Note: 

➤ SiteScope must be installed on a server in the Performance Center 
environment. You can install SiteScope on the same machine as the 
Controller, or on a dedicated server.

➤ Disk performance counters are disabled by default in standard Windows 
2000 installations. To monitor disk drives using the SiteScope Disk 
monitor on machines running Windows 2000, you must enable these 
disk counters. Run the diskperf -y command line on each Windows 2000 
machine for which you want to monitor disk space, then reboot the 
machine. Select the disk drives to monitor from the machine’s Resource 
Status tab.

 6 Click Save. The dialog box closes and the properties are updated.

To return to the Servers page:

Click the Servers link at the top of the page to return to the Servers page.
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Servers - Status Tab
The Status tab provides information on the connections between the 
selected machine and various servers and machines within your system. For 
more details on checking connections, see “Checking Servers” on page 107.

All functions are automatically performed when the tab is opened, the page 
is refreshed, or you click the Check Servers button. 

The Status tab displays the following results:

➤ State. Displays the status of the server check (Done, Refreshing, Succeeded).

➤ Ping to Server. Displays the results of the Administration Site server pinging 
the selected server.

➤ File Server. Displays whether the selected server is able to write, read, and 
delete from the file server.

➤ Database. Displays the results of the selected server’s attempts to connect to 
the database server.

➤ Ping to URL. If you want the selected server to ping a remote site, type the 
URL address, and click Check Servers.
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➤ Ping URL Status. Displays the results of the selected server pinging the listed 
URL.

➤ SiteScope Data. Displays detailed information about the server, collected by 
the SiteScope monitor. Information is displayed in this section only if 
SiteScope monitoring has been enabled (see “Servers - Properties Tab” on 
page 96).

To return to the Servers page:

Click the Servers link at the top of the page to return to the Servers page.

Servers - Processes Tab
The Processes tab provides detailed information about the processes and 
resource usage of the selected server. 

To kill a process, click the button in the Kill column for the process.

To return to the Servers page:

Click the Servers link at the top of the page to return to the Servers page.
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Server - Logs Tab
The Logs tab provides detailed information about the tasks performed on 
the selected server, the action status, and a description of any errors. 

The tab enables you to filter the information by selecting a specific time 
frame, refresh the table to view the most current tasks, and clear the log.

Click the Error Description link to view log files for the action.

To return to the Servers page:

Click the Servers link at the top of the page to return to the Servers page.
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Rebooting Servers

Performance Center enables you to remotely reboot server machines from 
the Administration Site. The following conditions and limitations 
determine if a particular machine can be rebooted from the Administration 
Site.

➤ The Remote Management Agent must be installed on the machine. For more 
information on the Remote Management Agent, see the HP Performance 
Center System Configuration and Installation Guide.

➤ The Administration Site and Database servers cannot be rebooted using this 
feature.

➤ You cannot reboot the File or Utility servers if they are in the Running state. 
You can only reboot these servers when they are idle.

To reboot servers:

 1 Select the servers you want to reboot.

 2 Click Reboot. The Reboot Servers dialog box opens.

If Performance Center is unable to reboot the machine (for example, 
because the selected server is the Administration Site server or a task is 
running on the machine), a message is displayed in the Message column.
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 3 Supply login information for all machines you want automatically logged 
on after the reboot. If you leave the fields empty, you must log on to these 
machines at startup.

Note: If you supplied login information when the machine was configured, 
it is displayed in the appropriate fields.

 4 Click Reboot. 

You can follow the progress of the reboot from the Servers page. During 
reboot, the server state changes to Rebooting and the time (MM:SS) since 
the rebooting process started is displayed. 

Uploading and Installing Patches

Performance Center allows you to upload a patch to the system and then 
install the patch on the appropriate Performance Center server machines.

The process consists of two stages: uploading the patch and installing the 
patch. The following conditions and limitations apply to installing patches 
on a particular machine from the Administration Site.

➤ The Remote Management Agent must be installed on the machine. For more 
information on installing the Remote Management Agent, see the HP 
Performance Center System Configuration and Installation Guide.

➤ The Install Patch feature is not available for the Administration Site and 
Database servers.

➤ You cannot install patches on the File or Utility servers if they are in the 
running state. You can only install patches when these machines are idle.

➤ You should use this feature to install HP certified patches only.
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To install patches on servers:

 1 From the Servers page, select the servers on which you want to install a 
patch.

 2 Click Install Patch. The Install Patch - Step 1 dialog box opens, displaying 
any patches that were previously uploaded to the File server.

 3 If the patch you want to install is not displayed in the Existing Patches list, 
click Browse, select the patch, and click Upload. The patch is added to the 
list.
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 4 Select the patches you want to install from the Existing Patches list and click 
Next. The Install Patch - Step 2 dialog box opens.

If Performance Center is unable to install the patch (for example, because 
the selected server is the Administration Site server or a task is running on 
the machine), a message is displayed in the Message column.

 5 Type the login information for all machines.

Note: If you supplied login information when the machine was configured, 
it is displayed in the appropriate fields.
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 6 From the Install Patch - Step 2 dialog box, click Install. The installation 
process begins.

You can follow the progress of the patch install from the Servers page. When 
the patch is being transferred from the File server to the host, the server 
state is Transferring. During the patch installation, the server state is 
Installing. The percentage shows the progress of the patch 
transfer/installation. If the installation fails, select the Server's Log tab and 
click the Fail to create task link to view the log file.

Note: If the log file opens in binary instead of .txt format, you should close 
the file and reopen it using Notepad.

 7 After installation is complete, Performance Center will prompt you to 
reboot the machine if a reboot is required.

To delete a patch file:

 1 From the Servers page, select the servers from which you want to delete a 
patch.

 2 Click Install Patch. The Install Patch dialog box opens and displays any 
patches that were previously uploaded to the servers.

 3 Click the Delete File button at the end of the line for the patch that you 
want to delete.

The patch is removed from the list and deleted from the File server.
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Checking Servers

You can check the connections between Performance Center servers and the 
File server and Database server. You can also check server connections to 
selected URLs.

To check servers:

 1 On the Servers page, select the servers that you want to check and click 
Check Servers. The Check Servers dialog box opens displaying a check next 
to each server. The icon next to the servers name indicates the purpose of 
the server.

By default, all the selected servers are enabled. If you not do want to check a 
server, clear that server’s check box.

Tip: Selecting/clearing the check box in the column header, selects/clears all 
the check boxes in the column respectively.
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 2 If you want the selected servers to ping a remote site, type the URL address.

 3 Click Check Servers. Performance Center performs the following actions:

➤ Ping to Host. The Administration Site server pings the selected server 
machines.

➤ File Server. The selected servers attempts to write, read, and delete from 
the file server.

➤ Database. The selected servers connects to the database server.

➤ Ping URL. The selected host pings the listed URL.

The Check Servers table displays the success or failure of the actions.

 4 Select a server to view the results of the server check. Details for each action 
are listed in the Result Status area.

 5 Click Close to close the Check Servers dialog box.
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Managing Test Runs

You can view all the test runs in the system and monitor their progress.

About Managing Test Runs

A test run is the actual execution of a load test. You can view all the test runs 
in the system to see when each test is supposed to run, whether it is 
currently running, and to which project it belongs.

During a test run, there are several stages, called states. The Test Runs page 
enables you monitor the test runs, and check the state of each run. 
Examples of test run states include Running, Before Collating Results, and 
Finished. You can change the state of a test run where necessary.

This chapter describes: On page:

About Managing Test Runs 111

Test Runs Page 112

Using the Fast Recovery 115

Changing a Test Run State 116

Deleting a Test Run 119

Checking the Collator Process 120

Deallocating Hosts from a Test Run 121
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Test Runs Page

The Test Runs page displays the test runs and the run details. The Test Runs 
table displays test runs according to your user login context. Users at the 
Performance Center level can view all test runs in the system. Users at the 
customer level can view only customer test runs. Users at the project level 
can view only test runs in the project.

To open the Test Runs page:

On the Performance Center left menu, select Site Management > Test Runs. 
The Test Runs page opens:

➤ Run ID. The identification number of the test. This number is automatically 
generated by the system when the load test starts.

➤ Test Name. The name given to the test when it was created. The test name 
links to the Event Log filtered by the Run ID. For more information, see 
“Managing Events” on page 129.

➤ Project Name. The name of the project running the test.
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➤ State. The state of the test run. If a test is stuck in a state, you can change it. 
For details, see “Changing a Test Run State” on page 116.

➤ # Vusers. The current number of Vusers running in the test. The number is 
updated when the test finishes.

➤ Analysis Start Time. The start time of the analysis process. (If the test results 
analysis is not complete, the value is displayed as “null.”)

➤ Run Date. The date and start time of the test run.

➤ Test duration. The duration of the test run.

The Test Runs page also displays the total number of all runs in the 
Performance Center database.

When you select a test run, additional details are displayed in the lower part 
of the page. For more information, see “Selecting a Test Run” on page 114.

Action Buttons

In addition to viewing the test run details, you can perform the following:

➤ Delete. Allows you to delete the selected test runs. For more information, 
see “Deleting a Test Run” on page 119.

➤ Deallocate Host. Allows you to detach all hosts that are allocated to a 
particular test run. For more information, see “Deallocating Hosts from a 
Test Run” on page 121.

Sorting the Test Runs
You can sort the test runs according to the values in any column whose 
heading is underlined.

To sort the test runs:

 1 Click an underlined column heading of your choice. A downward facing 
arrow is displayed next to the column heading. The test runs are sorted in 
descending order of the values in that column.

 2 When you click the heading again, the arrow reverses direction, and the test 
runs are sorted in ascending order of the values in that column.
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Filtering the Display
There are three lists for filtering the display:

➤ Time. Displays test runs that ran within a specified time period. The options 
are All Runs (default), Last Hour, Last 12 Hours, Last 24 Hours, Last Week, or 
Last Month.

➤ State. Displays test runs for all states (default), or for a specific state. The 
options are:

➤ All States. Displays test runs of all states.

➤ Run. Displays only test runs that are currently running.

➤ Collate. Displays only test runs whose results are currently being collated.

➤ Error. Displays only test runs with errors.

➤ Project. Displays test runs for all projects (default), or for a specific project.

To filter the display:

 1 From one or more of the filter lists, select filtering options.

 2 Click Filter. The table displays test runs according to the selected filter 
options.

Selecting a Test Run
When you select a test run, the following test run details are displayed in 
the lower part of the page, as well as a button which allows you to change 
the test run’s state:

➤ Duration. The duration of the test.

➤ Max concurrent Vusers. The maximum number of concurrent virtual users 
allowed during the test run.

➤ Load Generator (Vusers). A list of the hosts used to run virtual users.

➤ Results Directory. The directory that stores the test run results. 

➤ Vusers involved. The total number of Vusers used in the run.
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➤ Controller machine. The host machine used as the Controller. In the 
Performance Center system, one of the hosts is a Controller, and the others 
are load generators.

➤ User name. The name of the user who ran the test.

➤ Collator Status. Tells you whether or not the collator is running.

Action Buttons

Additionally, the following buttons are displayed:

➤ Change State. Allows you to change the state of the load test. For example, 
you can change the state from Before Collating Results to Fatal Error. For 
more information, see “Changing a Test Run State” on page 116.

➤ Fast Recovery. Allows you to stop a test when it has a status of Ready, 
Running, or Stopping. Clicking Fast Recovery abruptly terminates the test, 
resulting in a deallocation of resources and a resetting of the pointers to the 
active object. For more information, see “Using the Fast Recovery” on 
page 115.

Using the Fast Recovery

When viewing the details of a test run, the Fast Recovery button may be 
displayed in the lower-right corner of the Details area. This button should 
only be used if the test is frozen and unable to continue, for example, if the 
host connection fails and the processing cannot continue for a particular 
run.

Clicking Fast Recovery frees all the system resources, stops the test run, and 
resets the run state to Before Collating Results.

At this point, the Administrator should contact the user about the fast 
recovery.
115



Chapter 7 • Managing Test Runs
Changing a Test Run State

Changing the state of a test run provides a great deal of flexibility for 
running and processing your tests.

Changing the state of the test run is another way to handle a frozen test. For 
example, if the test is stuck in the Running state, you can change to the 
Before Collating Results state. Since the Before Collating Results state occurs 
after the Running state, by changing the test to this new state, you have 
placed the test at a point beyond the problem. The test restarts and proceeds 
to the end of the test.

Note: Where the temporary result files for a run have been deleted (after 
results were successfully collated), you cannot change the state of the test 
run to Before Collating Results, Finished, or Collating Results.
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Test Run Flowchart

Knowing the flow of states allows you to change a test’s state to the 
appropriate position. Use the following flowchart to study the relationship 
between states. 
117



Chapter 7 • Managing Test Runs
When viewing the flowchart, note the following:

➤ The Active state is a temporary state indicating that the system is 
performing an operation.

➤ The Non-Active state is a static state which only changes when the user 
performs an action.

Note: When a user deletes a test run in the User Site, the test is no longer 
displayed on the page. In the Administration Site, however, the test is still 
displayed with Deleted state. The administrator can change the state and 
the test will be redisplayed in the User Site. 

To change the state of a test run:

 1 Select the test run. The Change State button is displayed at the lower-right 
corner of the page.
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 2 Click Change State. The Set state of run dialog box opens. 

 3 Select the correct state.

 4 Click Save.

Deleting a Test Run

You can delete test runs from Performance Center. This is useful for deleting 
old runs that no longer need monitoring.

To delete a test run:

Select the test run you want to delete, and click the Delete  button at the 
end of the test run’s row in the table. The test run is deleted from the 
database and file server, and is no longer displayed in the table.
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Checking the Collator Process

After a test has finished running, the collator process in the database may 
still be active. As long as the process is still active, the user is able to 
reconnect the test. If collator process is active, you should reset the process 
for the run.

To check if the collator process is active:

 1 Select the test run. The additional details for the test run are displayed in the 
lower part of the page.

 2 If the Collator Status is Active, the process is still running. If not, Inactive is 
displayed.

To reset the collator status for the run:

 1 Click the Active link in the Collator Status field for the selected test run. A 
dialog box opens. 

 2 Click OK. A dialog box opens confirming the process value has been set to 
zero. 

 3 Click OK to close the dialog box.
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Deallocating Hosts from a Test Run

You can detach all the hosts that are allocated to a particular test run. You 
should do this if a host is stuck in the Running status after the test is 
finished.

To deallocate hosts from a test run:

 1 In the Test Runs page, click Deallocate Hosts. The Deallocate Hosts dialog 
box opens.

 2 Specify the type of host you are deallocating (Load Generator or Analysis), 
and the run ID of the test run from which you want to deallocate hosts, and 
click OK.

 3 A dialog box opens confirming the host’s deallocation. Click Close to close 
the dialog box.
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Managing Timeslots

From the Administration Site, you can monitor timeslot reservations.

About Managing Timeslots

When a user creates a load test from the Performance Center User Site, the 
user specifies how many hosts the test requires and reserves the necessary 
number of hosts for a specific time period. The availability of the required 
hosts for a specific time period is called a timeslot, and the user is said to 
have reserved a timeslot.

From the timeslots page, you can see details of all timeslot reservations and 
how many hosts remain available for any given timeslot. If necessary, you 
can delete reservations.

This chapter describes: On page:

About Managing Timeslots 123

Viewing Timeslot Allocations 124

Viewing Timeslot Availability 127
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Viewing Timeslot Allocations

The timeslots table displays details of all reserved timeslots. Use the table to 
see which projects have reserved which timeslots, and how many hosts are 
reserved for each timeslot.

To view the Timeslots page:

On the Performance Center left menu, select Site Management > Timeslots. 
The Timeslots page opens, displaying the Timeslots table and Timeslot 
details.

Note: To display timeslot availability, click the Switch to Resources 
Availability Table link. For details, see “Viewing Timeslot Availability” on 
page 127.
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The Timeslots table displays the following information about the timeslots:

➤ ID. The identification number of the timeslot.

➤ Project Name. The name of the project.

➤ User Name. The name of the user.

➤ From Time, To Time. The start and end of the timeslot. Due to the Autostart 
feature, the start and end times are displayed in half- and whole-hour 
increments. For details on Autostart, see the section in the HP Performance 
Center User’s Guide that describes viewing Autostart load tests.

➤ Machines. The number of host reserved for the test that runs during the 
timeslot.

➤ Vusers. The number of Vusers reserved for the test that runs during the 
timeslot. 

Note: The Vusers column is displayed only if Vuser Scheduling is enabled in 
the General Settings. For details, see Chapter 12, “Configuring General 
Settings.”

➤ Host Pool. The host pool assigned to the project. The project is allocated 
hosts from that pool only. For details, see “Understanding the Host Pools 
Page” on page 85.

➤ Run ID. The ID of the load test using the timeslot. This number is 
automatically generated by the system when the load test starts.

There is also a Delete button displayed for each timeslot.

The Timeslot details display the following information about the timeslots:

➤ Duration. The total length of time (in hours) reserved for the timeslot.

➤ User Name. The name of the user who reserved the timeslot.

➤ Post-run Analysis. The post-run analysis option selected in the Options tab 
of the Timeslots page. For details, see the section in the HP Performance 
Center User’s Guide that describes configuring post-run Analysis settings.
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➤ Run Vusers on Controller. Specifies whether the load test is configured to 
run Vusers on the Controller machine. For details, see the section in the HP 
Performance Center User’s Guide that describes running Vusers on the 
Controller.

➤ Machines. The names of the hosts assigned to the load test. If no hosts were 
specified when the timeslot was reserved, a message is displayed.

➤ Comments. Users can add comments when they reserve a timeslot. When a 
timeslot is selected, comments for that timeslot are displayed.

Sorting Timeslots
You can sort timeslots according to the values in any column of the 
Timeslots table whose heading is underlined.

To sort timeslots:

 1 Click an underlined column heading of your choice. A downward facing 
arrow is displayed next to the column heading. The timeslots are sorted in 
descending order of the values in that column.

 2 When you click the heading again, the arrow reverses direction, and the 
timeslots are sorted in ascending order of the values in that column.

Deleting a Timeslot
You can delete a timeslot reservation.

To delete a timeslot reservation:

➤ Select a timeslot and click the corresponding Delete button. The timeslot is 
removed from the table. 

Note: You can delete future timeslots only.
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Viewing Timeslot Availability

You can switch from the Timeslots table to the Resources Availability table 
to display the distribution of available hosts and Vusers over any time 
period.

Note: Vuser availability is displayed only if Vuser Scheduling is enabled in 
the General Settings. For details, see Chapter 12, “Configuring General 
Settings.”

To view the Resources Availability table:

Click the Switch to Resources Availability Table link at the top of the 
Timeslots page. The Resources Availability table opens: 
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The Resources Availability table contains the following elements:

➤ Time on Server. The current time according to the server.

➤ Total Load Generators in selected projects. The number of load generator 
hosts available in the selected projects, and therefore, the maximum 
number of hosts that could be available for the project at any one time.

➤ Total Vusers in selected project(s). The number of Vusers available in the 
selected projects, and therefore, the maximum number of Vusers that could 
be available for the project at any one time.

To configure the Resources Availability table:

 1 Click Month and select the month for which you want to display resource 
availability.

 2 Click Week and select the specific week for which you want to display 
resource availability.

 3 Select the project for which you want to display resource availability. Click 
Go to show available timeslots for the selected host pool.

The Calendar displays how many resources are available for each timeslot 
period selected.

The table is divided into half-hour timeslots. Each timeslot is represented by 
a rectangle, which indicates the number of resources available during that 
hour. Place the mouse cursor over a timeslot for resource availability details.

The three types of availability are listed below the table:

➤ All Load Generators and Vusers Available. All the hosts and Vusers are 
available for the timeslot. For the total number of hosts and Vusers, refer 
to the Total hosts in selected project and Total Vusers in selected 
project(s) number above the table.

➤ Partial Load Generators/Vusers Available. The number on the rectangle is 
the number of hosts and Vusers available.

➤ No Load Generators/Vusers Available. There are no hosts or Vusers 
available.

To return to the Timeslots table:

Click the Switch to Timeslots Table link at the top of the Timeslots page.
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Managing Events

In case of an event during a test run, you can see a description of the event 
and its source in the Event Log page. An event can be informational or 
generated by an error. 

This chapter describes: On page:

Viewing the Event Log 130

Filtering and Sorting Events 132
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Viewing the Event Log

The Event Log page displays all the events, reporting the source and severity 
of each event, as well as showing which host and test run it occurred on, 
and the time it occurred.

To view events:

On the Performance Center left menu, select Site Management > Event Log. 
The Event Log page opens: 

The following information is displayed for each event:

➤ ID. The identification number of the event.

➤ Time. The time the event was recorded.

➤ Description. A description of the event.

➤ Event. An internal identifier for the event.

➤ Source. The system element where the event originated.
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➤ Severity. The severity of the event (Info, Error, Fatal Error).

➤ Run ID. The identification number of the test run.

➤ Host. The host from which the event was generated.

The page also displays:

➤ Total Events in Database. The total number of events in the system.

➤ Export Event Log. Prepares and downloads a text file of all the events that 
occurred in the past week or of all the events in the log.

To prepare and export an event log:

 1 Click the Export Event Log button. The Export Event Log dialog box opens. 

 2 Choose the desired time period and click OK. The event log is prepared for 
download and the size of the download file is displayed.

 3 Click Download, and choose the location to save the file.

 4 Click Close to close the Export Event Log dialog box.
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Filtering and Sorting Events

You can use the filter lists to display a specified subset of the events. In 
addition, you can sort the events according to the values in any column 
whose heading is underlined.

To filter the display:

 1 From one or more of the filter lists, select filtering options.

➤ Time. Displays only test runs that ran within a specified time period. 

➤ Severity. Displays test runs with specific severity levels.

➤ Host. Displays test runs that were performed on a specified host.

➤ Run ID. Displays test runs with a specific run ID.

 2 Click Go. The table displays test runs specified by the selected filtering 
options.

To sort the events:

➤ Click an underlined column heading of your choice. A downward facing 
arrow is displayed next to the column heading. The events are sorted in 
descending order of the values in that column.

When you click the heading again, the arrow reverses direction, and the 
events are sorted in ascending order of the values in that column.
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Introducing System Configuration

You configure and view license key information, general settings, HP 
Diagnostics (J2EE and .NET), server configuration information, server 
authentication details, and email alerts from the System Configuration 
pages of the Performance Center Administration Site.

Important: If you are performing the initial system configuration, the 
Performance Center system user must have administrative privileges. For 
more information on performing the initial system configuration, see the 
HP Performance Center System Configuration and Installation Guide.

➤ License page. You can view your Performance Center and host license 
details in the License page. The Performance Center license, which is 
required for using the entire product and running load tests, provides details 
of your Vuser limit, concurrent runs limit, and expiry date. You can view 
these details, and update your license key number from this page. The 
Performance Center host license allows access to different kinds of protocols 
and monitors.

➤ General Settings page. This page provides information about the system 
configuration. On this page, you can set the time zone, the alert threshold, 
the auto-refresh rate, and the autostart options.

➤ Diagnostics page. Use this page to set up the ERP/CRM and J2EE/.NET 
Diagnostics modules to generate transaction breakdown data for ERP/CRM 
and J2EE/.NET environments. 
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➤ Server Configuration page. This page provides details as to where key 
components of Performance Center are located. 

➤ Authentication Server page. From this page you configure the Performance 
Center server authentication information.

➤ Alerts page. From this page you define alert conditions and set email 
preferences.
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Configuring and Viewing License 
Information

You configure and view license key information from the System 
Configuration pages of the Performance Center Administration Site.

Viewing License Information

You can view your Performance Center license and host license details, and, 
if necessary, update your license key number from the License page.

The Performance Center License enables you to use the product and run 
load tests. It provides details of your Vuser limit, concurrent runs limit, 
expiry date, and the license key. 

➤ Vuser Limit. The maximum number of Vusers a project can run at once. The 
total number used by all of the project's concurrent load tests must not 
exceed this maximum.

➤ Concurrent Runs Limit. The maximum number of concurrent runs allowed 
within a project.

➤ Valid. Displays the time limitation of the license key.

➤ License Key. The Performance Center license key.

This chapter describes: On page:

Viewing License Information 137

License Types 140
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The Host License allows you to access the Vuser protocols and server 
monitors that are available for the specified host license key. For more 
information on the licenses available for Performance Center, see “License 
Types” on page 140.

To view the License page:

On the Performance Center left menu, select System Configuration > 
License. The License page opens. 
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To update your Performance Center license key:

 1 On the Administration site System Configuration menu, click License. The 
License page opens.

 2 Under Performance Center License, click Set New License. The Set License 
dialog box opens. 

 3 Type the new Performance Center license key.

 4 Click OK to set the new license key. Performance Center checks the validity 
of the license key and closes the dialog box.

To update the host license key:

 1 On the Administration Site System Configuration menu, click License. The 
License page opens.

 2 Under Host License, click Set New License. The Set License dialog box 
opens. 
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 3 Type the new host license key.

 4 Click OK to set the new license key. Performance Center checks the validity 
of the license key and closes the dialog box.

License Types

There are two types of licenses available for Performance Center:

➤ Regular. This type of license is limited by time and by the total number of 
concurrent runs and Vusers.

➤ VUD–based. This type of license is limited by the total number of Vusers 
that you can run concurrently during a Virtual User Day (VUD). A VUD 
license enables you to use the product an unlimited number of times within 
a period of 24 hours. After that time, the remaining number of Vusers equals 
the total number of licensed Vusers minus the maximum number of Vusers 
that ran concurrently that day.

For example, a user has a VUD-based license for a total of 1000 Vusers and 
creates a test that uses 200 hundred Vusers and lasts for forty-five minutes. 
The user runs the test at 8:00 AM, 10:00 AM, 2:00 PM, and 4:00 PM. In each 
case, the test finishes before the new one begins. Since there is no 
concurrent use, 200 VUDs are deducted at the end of the day, leaving 800. 

Let’s say however, that the user starts the second run of the day at 8:30 AM. 
In this case, the first test does not complete the run before the second test 
initializes. There are now 400 Vusers running concurrently. At the end of the 
day, 400 VUDs are deducted because that is the highest number of 
concurrent Vusers. The total left for future use is now 600 VUDs.
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Configuring General Settings

You view and configure general settings from the System Configuration 
pages of the Performance Center Administration Site.

The General Settings page provides information about the system 
configuration. For example, you can set the time zone, the alert threshold, 
the autostart options, and the Performance Center maintenance services.

This page also provides read-only information, such as the upload directory 
path and the temporary graph directory.

Viewing General Settings

To view the General Settings page:

On the Performance Center left menu, select System Configuration > 
General Settings. The General Settings page opens.

This chapter describes: On page:

Viewing General Settings 141
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You can view the following General Settings, and update any editable 
settings in the boxes provided.

Global Settings

➤ Upload Directory. Specifies the path to the directory to which virtual user 
(Vuser) scripts are uploaded.

➤ Temporary Graph Directory. Specifies the path to the directory in which 
analysis graphs are stored. 

➤ Time Zone. Specifies the time zone used by the server (default is PST). You 
select the string that you want displayed within the Performance Center 
system.

➤ License VUD Alert Threshold. Specifies the threshold for issuing a VUD 
license alert. A VUD license limits the total number of Vusers that can be 
run concurrently within a period of 24 hours. The default alert setting is 
5000 Vusers. 

➤ PC System User. Specifies the name of the Performance Center user. To 
change the system user, see “Changing the System User” on page 31.

➤ Performance Center Installation Name. (Optional) Specifies the name of the 
Performance Center installation. 

Autostart Settings

➤ Maximum Number of Autostart Retries. Specifies the maximum number of 
attempts allowed by the Autostart mechanism to start a load test in case of 
failure.

➤ Autostart Retries Interval (min). Specifies the interval, in minutes, that the 
Autostart mechanism waits between retry attempts.
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Project Settings

➤ Use Routing. Enables projects to use configured target IPs (which prevent 
targeting load tests outside the run scope). For more information, see “Using 
IP Addresses” on page 237. Select Enable to enable use of target IPs (default) 
or select Disable to disable their use. 

➤ Vuser Scheduling. Enables users to schedule and reserve Vusers in the 
Timeslots page. Select Enable to enable use of Vuser Scheduling, or select 
Disable to disable use (default).

Note: If you attempt to change this setting, Performance Center performs a 
test to see if there are any autostart tests scheduled or future timeslots 
reserved. If there are, Performance Center displays an alert that you must 
delete all autostart tests and cancel all future timeslots before changing this 
setting.

➤ Collate Timeout. Specifies the maximum length of time (in minutes) to wait 
for collating results. Performance Center issues an error message about the 
timeout, and recommends that you increase the timeout value.

➤ Diagnostics Collate Timeout. Specifies the maximum length of time (in 
minutes) to wait for collating diagnostics results. Performance Center issues 
an error message about the timeout, and recommends that you increase the 
timeout value. 
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System Check Settings

➤ Host Checkup Service. Enables Performance Center to detect hosts in the 
Resource Failure state and, if possible, recover them to Operational. Select 
Enable to enable use of the Host Checkup Service (default), and to specify 
the checkup service frequency and the number of consecutive host resource 
failures before the service is discontinued, or select Disable to disable use. 

Note: Host recovery currently supports only Controllers and load generators 
installed on Windows machines for an English environment, and only load 
generators installed on Windows machines for a non-English environment.

➤ IIS Maintenance Service. Enables Performance Center to verify that IIS is 
operational and to restart IIS if necessary. Running tests are unaffected when 
IIS is restarted. It also restarts Performance Center when its memory limit is 
reached. Select Enable to enable use of the IIS Maintenance Service (default) 
and to specify the service frequency and Application Memory limit, or select 
Disable to disable use. 

➤ Restart IIS Daily. Enables Performance Center to restart IIS at a set time every 
day. Restarting IIS increases Performance Center stability and is highly 
recommended. Running tests are unaffected when IIS is restarted, and users 
can reconnect to tests and view progress. Select Enable to enable use of 
Restart IIS Daily (default) and to specify restart time, or select Disable to 
disable use.
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Configuring Server Information

You supply, view and edit Server details from the Performance Center 
Administration Site.

This chapter describes: On page:

About Server Configuration 148

Supplying Server Configuration Information 148

Viewing and Editing Server Configuration Information 150
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About Server Configuration

The Server Configuration page provides details as to where key components 
of Performance Center are located. You can use the Server Configuration 
page for mapping information, to establish where information should be 
stored and from where it should be retrieved.

Supplying Server Configuration Information

Important: To perform initial system configuration, the Performance Center 
system user must have administrative privileges.

The first time you log on to the Administration Site, you are redirected to 
the Server Configuration page. 

The Database information and File Server name are supplied during the 
product installation and are displayed as read-only. 
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To complete the server configuration (the first time you log on to the 
Administration Site):

Important: For all servers, it is recommended to provide the name of the 
machine, rather than the IP address.

 1 Click the Test Connection button to ensure that the specified connection 
works properly.

 2 In the Utility Server box, enter the name of the machine that hosts the 
Performance Center license.

Note: The Utility Server needs to be available at all times. When choosing a 
Utility Server, it is advisable to choose a machine that is not a host. 

 3 In the User site Servers section, enter the names of the computers on which 
the User Site will be installed.

 4 If you are using SiteScope to monitor a server, enter the relevant values for 
the SiteScope server used by Performance Center to monitor its own 
resources.

➤ SiteScope Server. Enter the name of the SiteScope server.

➤ SiteScope Port. Enter the SiteScope port (default:8888).

➤ Use HTTPs. Select this option to use a secure HTTP connection.

➤ Use Account. Select this option to use a specific SiteScope user account, 
and enter the SiteScope account details—name/number, user name, and 
password.

 5 Click Save to save the server configuration settings.
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Viewing and Editing Server Configuration Information

You can view and edit server configuration information at any time from 
the Server Configuration page.

To view and edit server configuration information:

 1 On the Performance Center left menu, select System Configuration > 
Server Configuration. The Server Configuration page opens.

 2 Edit any information that is not read-only. The Server Configuration page 
displays the following information:

Important: For all servers, it is recommended to provide the name of the 
machine, rather than the IP address.

➤ Database. The name of the machine on which the system database is 
installed (read-only). Click Test Connection to test the connection to the 
database using the previously supplied system details.

➤ File Server. The machine that contains the file server installation where 
system files such as scripts are stored.

➤ Utility Server. The machine that hosts the Performance Center license.

➤ User Site Servers. The Web servers on which the User Site will be 
installed.

SiteScope Configuration

➤ SiteScope Server. The name of the SiteScope server used to monitor your 
servers.

➤ SiteScope Port. The port of the SiteScope server used to monitor your 
servers (default:8888).

➤ Use HTTPs. Select this to use a Secure HTTP connection.
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➤ Use Account. Select this to use a specific SiteScope user account. Enter the 
following account details:

➤ Account. The SiteScope account name or number.

➤ Username. The user name defined to log on to the SiteScope account.

➤ Password. The password defined to log on to the SiteScope account.

 3 Click Save to update the server information. 

Click Reset to update the server connections.
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Configuring Diagnostics

You configure and view HP Diagnostics from the System Configuration 
pages of the Performance Center Administration Site.

Setting Up the Diagnostics Modules

You set up the Performance Center J2EE/.NET and ERP/CRM diagnostics 
modules from the Diagnostics page of the Administration Site.

You configure the ERP/CRM Diagnostics modules by defining the mediators 
that communicate with the Load Testing Server. For more information, see 
“Configuring ERP/CRM Mediators” on page 154.

You configure the J2EE/.NET Diagnostics module by defining the J2EE/.NET 
Diagnostics server environments. For more information, see “Setting Up the 
HP Diagnostics (J2EE & .NET) Environment” on page 156.

Before setting up the diagnostics modules:

If you are monitoring over a firewall, make sure that you perform the 
following:

➤ Install an MI Listener on a machine outside of the firewall. For installation 
instructions, see the HP Performance Center System Configuration and 
Installation Guide.

This chapter describes: On page:

Setting Up the Diagnostics Modules 153

Configuring ERP/CRM Mediators 154

Setting Up the HP Diagnostics (J2EE & .NET) Environment 156
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➤ Define the MI Listener in the MI Listeners page. For information on defining 
MI Listeners, see Chapter 4, “Managing MI Listeners.”

Note: MSXML 3.0 and later (this is included in Internet Explorer 6.0) should 
be installed on the client. You can install MSXML 3.0 from the Microsoft 
MSDN Web site (http://msdn.microsoft.com/library/default.asp?url=/downloads/
list/xmlgeneral.asp).

Configuring ERP/CRM Mediators

To generate Siebel/Oracle/SAP diagnostics data, you must set up the 
Siebel/Oracle/SAP diagnostics module to communicate with the mediators. 

Before setting up the Siebel/Oracle/SAP Diagnostics modules:

Make sure that you have installed an ERP/CRM mediator in the same LAN as 
the monitored Siebel/Oracle/SAP server. For installation instructions, see the 
HP Performance Center System Configuration and Installation Guide. 
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To set up the ERP/CRM mediators:

 1 On the Performance Center left menu, select System Configuration > 
Diagnostics. The Diagnostics page opens.

 2 To add a new mediator to the Mediators list, click Add Mediator. The Add 
Mediator dialog box opens.
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Type the name of a new mediator.

If you are monitoring over a firewall, select Enable Firewall. 

Note: Before you can add a mediator over the firewall, you need to define an 
MI Listener in the MI Listeners page. For details, see “Removing Hosts” on 
page 74.

 3 Click OK. The new mediator is added to the list of mediators and the 
following properties are displayed: 

➤ Name. The name of the mediator used to collect and process the 
diagnostics data.

➤ Over Firewall. Yes denotes that monitoring over firewall is enabled. No 
denotes that monitoring over firewall is not enabled.

➤ Status. The connection status between the Web server (Admin) and the 
mediator. The possible statuses are: Test passed, Test failed, and Testing 
connection. 

 4 To test the connection between the Web server (Admin) and the mediator, 
select a mediator and click Test. The Web server attempts to connect to the 
mediator. The connection status is displayed.

If the test fails, the Error Details button is displayed. Click the button for 
details of the error.

 5 To delete a mediator, select it in the list of mediators and click Delete.

Setting Up the HP Diagnostics (J2EE & .NET) Environment

You can view or edit information about the HP Diagnostics (J2EE and .NET) 
application host from the Diagnostics page. 

Before you can use HP Diagnostics with Performance Center, you need to 
ensure that you have specified the Diagnostics Server details on the 
Diagnostics page in the Performance Center Administration Site. For more 
information, see the HP Diagnostics Installation and Configuration Guide.
156



15
Configuring Server Authentication

This chapter describes configuring authentication details for logging on to 
Performance Center. When you install Performance Center, the default 
authentication details required to log on to Performance Center are those of 
a Performance Center user. 

To log on to Performance Center through an LDAP or SSO server, you need 
to configure the appropriate authentication details.

This chapter describes: On page:

LDAP Server Authentication 158

SSO Server Authentication 163

Restoring Default Performance Center Server  Authentication 171
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LDAP Server Authentication

When you install Performance Center, the default authentication required is 
that of a Performance Center user. To log on to Performance Center through 
an LDAP server, you need to configure the LDAP server authentication 
details in Performance Center. After configuring these details, the next time 
you log on to Performance Center, you provide the LDAP user credentials 
instead of Performance Center user credentials.

Before you begin, you must obtain the LDAP server authentication details 
from the LDAP system administrator. 

Configuring the LDAP server authentication details in Performance Center 
is described in the steps below.

Note: If the LDAP server is configured to run in secure mode, you need to 
install the SSL certificate on the Performance Center Web servers—both on 
the Administration site and User site servers. 

➤ Install the certificate in the Certificates Console of the local computer, 
under the Trusted Root Certification Authorities category.

➤ When configuring the LDAP server authentication below, the LDAP 
server name must be identical to the LDAP server name in the 
certificate’s Issued To field.
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Step 1: Create a Performance Center user that is identical to a 
valid LDAP user.

Ensure that there is Performance Center user whose user name matches that 
of a valid LDAP user. The Performance Center user must be an active (non-
expired) user, and must have the following permissions:

➤ Manage Servers 

➤ Create/Edit/Delete Users

➤ Create/Edit/Delete Roles

➤ Assign Users to Roles 

➤ Remove User from Roles

Note: Contact the LDAP system administrator to obtain the name of a valid 
LDAP user. 

If there is no user in Performance Center that matches a valid LDAP user, 
you need to create one. To create a Performance Center user, see “Adding 
Performance Center Users” on page 203.
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Step 2: Configure the LDAP server authentication.

Configure the LDAP server authentication in Performance Center. 

Note: You must obtain the LDAP server authentication details from the 
LDAP system administrator before you begin this procedure. 

After configuring Performance Center to use LDAP server authentication, 
when you log on to Performance Center, enter the LDAP user credentials.

To configure Performance Center to use LDAP server authentication:

 1 On the Performance Center left menu, select System Configuration > 
Authentication Server. The Authentication Server page opens.

 2 Select LDAP Server Authentication. 

 3 In the LDAP Server and Port boxes, type the LDAP server name and port 
number.

Note: When connecting to the LDAP server in secure mode:

➤ the LDAP server name must be identical to the LDAP server name in the 
SSL certificate’s Issued To field

➤ the Port must be a secured port

 4 Select the name of the LDAP Server vendor: Sun One or Active Directory.

➤ If the vendor is Sun One:

In the Base Distinguish Name box, type the full base distinguished name 
of the root directory on the LDAP server where all the LDAP users that 
need to access Performance Center are maintained. 

For example, 

ou=People,dc=mercury,dc=co,dc=il
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➤ If the vendor is Active Directory:

In the Users’ AD Domain box, type the fully qualified domain name on 
the LDAP server where all the LDAP users that need to access 
Performance Center are maintained. 

For example, 

Important: The LDAP users that need to access Performance Center must all 
be defined under the same Sun One tree or in the same Active Directory 
domain. Otherwise they are not recognized and Performance Center returns 
an error when attempting to log on.

 5 In the Unique User Attribute box, type the unique user attribute defined on 
the LDAP server—for example, uid or cn.

If the LDAP vendor is Active Directory, continue with step 7.

 6 If the LDAP vendor is Sun One, you need to select a user that can perform 
any type of search on the LDAP server. Depending on the configuration of 
the LDAP server, select one of the User for LDAP Search options, as follows:

➤ Use anonymous user. This can be any anonymous user. An anonymous 
user can run a search on the LDAP server only if the LDAP server is 
configured to allow this.

➤ Use other user. This must be a specified LDAP user who has search 
privileges on the LDAP server. When a search is requested on the LDAP 
server, only the user specified here can perform the search. 

Type the full base-distinguished user name and password for this LDAP 
user, and confirm the password by typing it in again.

 7 If you want to connect to the LDAP server in secure mode, select Enable SSL.

Note: If you enable SSL, the LDAP port must be a secured port.

DEVLAB.AD.HP
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 8 The Local PC Username list displays of all the active, non-expired 
Performance Center users. 

 a Select the user that matches a valid LDAP user. If there is no such user in 
this list, you must create one, as described in Step 1 of this procedure 
on page 159.

 b In the Local PC Password box, type the password of the selected 
Performance Center user.

 9 Click Save to save the LDAP authentication details.

➤ If the details provided are validated, Performance Center logs off and 
displays the login page. When you log on to Performance Center again, 
use the LDAP authentication details.

➤ If the details provided are invalid, Performance Center displays an error 
and the configuration is not saved. Try to configure the authentication 
again. If the configuration does not succeed, contact the LDAP system 
administrator.

Step 3: Enter the LDAP users into the Performance Center 
Database.

After logging on to Performance Center through the LDAP server, all the 
LDAP users that need to access Performance Center must be added to the 
Performance Center database. Add the users in the Users page, as described 
in “Adding Performance Center Users” on page 203. The login user names 
given to the users must be identical to the login user names on the LDAP 
server.

Note: When you add LDAP users to the Performance Center database, the 
Password and Confirm Password fields are disabled. All users with Locked 
status become Active.
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SSO Server Authentication

When you install Performance Center, the default authentication 
credentials required to log on to the system are those of a valid Performance 
Center user. To log on to Performance Center through an SSO server, you 
need to configure SSO server authentication details in Performance Center. 
After this configuration, the next time you log on to Performance Center, 
you must provide the SSO user credentials.

Note: Performance Center supports SSO server authentication for SSO 
systems that allow all characters in HTTP requests—that is, if the SSO 
server’s CSSA feature has not been enabled.

Configuring the SSO server authentication details in Performance Center is 
described in the steps below.

Step 1: Configure the SiteMinder Policy Server and WebAgents.

Set up the SiteMinder Policy Server to communicate with the IIS Web servers 
where the Performance Center Administration and User sites are installed. 

To set up the Policy Server:

 1 In SiteMinder, set up the Policy Server for the installation of the WebAgent 
clients.

 2 Install the WebAgent clients on the IIS Web servers where the Performance 
Center Administration and User sites are installed. 

 3 On the Policy Server, configure the Web Agent details. 

 4 On the Policy Server, define the security policies for the Performance Center 
Administration site and User site resources.

In SiteMinder, these security policies are called realms and should be 
defined for each Performance Center server as follows:
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➤ Administration site server resources:

➤ User site server resources:

 5 In the LogoffURI field, enter the URL to which to direct the browser when 
logging off Performance Center. Enter the URL as follows:

➤ If all the SSO system servers are set up with a specified logoff URL, enter 
this URL in the LogoffURI field for the Performance Center 
Administration site server, and for each of the Performance Center User 
site servers.

➤ If Performance Center is to use an internal logoff URL:

➤ If the Administration and User sites are installed on different servers, 
then for each server in the LogoffURI field, enter SSOLogoutPage.asp.

➤ If the Administration and User sites are installed on the same server, 
then in the LogoffURI field, enter

Resource Filter Authentication Scheme
Default Resource 
Protection

/Admin HTML Form Template Protected

/Admin/Include/GetSession HTML Form Template Unprotected

/Admin/MemorySize HTML Form Template Unprotected

Resource Filter Authentication Scheme
Default Resource 
Protection

/Loadtest HTML Form Template Protected

/Loadtest/Include/GetSession HTML Form Template Unprotected

/Loadtest/RequestDispatcher Basic Template Protected

/Loadtest/MemorySize HTML Form Template Unprotected

/Admin/SSOLogoutPage.asp
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Step 2: Log on to Performance Center and configure the SSO 
server authentication settings in Performance Center.

When the WebAgents are installed on the Performance Center server, 
logging on to Performance Center requires the single-sign-on credentials. 

To log on to Performance Center and configure the SSO server 
authentication:

 1 Navigate to the Performance Center site. Because of the security policies you 
defined in Step 1 above, the SSO server login page opens, requesting the 
SSO credentials.

 2 Enter the SSO credentials, as provided by the SiteMinder administrator. The 
Performance Center Administration site login page is displayed. 

Note: At this point the Policy Server creates a cookie with the SSO 
credentials and sends it back to local drive where it is saved. 

The cookie remains valid for a period of time defined in the Policy Server 
configuration. While it is valid, any time you try to access one of the 
Performance Center resources in the domain, the relevant WebAgent checks 
for the valid credentials in the cookie and allows you to access the resources 
without requesting authentication credentials.

After this period, the cookie is erased from your local drive, and you must 
enter the SSO authentication credentials again.

 3 Log on to the Performance Center Administration site using the 
Performance Center user’s login credentials. 
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 4 Ensure that there is a Performance Center user whose user name matches 
that of a valid SSO user. The Performance Center user must be an active 
(non-expired) user, and must have the following permissions:

➤ Manage Servers 

➤ Create/Edit/Delete Users

➤ Create/Edit/Delete Roles

➤ Assign Users to Roles 

➤ Remove User from Roles

Note: Contact the SSO system administrator to obtain the name of a valid 
SSO user. 

If there is no user in Performance Center that matches a valid SSO user, you 
need to create one. To create a Performance Center user, see “Adding 
Performance Center Users” on page 203.

 5 On the Performance Center left menu, select System 
Configuration > Authentication Server. The Authentication Server page 
opens. 

 6 Scroll down the page, and select SSO Server Authentication.

 7 In the Login Parameter box, enter the HTTP header that contains the user’s 
mapping key (see step 9 below).
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 8 In the Logout URL box, enter the URL to which to direct the browser when 
logging off Performance Center. Enter the URL as follows.

➤ If all the SSO system servers are set up with a specified logoff URL, in the 
Logout URL box enter the fully qualified name of that URL you entered 
in the LogoffURI field in the SiteMinder configuration (in Step 1 of this 
procedure above).

➤ If Performance Center is to use an internal logoff URL:

➤ If the Administration and User sites are on different servers, in the 
Logout URL box enter the default logoff URL, SSOLogoutPage.asp.

➤ If the Administration and User sites are on the same server, in the 
Logout URL box enter

 9 Under User’s Mapping select one of the following: 

➤ Map users according to user's login name. Maps the user login name in 
Performance Center to that on the SSO system server.

➤ Map users according to user's custom field. Maps the user’s custom field 
in Performance Center to the same field on the SSO system server. 

If you select this option, enter the following parameters to create an 
initial link between the Performance Center database and the SSO system 
server:

➤ Local PC Username. Select a Performance Center user from the list. 

The Performance Center user must be an active (non-expired) user, 
and must have the following permissions:

Manage Servers, Create/Edit/Delete Users, Create/Edit/Delete Roles, 
Assign Users to Roles, Remove User from Roles

http://<machine_name/Admin/SSOLogoutPage.asp
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Important: The login name of the selected Performance Center user 
must be identical to the login name of a valid SSO user. If it does not 
match a valid SSO user, Performance Center displays an error. 

To configure a valid user, you must log on to the Performance Center 
server using the default Performance Center authentication and 
reconfigure the SSO server authentication. To do this, you need to 
restore the default authentication. For details, see “Restoring Default 
Performance Center Server  Authentication” on page 171.

➤ Local PC Custom Field. Enter the custom field value of the matching 
SSO user.

For example, if you selected the user’s email address to be the 
mapping field (in the Login Parameter box—step 7 above), enter the 
email address of the SSO user that matches the Performance Center 
user that you selected here. 

 10 Click Save to save the SSO authentication details. Performance Center 
automatically closes.

Step 3: Log on to Performance Center.

Open Performance Center. The non-expired cookie containing the SSO 
credentials allows you to go straight into the Performance Center sites, 
without requesting authentication credentials.

Step 4: Add the SSO users to the Performance Center database.

All the SSO users that need to access Performance Center must be added to 
the Performance Center database. 

Add the users in the Users page, as described in “Adding Performance Center 
Users” on page 203.
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Important: 

➤ If, when defining the SSO Authentication Server details above, you 
selected Map users according to user's login name, enter the exact SSO 
user (login) name into new Performance Center user’s User Name box.

➤ If, when defining the SSO Authentication Server details above, you 
selected Map users according to user's custom field, in the User 
Information (Add mode) form a new mandatory field, Custom Field, 
appears. This field constitutes the mapping field between the user in the 
Performance Center database and the SSO user. The Custom Field value 
that you enter for the new Performance Center user must be identical to 
value defined for that user on the SSO server. 
For example, if you selected the user’s email address to be the mapping 
field (in the Login Parameter box—step 7 above), enter the email address 
of the SSO user in the Custom Field box.

Note: When you add SSO users to the Performance Center database, the 
Password and Confirm Password fields are disabled. All users with Locked 
status become Active.
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Connecting to Performance Center in SSO Authentication 
Mode from a Standalone Application
When you are working with a standalone application, and you want to 
connect to Performance Center in SSO authentication mode, you need to 
log on with valid SSO credentials. The SSO server authenticates the user, 
creates a cookie, and sends the cookie back to the standalone application 
host where it is saved. Then the user is authenticated by Performance 
Center. 

The SSO server creates an SSO cookie when: 

➤ the user is authenticated by SSO and by Performance Center

➤ the user is authenticated by SSO, but not in Performance Center (user not 
active, user expired, and so on)

The cookie that is saved on the host of the standalone application remains 
valid as long as the application is running. As soon as the application is 
closed, the cookie is removed.

Important: To log on to Performance Center with a different user name, you 
need to close the standalone application and re-invoke it. As mentioned 
above, closing the application removes the SSO cookie from the 
application’s host. This prevents a user mismatch when you try to log in 
with a different user name.
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Restoring Default Performance Center Server 
Authentication

When Performance Center is configured for LDAP or SSO server 
authentication, you can revert back to the default Performance Center 
authentication at any time, or you may be forced to restore the default 
authentication due to connection problems.

Reverting to Default Authentication
You can revert back to default Performance Center server authentication 
from the Authentication Server page. 

To revert back to the default server authentication:

 1 On the Performance Center left menu, select System Configuration > 
Authentication Server.

 2 Select PC Server Authentication, and click Save.

Note: Reverting back to the default Performance Center server 
authentication through the Authentication Server page resets all the users’ 
passwords to welcome.
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Restore Default Authentication Method Utility
If you are experiencing problems logging on to Performance Center with the 
LDAP or SSO server authentication configuration, you need to restore 
Performance Center authentication using the Restore Default 
Authentication Method utility, provided on the Performance Center 
installation disk. After restoring default authentication, you can log on to 
Performance Center using default Performance Center authentication 
credentials, and reconfigure the relevant server authentication.

To run the Restore Default Authentication Method utility:

 1 From the root folder of the Performance Center installation disk, copy 
\Additional Components\Unlock Utility\PCAuthentciationModeUtility.exe 
to a local drive on your computer.

 2 Run PCAuthentciationModeUtility.exe from the local drive.

The Restore Default Authentication Method utility opens. 

 3 Enter the Database Server name.

 4 Enter the type of Database Server—MS-SQL or Oracle.

 5 Enter the Database Server login credentials. You can accept the default 
credentials, or enter customized credentials. 

To customize the Database Server login credentials, select Customized 
Database Login, and enter the user name and password of the Performance 
Center database user.

Note: The Performance Center database user must have admin privileges.

 6 Click Restore Default Authentication Method. The Performance Center 
server authentication is restored. 
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Configuring Alerts

You configure and view email alerts from the System Configuration pages of 
the Performance Center Administration Site.

Performance Center uses alerts to let you know when server performance 
problems occur during a load test. The alerts provide real-time information 
about your server performance. Alerts are triggered whenever one of the 
measurements monitored by SiteScope is out of the defined range (memory, 
CPU, or disk space), or when a service that is supposed to run is not 
running. 

When configuring SiteScope, you specify the frequency at which alerts 
should be sent when an event is detected, and the email addresses to which 
the alert is to be sent. In addition, a warning that system performance is less 
than optimal or that not all services are running is indicated by a colored 
light (other than green) in the Hosts/Servers page. You define alert 
frequency and email preferences from the Alerts Configuration page. 

Note: You must configure the SiteScope server on the Server Configuration 
page before you can configure an alert. For more information, see 
Chapter 13, “Configuring Server Information.”
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To configure email alerts:

 1 On the Performance Center left menu, select System Configuration > 
Alerts Configuration. The Alerts Configuration page opens.

 2 Select one of the following Alert Frequency options: 

➤ Once. This sends an alert once, after the event occurs.

➤ Every X time(s) that event occurs. Type the number of times that the 
event must occur before sending an alert. This sends an alert after the 
event has occurred the specified number of times.

➤ Each time that event occurs. This sends an alert each time the event 
occurs.

➤ Never. An alert is never sent.

 3 Under Initial Alert trigger, type the number of times an event of this type 
must occur before sending an initial alert.
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 4 Under E-mail Account Configuration, enter the following information:

➤ Alert E-mail Address. Type the email addresses where the alert is to be 
sent. You can enter multiple email addresses, separated by commas.

➤ Mail Server Domain Name. Type the mail server domain name.

➤ Backup Mail Server Domain Name. Type the backup mail server domain 
name. 

➤ From E-mail Address. Type the email address from where the alert is 
generated.

 5 Under Administrator Status Reports, enter the following information:

➤ Administrator E-Mail Address. Type the email address of the 
administrator.

➤ SiteScope Status Messages. You can select the following SiteScope status 
messages:

➤ Daily Status. Provides daily status updates on the SiteScope server.

➤ SiteScope Starts/Restarts. Provides information on the SiteScope 
server starts and restarts.

 6 Click Save to save your settings.
175



Chapter 16 • Configuring Alerts
176



17
Running Vusers over a Firewall

You can run Vusers within a firewall, while the Controller is outside the 
firewall.

About Running Vusers over a Firewall

Once you set up your environment, as described in the HP Performance 
Center System Configuration and Installation Guide, you need to configure your 
system to run Vusers over the firewall. You configure your system from the 
Performance Center Administration site.

This chapter describes: On page:

About Running Vusers over a Firewall 177

Running Vusers Over the Firewall 178
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Running Vusers Over the Firewall

To enable running Vusers over the firewall, you need to add the host 
location, and configure your host to run Vusers over a firewall.

To run Vusers over the firewall:

 1 On the Performance Center left menu, select Resources > MI Listeners.

 2 In the MI Listeners page, click Add. The Add New MI Listener dialog box 
opens.

 3 Type the IP address or name of the MI Listener that enables the running of 
Vusers over the firewall.

Note: This MI Listener can be the same as your monitoring MI Listener.

 4 To add the host location, on the left menu, select Resources > Host 
Locations and click Add Host Location. The Add Host Location dialog box 
opens.

➤ Type the location name. The name should have a logical connection to 
the host location. 

➤ Select Yes to indicate that the host is over the firewall. 

Click OK to add the location to the list.
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 5 To add the host name, on the Performance Center left menu select 
Resources > Hosts. In the Hosts page click Add Host. The Add New Host 
dialog box opens.  

 a In the Name box, type a name for the host to specify the over the firewall 
host location. 

 b In the OS Type box, select the operating system, and enter your system 
login name if required.
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 c In the Purpose box, select Load Generator. This is the only purpose that 
can be assigned to a host located over a firewall. 

 d Type a Priority number, and select the host details: Location, MI Listener, 
Host Pool, and State.

Click Save to add the host to the list. For more information, see “Adding 
Hosts” on page 46.

 6 Configure the Performance Center agent. For more information, see the 
section in the HP Performance Center System Configuration and Installation 
Guide that describes monitoring over a firewall.

Note: When specifying the Local Machine Key, you must use the format 
hostname_locationname where hostname is the name of the host in the Hosts 
page of the Administration Site, and locationname is the name of the host 
location in the Host Location page.

Your system is now configured to run Vusers over the firewall.
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Understanding Performance Center 
Reports

You can get an overall analysis of Performance Center site users, system 
resource usage, load test runs, and autostart load tests from the Performance 
Center Administration Site.

About Reports

The Site Users Report page provides detailed user information, including the 
projects that each users can access, user privilege levels, user status, and user 
expiration dates.

The Resource Usage Report page provides details of resource usage by 
individual users, as well as, overall system resource usage.

The Test Run Information Reports page provides aggregate details of runs on 
a per-project or per-user basis. The Run Reports page also provides a link to 
view information on individual runs.

This chapter describes: On page:

About Reports 183

Working with Reports 184

Site Users Report 186

Resource Usage Report 187

Test Run Information Report 189

Autostart Viewer Report 193
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The Autostart Viewer Reports page provides information about all autostart 
load tests in a project, and provides a link to status reports on tests that have 
run. The Autostart Viewer Reports page also enables you to cancel scheduled 
tests.

Working with Reports

This section describes working with the Performance Center reports.

Sorting a Report
You can sort the Performance Center reports according to the values of any 
column. The arrow in the heading displays whether the column is sorted in 
ascending or descending order.

When you click a column heading, the down arrow appears, indicating that 
the column is sorted in descending order. 

Clicking the column again reverses the arrow’s direction and the entries are 
displayed in the opposite order.
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Selecting a Report Time Range
For the Resource Usage and Test Run Information reports, you can select to 
display the data over a specific time range. 

To select a time range for the report:

 1 In the report page, click the Show usage/information from browse button. 
The Calendar dialog box opens.

 2 Select a date and time for the start of the range.

 3 Click Set. The calendar closes and the Show usage/information from box is 
updated.

 4 To set the end of the range, repeat steps 1 - 3 for the to box.

 5 Click Go. The report displays the information for the selected time range.
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Site Users Report

The Site Users report displays a complete list of users in the Performance 
Center system. The Site Users report specifies the total number of users in 
the system, and provides information on each user’s project access, privilege 
level, status, and expiration date. The report is available from the 
Performance Center left menu.

To open the Site Users report:

On the Performance Center left menu, select Reports > Site Users. The Site 
Users report opens.

The Site Users report displays the following information:

➤ Include expired Users and Projects. The report includes current users and 
projects, as well as users and projects that expired and were deleted from the 
system.

➤ Total Number of Users. The total number of users that are in the 
Performance Center system.

➤ User Name. The name of the user.

➤ Project. The name of the project.

➤ Privilege. The user’s privilege level.

➤ Active. The status of the user in the Performance Center system. The status 
can be active or non-active. A user with a non-active status cannot log on to 
the system. This field cannot be edited.

➤ Expires At. The date and time that the user is due to be deleted from the 
system.
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Sorting Results

You can sort the Site User report according to the values of any column. The 
arrow in the heading displays whether the column is sorted in ascending or 
descending order. For more information, see “Sorting a Report” on page 184.

Resource Usage Report

The Resource Usage Report provides general information about the usage of 
your system resources. The report is available from the Performance Center 
left menu. You can view statistics per user within a project and for total 
usage by project.

To open the Resource Usage report:

On the Performance Center left menu, select Reports > Resource Usage. The 
Resource Usage report opens.

The Resource Usage report displays the following information:

➤ Project/User. The name of the project or user.

➤ Total Active Duration. The total time tests were run during reserved 
timeslots.

➤ Total Reserved Duration. The total time reserved, in the Timeslots page, by 
user or per project.

➤ Avg Hosts per Active Hour. The average number of hosts used per active 
hour.
187



Chapter 18 • Understanding Performance Center Reports
➤ Avg Vusers per Active Hour. The average number of running Vusers per 
active hour.

Note: An active hour/duration refers to the actual running time of your 
tests.

Sorting Results

You can sort the Resource Usage report according to the values of any 
column. The arrow in the heading displays whether the column is sorted in 
ascending or descending order. For more information, see “Sorting a Report” 
on page 184.

Selecting the Resource Usage Report Time Range

Performance Center enables you to select the time range for the Resource 
Usage report. For details on selecting a time range for the report, see 
“Selecting a Report Time Range” on page 185.

Selecting the View

The View by options allow you to view usage information by project or by 
user.
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Test Run Information Report

The Test Run Information report provides general information about the 
test runs. The report is available from the Performance Center left menu. 
You can view statistics per user within a project and for total usage by 
project.

To open the Test Run Information report:

On the Performance Center left menu, select Reports > 
Test Run Information. The Test Run Information report opens.

The Test Run Information report displays the following information:

➤ Project/User. The name of the project or user.

➤ Total Runs. The total number of runs for the project/user during the 
specified time range.

➤ Total Vusers Involved. The total number of Vusers involved in runs during 
the specified time range.

➤ Avg Vusers per Run. The average number of Vusers used per run.

➤ Total Duration. The total time used by the listed runs.

➤ Avg Duration per Run. The average time used for the listed runs.

➤ Avg Hosts per Run. The average number of hosts used per run.

Sorting Results

You can sort the Test Run Information Report according to the values of any 
column. The arrow in the heading displays whether the column is sorted in 
ascending or descending order. For more information, see “Sorting a Report” 
on page 184.
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Selecting Test Run Information Report Time Ranges

Performance Center enables you to select the time range for the Test Run 
Information report. For details on selecting a time range for the report, see 
“Selecting a Report Time Range” on page 185.

Selecting the View

The View by options allow you to view usage information by project or by 
user.

Viewing Test Run Information Report Details
In addition to summary information for your runs, you can also view details 
on a per-user or per-project basis.

To view run details per project:

 1 On the Performance Center left menu, select Reports > 
Test Run Information.

 2 From the Test Run Information report, select View by Project.

 3 Click the desired project. The Details for Project page opens and displays run 
information grouped by user.

You can sort the table in ascending or descending order by clicking a 
column heading. Click the column heading again to reverse the sort order.
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 4 To view all project runs, select View all Runs. The table expands and displays 
all runs for the project. 

The View all Runs table displays the following information:

➤ RunId. The unique ID number assigned to the run.

➤ Run Date. The date and time of the load test run.

➤ User. The name of the user.

➤ Total Vusers Involved. The number of Vusers for the run.

➤ Hosts. The number of hosts used for the run.

➤ Duration. The time used by the run.

 5 Click Back to return to the Test Run Information report.
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To view run details per user:

 1 On the Performance Center left menu, select Reports > 
Test Run Information.

 2 From the Test Run Information page, select View by User.

 3 Click the desired user. The Details for User page opens and displays run 
information grouped by project.

You can sort the table in ascending or descending order by clicking a 
column heading. Click the column heading again to reverse the sort order.

 4 To view all user runs, select View all Runs. The table expands and displays all 
runs for the user. 

The View all Runs table displays the following information:

➤ RunID. The unique ID number assigned to the run.

➤ Run Date. The date and time of the load test run.
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➤ Project. The name of the project.

➤ Total Vusers Involved. The number of Vusers for the run.

➤ Hosts. The number of hosts used for the run.

➤ Duration. The time used by the run.

 5 Click Back to return to the Test Run Information page.

Autostart Viewer Report

The Autostart Viewer report provides information about load tests with 
autostart for all projects. Along with the general information provided in 
the main table, you can access status reports on tests that have run, and 
cancel tests that are scheduled to run. 

The Autostart Viewer report gives information about tests scheduled to 
autostart. The actual scheduling of the autostart is done in the Timeslots 
page, while the configuring of the test is done when you create a new load 
test. For details on scheduling and configuring the autostart, see the HP 
Performance Center User’s Guide.
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To view a status report on a test that has run:

On the Performance Center left menu, select Reports > Autostart Viewer. 
The Autostart Viewer report opens.

The report displays a table of information on all tests scheduled to autostart, 
navigation arrows for the table, and a link to the Autostart Load Tests report.

The table supplies the following information:

➤ ID. A unique number identifying the autostart load test.

➤ Date and Time. The date and time of the timeslot you reserve when you 
schedule a test to autostart.

➤ Project Name. The name of the project.

➤ User Name. The name of the user who scheduled the test.
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➤ Test Name. The name of the test that is scheduled to autostart. This is the 
same name that was given when the test was created.

➤ Status. The status of the autostart test. Some of the information (Scheduled 
to run, Failed to Run, Insufficient Resources) is specific for the autostart 
status, other information describes the tests’ status in the test workflow. For 
more information on the test workflow, see “Changing a Test Run State” on 
page 116. Click an entry in the Status column to open the Autostart Load 
Test Report.

➤ Duration. The duration of the test scheduled to autostart, as defined when 
reserving the timeslot.

➤ Hosts. The number of hosts assigned to the autostart test, as defined when 
reserving the timeslot.

➤ Vusers. The number of Vusers assigned to the autostart test, as defined when 
reserving the timeslot. 

Note: Autostart tests that have not yet started their run can be canceled by 
clicking the X in the Delete column. Deleting an entry from the Autostart 
Viewer report releases the reserved timeslot.

Sorting Tests
When you open the Autostart Load Tests report, the tests are sorted on the 
Date and Time key. You can also sort the tests according to the Project 
Name, User Name, Test Name or Hosts. For more information, see “Sorting a 
Report” on page 184.
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Viewing Autostart Load Test Reports
The Autostart Load Test report displays an overview of load test performance 
and a table of the autostart actions.

To view the Autostart Load Test report:

In the Autostart Viewer report, click a link in the Status column. The 
Autostart Load Test report for that test opens. 

You can view and access the following information in the Autostart Load 
Tests report:

➤ Load Test performance information. The information includes the start of 
the run, Vuser information, the Controller of the load test, and the names of 
any additional hosts.

➤ Autostart Test actions. This information reports on the autostart aspect of 
the test run, not on the actual running of the load test. The table gives a step 
by step list of the progress of the test. This information includes the start 
time, the initialization time, and the end time of the test.

The Time column supplies the date and time of the action, while the Status 
column supplies a self-explanatory note of the action performed or the 
problem the test encountered.
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User Management

The User Management module is used for managing, user roles and 
privileges, project information, and user-role-project assignments.

The Personal Information page stores all your personal information.

The Users page stores information about all the Performance Center users.

This chapter describes: On page:

Understanding User Information 200

Managing Your Personal Information 201

Managing User Information 202
199



Chapter 19 • User Management
Understanding User Information

You view and manage your personal user details and other users’ details in 
the User Management module. User information includes a user’s login 
information, personal details, and other general information.

Detail Description
Lo
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User Name The user’s username for logging on to 
Performance Center

Password The user’s password for logging on to 
Performance Center

(Not editable for LDAP/SSO users.)

Account Expiration Date The expiration date of the user account

Pe
rs

o
n

al
 D

et
ai

ls Full Name The user’s full name

E-mail The user’s email address

Additional Data Any additional relevant information about 
the user

G
en

er
al

 In
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rm
at
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n

User Creator The name of the user who created the user 
account in the system. 

This field is automatically filled in when a 
user is added. It cannot be edited.

User Status The status of a user can be active or non-
active. 

(Not editable for LDAP/SSO users.)

Note: A user with a non-active status 
cannot log on to Performance Center.

Creation Date The date (and time) on which the user 
account was created in the system.
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Managing Your Personal Information

You can view and edit your personal user details in the Personal Information 
page. 

To view and edit your personal information:

 1 On the Performance Center left menu, select User Management > Personal 
Information. 

 2 To edit your personal details, click Edit. The Personal Information area 
switches to Edit mode.

 3 Edit the details and click Save to save your changes.

You can edit your user name and password, your full name and email 
address, and the additional data section.

For more information about the details displayed in the Personal 
Information page, see “Understanding User Information” on page 200.
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Managing User Information

The Users page displays a list of all the users in the Performance Center 
system. 

To access this page, on the Performance Center left menu, select User 
Management > Users.

The Users page displays 50 users in the Performance Center system at a time.

To see more users you can scroll down the list, and use the arrow buttons 
above the table to navigate between sets of 50 users.

To see a particular user’s details, select the user in the list. The User 
Information section in the lower area of the page displays user information 
for the selected user.
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Tip: 

➤ To search for a specific user or alphabetic string, in the Find users box, 
type the user name (or part thereof), and click Find. Performance Center 
returns the appropriate list.

Entering part of a name returns a list of all the users that have the 
specified string anywhere in their names. If you entered th, the display 
list might include Seth, Thomas, and Anthony.

➤ To view the full list of users again, click Show All.

Adding Performance Center Users
You add new Performance Center users in the Users page.

To add a user:

 1 On the Users page, click Add New User. The User Information area switches 
to Add mode and displays an empty User Information form.

 2 Enter the new user’s details. For more information, see “Understanding User 
Information” on page 200.

Note: When adding LDAP or SSO users, the Password and Confirm 
Password fields are not editable. These values are taken from the user’s 
details in the respective system.

 a Enter a user name and password for the new user.

 b Set an expiration date for the user account. 

Under Account Expiration Date, click the Select expiration date link. A 
calendar window opens. Select the desired date and time, and click Set. 
The calendar closes and the account expiration date is updated. 

If you want the user account to always remain valid, select Never Expires.
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 c Enter the user’s personal details.

 d Select a status for the user—Active or Non Active.

Note: Non-active users cannot log on to Performance Center.

 3 To add the user to the list, click Add. 

To clear all fields, click Clear. 

To return to viewing user information without adding the new user, click 
Cancel. 

Modifying User Information
You modify user details in the Users page.

To modify a user’s details:

 1 On the Users page, select the user whose information you want to modify.

 2 Click Edit. The User Information area switches to Edit mode. 

 3 Modify the details. 

You can edit a user’s login information, personal details, and user status.

For more information about the details displayed in the User Information 
area, see “Understanding User Information” on page 200.

 4 Click Save to save the changes to the user’s information.

Tip: In cases where users forgets their passwords, use the Edit mode to assign 
new passwords.
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Deleting Performance Center Users
On the Users page, select the user you want to delete and click Delete. Click 
OK to confirm that you want to delete the user. 

The user is deleted from the list of users.
205



Chapter 19 • User Management
206



20
Defining User Roles

This chapter describes defining roles in Performance Center. Roles are 
defined groups of permissions that can be assigned to one or many users. A 
role determines which tasks the user can perform, and that information the 
user can access.

Understanding Performance Center and Project-Related 
Permissions

When creating roles, you select permissions for performing Performance 
Center or project-related tasks in the Performance Center system. 

Some permissions are dependent on other permissions. This means that a 
role containing a permission that has dependants automatically contain the 
dependant permissions too. These permission dependencies are noted in the 
tables described in the sections that follow.

This chapter describes: On page:

Understanding Performance Center and Project-Related  Permissions 207

Managing Roles in Performance Center 215

Assigning Roles to Users 221
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Performance Center Task Permissions
This section decribes the permissions assignable for Performance Center 
system related tasks.

Project Management and User Permissions

Permission Description

Project Management

Create project Allows the user to create projects

Dependants: 

➤ Edit project

Edit project Allows the user to edit projects

Delete project Allows the user to delete projects

User Management

Create user Allows the user to create Performance Center users

Dependants:

➤ Edit user

➤ Edit user personal information

Edit user Allows the user to edit user details

Dependants:

➤ Edit user personal information

Delete user Allows the user to delete users

Assign user to role Allows the user to assign roles to users

Remove user from role Allows the user to remove user-role assignments

Edit user personal data Allows the user to edit personal information
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Resource Management Permissions

Role Management

Create role Allows the user to create roles

Dependants:

➤ Edit role

Edit role Allows the user to edit role definitions

Delete role Allows the user to delete roles

Copy role Allows the user to copy roles

Dependants:

➤ Create role

➤ Edit role

License Management

Manage License Allows the user to insert or edit a Performance 
Center license or a host license

Permission Description

Host Pool Management

Create pool Allows the user to create host pools

Dependants:

➤ Edit pool

Edit pool Allows the user to edit host pools

Delete pool Allows the user to delete host pools

Permission Description
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Host Management

Add host Allows the user to add hosts

Dependants:

➤ Edit host (all data)

➤ Edit host (partial)

Edit host (all data) Allows the user to edit host details

Dependants:

➤ Edit host (partial)

Edit host (partial) Allows the user to edit the following host details 
only: Priority; State; Pool; Comment

Delete host Allows the user to delete hosts

Host Maintenance

Install patch Allows the user to install patches on Performance 
Center servers/hosts

Dependants:

➤ Reboot machine

Reboot machine Allows the user to reboot Performance Center 
servers/hosts

Check host Allows the user to check the status of Performance 
Center servers/hosts

Kill process Allows the user to end running processes on 
Performance Center servers/hosts

Deallocate host Allows the user to release hosts that are left in 
Running status after a load test has finished running

Permission Description
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General Performance Center Permissions

Timeslot Management

Delete timeslot Allows the user to delete a timeslot from the 
Administration site

Run Time Operations

Delete Run Allows the user to delete runs

Permission Description

Manage servers Allows the user to manage configuration on all 
Performance Center servers

Manage diagnostics 
servers

Allows the user to add/edit/delete diagnostics 
servers

Manage MI listeners Allows the user to add/edit/delete MI listeners

Edit alerts Allows the user to edit email alert configuration

Edit general settings Allows the user to edit the Performance Center 
general settings

Permission Description
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Project-Related Task Permissions
This section decribes the permissions assignable for project-related tasks.

Load Testing - Design Permissions

Permission Description

Load Test Management

Create load test Allows the user to create load tests

Dependants:

➤ Edit load test

Edit load test Allows the user to edit load tests

Delete load test Allows the user to delete load tests

Dependants:

➤ Delete run

➤ Delete timeslot

➤ Delete monitor profile

➤ Delete run results

Upload script Allows the user to upload scripts from VuGen

Delete script Allows the user to delete scripts

Monitor Profile Management

Create monitor profile Allows the user to create monitor profiles

Dependants:

➤ Edit monitor profile

Edit monitor profile Allows the user to edit monitor profiles

Delete monitor profile Allows the user to delete monitor profiles
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Dashboard Management

Configure SLAs Allows the user to create and edit service level 
agreements

Delete SLAs Allows the user to delete service level agreements

Publish SLA statutes Allows the user to publish service level agreement 
statuses to the Dashboard

General

Edit user personal data Allows the user to edit personal information

Download applications Allows the user to download applications from the 
Downloads page

Integration with VuGen Allows the user to enable integration with 
Standalone VuGen

Dependants:

➤ Upload scripts

Integration with Analysis Allows the user to enable integration with 
Standalone Analysis

Permission Description
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Resource Management Permissions

Load Testing - Run-Time Permissions

Permission Description

Timeslot Management

Create timeslot Allows the user to create timeslots

Dependants:

➤ Edit timeslot

Edit timeslot Allows the user to edit timeslots

Delete timeslot Allows the user to delete timeslots

Create Autostart Allows the user to configure the Autostart feature

Dependants:

➤ Run load test

➤ Create timeslot

➤ Edit timeslot

Resource Management

Reboot machine Allows the user to reboot Performance Center 
servers/hosts

Check host Allows the user to check the status of Performance 
Center servers/hosts

Kill process Allows the user to end running processes on 
Performance Center servers/hosts

Permission Description

Run-Time Operations

Run load test Allows the user to run load tests (create runs)

Stop run Allows the user to stop runs
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Managing Roles in Performance Center

Performance Center comes packaged with predefined system roles, called 
canned roles. For example, the Administrator role is a canned role that 
grants a user permission to perform administration-level tasks.

You can also create user-defined roles. 

Roles are assigned to users within Performance Center projects.

This section describes:

➤ “Viewing Roles in Performance Center” below

➤ “Understanding Canned Roles” on page 217

➤ “Creating User-Defined Roles” on page 218

➤ “Editing Roles” on page 219

Delete run Allows the user to delete runs

Dependants:

➤ Delete run results

Manual operation during 
run

Allows the user to change run-time settings during a 
run

Add run notes Allows the user to add summary information about 
a run

Collate/Analyze results Allows the user to collate or analyze run results

Dependants:

➤ Stop run

Upload files to Results 
page

Allows the user to upload files to the Load Test 
Results page

Configure scenario 
schedule

Allows the user to create load test schedules

Delete run results Allows the user to delete load test results

Permission Description
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➤ “Copying Roles” on page 219

➤ “Deleting Roles” on page 220

Viewing Roles in Performance Center
You view roles in the Roles Management page.

To access the Roles Management page, on the Performance Center left menu 
select User Management > Roles.

The left pane of the Roles Management page contains two tabs which 
display the lists of roles. The tabs display:

➤ Performance Center roles. Allow the user to manage Performance Center 
assets—such as projects, users, and roles—and resources—such as hosts 
and servers.

➤ Project roles. Allow the user to manage project-related resources, and 
load test design and run-time settings.

Filtering the List of Roles

To facilitate locating a specific role, you can filter the list of roles by role 
name. 

To filter the list of roles:

 1 Under the relevant roles tab (Performance Center or Project), in the Role 
box, type the name of the role (or part of the name).

 2 Click Filter.

The lists display all the roles whose names contain the string that you 
entered.

Note: The filter is applied in the selected roles tab only.

To clear the filter:

➤ In the Role box, clear the text and click Filter. All the roles are displayed.
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Understanding Canned Roles
The following table describes the canned (predefined) roles that are built 
into Performance Center. These roles cannot be edited or deleted.

Canned Role Description

Administrator
(Performance Center role)

Privileges: Performance Center administration 
privileges—project/user/roles/licence management; 
resource management—hosts and servers, events; 
reports; general settings

Project Manager
(Project role)

Privileges: Projects and project resources; reports; 
Dashboard; events.

Manages the engagement between the LOB (Life of 
Business) and the COE (Center of Excellence). Does 
not perform any load testing but ensures that the 
project works as planned.

Power Tester
(Project role)

Privileges: Configure and run load tests; 
share/import/export assets; publish to Dashboard; 
reboot machines.

Load testing user. Can manage limited resource 
tasks.

Tester
(Project role)

Privileges: Configure and run load tests

Load testing user. No resource management 
privileges.

LT Advisor
(Project role)

Privileges: View run screen, Vuser groups, graphs; 
perform manual operations on Vusers and Vuser 
groups 

Guest
(Project role)

Privileges: Edit personal details and configure own 
graphs; view run, graphs, Vuser groups
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Creating User-Defined Roles
If you have at least Create role privileges, you can create user-defined roles. 
You create roles in the Roles page. When you create a role, you give it an 
appropriate name and description, and select the permissions that you want 
to include in the role.

After creating roles, you assign them to users in the Privilege Managements 
page. For more information see Chapter 21, “Managing User Privileges.”

To create a role:

 1 On the Performance Center left menu, select User Management > Roles.

 2 In the Roles Management page, select the type of role you want to create—
Performance Center or Project (see description on page 216).

 3 In the left pane, below the list of roles, click New. 

A new role, New Role <n>, appears in the roles list, and an empty form 
opens in the Role Properties pane.

 4 In the Name box, type an appropriate name for the role. The name may 
include alphanumeric characters, and the following special characters 
only: _ @ # ( ) 

 5 In the Description box, type a description for the role.

 6 Select permissions for the role. For a list of all the task permissions, see 
“Understanding Performance Center and Project-Related  Permissions” on 
page 207.

Tip: To select all the permissions under a specific category, select the 
check box adjacent the category name.

 7 Click Save. The role is saved and a message is displayed in the Messages area 
(below the form).
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Editing Roles
If you have at least Edit role privileges, you can edit user-defined roles. 

Note: You cannot edit canned roles.

To edit a role:

 1 On the Performance Center left menu, select User Management > Roles.

 2 In the Roles Management page, select the type of role you want to edit—
Performance Center or Project.

 3 In the roles list, select the role that you want to edit. 

Tip: To locating the role more easily, you can filter the roles list. 
See “Filtering the List of Roles” on page 216.

 4 Edit the role, and click Save.

The role is saved and a message is displayed in the Messages area below the 
form.

Copying Roles
If you have at least Copy role privileges, you can copy user-defined roles.

To copy a role:

 1 On the Performance Center left menu, select User Management > Roles.

 2 In the Roles Management page, in the list of roles, select the role you want 
to copy.

Tip: To locate the role more easily, you can filter the roles list. See “Filtering 
the List of Roles” on page 216.
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 3 In the left pane, below the list of roles, click Copy. 

A copy of the role, Copy of <copied role>, appears in the list of roles.

 4 Edit the role as described in “Editing Roles” on page 219.

 5 Click Save to save the role.

Deleting Roles
You can delete roles that have no association with any users in the system. 

Note: You cannot delete canned roles.

To delete a role:

 1 In the list of roles, select the role you want to delete.

Tip: To locate the role more easily, you can filter the roles list. See “Filtering 
the List of Roles” on page 216.

 2 In the left pane, below the list of roles, click Delete and confirm that you 
want to delete the role. 

As long as there is no user assigned to the role, the role is deleted.

Note: If there is a user assigned to the role, the role cannot be deleted—a 
notification is displayed.
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Assigning Roles to Users

All Performance Center users are assigned roles which permit them to 
perform tasks in Performance Center. For more information about assigning 
roles to Performance Center users, see Chapter 21, “Managing User 
Privileges.”
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Managing User Privileges

The Privilege Manager stores all the project-user-role assignments in the 
Performance Center system.

About Privilege Management

Privilege Management enables you to assign users with selected privileges to 
manage Performance Center resources and assets or to manage Performance 
Center projects.

After you have defined users, user roles, and projects in Performance Center, 
you use the Privilege Manager to create associations between these elements.

The Privilege Management page lists these associations and is a portal to the 
pages where these associations are managed.

This chapter describes: On page:

About Privilege Management 223

Accessing the Privilege Manager 224

Privilege Manager at a Glance 224

Managing User Privilege Assignments 225
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Accessing the Privilege Manager

You access the Privilege Manager directly from the Performance Center left 
menu or from the Roles Management page.

➤ To access the Privilege Manager from the Performance Center left menu, 
select User Management > Privilege Management. 

➤ To access the Privilege Manager from the Role Management page, below the 
Role Properties pane, click the Assign Project-User-Role button.

Privilege Manager at a Glance

The Privilege Manager displays a list of containers on the left, and the User-
Roles table on the right. 
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A container can be defined as a Performance Center object that contains 
resources, assets, and other containers. Performance Center has two types of 
containers:

➤ PC. Contains Performance Center resources such as hosts and servers, 
and Performance Center assets such as projects, users, and user roles.

➤ Projects. Contains project-related resources and assets such as load tests, 
scripts, and monitor profiles.

When you select a container, the User-Roles table displays the users assigned 
to that container, and the roles required of them in that container.

In the Privilege Management page, you can do the following:

➤ View all users assigned to a container, and the roles assigned to them in 
that container

➤ Assign users to a container

➤ Modify roles assigned to users

➤ Remove users assigned to a container

Managing User Privilege Assignments

You use the Privilege Manager to manage users and their roles in the 
Performance Center or Performance Center project containers.

This section includes:

➤ “Assigning Users to Performance Center/Project Containers” on page 226

➤ “Modifying User-Role Assignments” on page 228

➤ “Disassociating Users from Containers” on page 230
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Assigning Users to Performance Center/Project
Containers
You use the Privilege Manager to assign users to manage Performance Center 
tasks or project-related tasks.

Assigning users to the Performance Center or All Projects container, or to a 
particular project, involves a two-fold operation: 

➤ You select a container to which to assign the users

➤ You assign roles to users which allow them to perform tasks in the 
selected container.

To assign users to the Performance Center or All Projects container:

 1 In the Privilege Management page (User Management > Privilege 
Management), in the container list, select PC or All Projects. 

The User-Roles table on the right lists all the user-role assignments in the 
selected container.

 2 Below the User-Roles table, click Assign New User. The Assign New User-
Role to <PC/All Projects> dialog box opens. 

 3 In the Role list, select a role that you want to assign to users.

Users already assigned this role are displayed in the Assigned to users box.

 4 In the Available users list, select the available users to whom you want to 
assign the selected role.

Tip: You can filter the Available users list by entering a particular user name 
(or part thereof) in the User box, and clicking Filter.

Click the single right-arrow button to move the selected available users to 
the Assigned to users box. Alternatively, to move all of the available users 
simultaneously, click the double right-arrow button.
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 5 Click Apply.

 6 To assign another role, repeat steps 3 through 5.

 7 Click OK. The Assign New User-Role dialog box closes, and the User-Role 
table displays the new user and its assigned roles. 

Note: Roles assigned in All Projects are marked with an asterisk (*).

To assign users to a single project:

 1 In the Privilege Management page (User Management > Privilege 
Management), in the container list, select the project to which to assign the 
users. 

The User-Roles table on the right lists all the user-role assignments in the 
selected container.

 2 Below the User-Roles table, click Assign New User. The Assign New User-
Role to <project> dialog box opens. 

 3 In the Role list, select a role that you want to assign to users.

Users already assigned this role are displayed in the Assigned to users boxes.

➤ Users assigned this role in the selected project are displayed in the Project 
Assignment box. 

➤ Users assigned this role in All Projects are displayed in the All Project 
Assignment box.
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 4 In the Available users list, select the available users to whom you want to 
assign the selected role.

Tip: You can filter the Available users list, by entering a particular user name 
(or part thereof) in the User box, and clicking Filter.

Click the single right-arrow button to move the selected users to the 
Assigned to users box. Alternatively, to move all of the available users 
simultaneously, click the double right-arrow button.

 5 Click Apply.

 6 To assign another role, repeat steps 3 through 5.

 7 Click OK. The Assign New User-Role dialog box closes, and the User-Role 
table displays the user-role assignments. 

Modifying User-Role Assignments
For any user assigned to a container, you can modify the roles assigned to 
the user in that container.

To modify the roles assigned to a particular user:

 1 In the Privilege Management page (User Management > Privilege 
Management), in the container list, select the container to which the user is 
assigned. 

Note: Roles assigned to a user in one container can differ from roles assigned 
to the same user in a different container.

 2 In the User-Roles table, select the user whose roles you want to modify.
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 3 Below the User-Roles table, click Change User Roles. 

Note: The Change User Roles button is available when one user only is 
selected in the User-Roles table.

 4 The Change User-Role Assignments in <container> dialog box opens, 
displaying the user that you selected. 

In the Roles table, all the roles available for the selected container are 
displayed, and the roles already assigned to the user are selected.

 5 Select roles to assign to the user and clear the roles that you want to remove 
from the user.

Note: When modifying a user’s roles in a particular project, roles assigned to 
the user for all projects are displayed in read-only format. To modify these 
roles, perform this procedure in the All Projects container (see step 1).

 6 When you are satisfied, click Assign. The Change User-Role Assignments 
dialog box closes, and the modifications are displayed in the User-Roles 
table.
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Disassociating Users from Containers
Using the Privilege Manager, you can disassociate a user from a container. 
When you disassociate a user from a container, all the user-role assignments 
for the user in that particular container removed.

To remove a user from a container:

 1 In the Privilege Management page (User Management > Privilege 
Management), in the container list, select the container from which to 
remove the user.

 2 In the User-Roles table, select the user you want to remove. You can select 
one or multiple users.

Note: If the user has roles that are marked with an asterisk (*), to remove the 
user you must perform this procedure in the All Projects container. 

 3 Below the User-Roles table, click Remove Assignment. 

Note: The Remove Assignment button is available when at least one user is 
selected in the User-Roles table.

 4 In the message box that opens, click OK. 

 5 The user is removed from the User-Roles table.
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Managing Performance Center Projects

This chapter describes defining projects in Performance Center. Project 
information includes a project’s name, status, Vuser limit, machine limit, 
and other information about the project. You can view, modify, add, copy, 
move, and delete project information. In addition, you can define IP target 
addresses.

This chapter describes: On page:

Understanding Project Information 232

Managing Project Information 234

Using IP Addresses 237
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Understanding Project Information

You view and manage Performance Center projects in the Projects page. The 
Projects page displays a list of all the projects in the Performance Center 
system. If you have Project Management privileges, you can view and 
manage this information.

Detail Description

Project Name The name of the project.

Project Status The status of the project in the 
Performance Center system. The status can 
be active or non-active. 

Note: If a project is in a non-active state, 
no the users in the project can log on to 
the Performance Center system.

Running Vusers on 
Controller

Enables users to run Vusers on the 
Controller. This provides greater flexibility 
where resources are scarce. 

In Add/Edit mode: Select Enable or 
Disable. To give users more control in 
advanced projects, select Allow project 
users to override this selection. This allows 
project users at the administration level to 
change the Running Vusers on Controller 
setting.

Note: For best results, it is recommended 
to run Vusers on dedicated load generators 
only. Running Vusers on the Controller 
can overload the machine and affect load 
test results.

Vuser Limit The maximum number of Vusers a project 
can run at once. The total number used by 
all the project’s concurrent load tests must 
not exceed this limit.
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Machine Limit The maximum number of host machines a 
project can use at once. The total number 
used by all of the project’s concurrent load 
tests must not exceed this limit.

Concurrent Runs The maximum number of concurrent runs 
allowed within a project.

Host Pool Specification of what class of host 
machines should be assigned to the project 
for load tests. If your privilege level is 
Administrator, you can edit the set of 
possible pools. For details, see Chapter 5, 
“Managing Host Pools.”

Creation Date The date and time the project was created 
in the system.

Expiration Date The date and time the project’s validity 
expires.

In Add/Edit mode: 

➤ If you do not want the project to expire, 
select Never Expires. 

➤ To set an expiry date for the project, 
click the Select expiration date link, 
select the desired date and time from 
the calendar window, and click Set. The 
calendar closes and the date updated.

Use Target IP Definitions Allows the user to define the IP addresses 
to use as targets for load testing. For 
details, see “Using IP Addresses” on 
page 237.

Detail Description
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Managing Project Information

The Projects page displays a list of all the projects in the Performance Center 
system. 

To access this page, on the Performance Center left menu, select User 
Management > Projects.

The Projects page displays 25 projects in the Performance Center system at a 
time. To see more projects you can scroll down the list, and use the arrow 
buttons above the table to navigate between sets of 25 projects.

To see a particular project’s details, select the project in the list. The Project 
Information section in the lower area of the page displays project 
information for the selected project. For project detail definitions, see 
“Understanding Project Information” on page 232.

If you want to find a particular project, type the name in the Find project 
box and click Find.

If you want to display the complete list of projects, click the Show All 
button. This will expand the list from 25 projects to all projects.
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Tip: 

➤ To search for a specific project or alphabetic string, in the Find project 
box, type the project name (or part thereof), and click Find. Performance 
Center returns the appropriate list.

➤ Entering part of a name returns a list of all the projects that have the 
specified string anywhere in their names. If you entered nn, the display 
list might include wynn, benny_proj, and MG_grow_penn.

➤ To view the full list of projects again, click Show All.

Adding Project Information
You add new Performance Center projects in the Projects page.

To add a project:

 1 On the Projects page, click Add New Project. The Project Information area 
switches to Add mode and displays an empty Project Information form.

 2 Enter the new projects’s details.

For more information about the new projects details, see “Understanding 
Project Information” on page 232.

 a Enter a name for the new project.

 b Select the Project Status, either Active or Non-Active.

 c Select Running Vusers on Controller, either Disable or Enable. To allow 
Vusers to override this selection, select the Allow project users to 
override this selection option.

 d Enter the Vuser Limit, the maximum number of Vusers a project can run 
at once.

 e Enter the Machine Limit, the maximum number of host machines a 
project can use at once.

 f Enter the Concurrent Runs, the maximum number of concurrent runs 
allowed within a project.
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 g Select the Host Pool, a specification of what class of host machines 
should be assigned to the project.

 h Set an expiration date for the project.

Under Account Expiration Date, click the Select expiration date link. A 
calendar window opens. Select the desired date and time, and click Set. 
The calendar closes and the account expiration date is updated.

 i if you select the Use Target IP Definitions option, you will need to define 
the IP addresses to use as targets for load testing. For details, see “Using IP 
Addresses” on page 237.

 3 To add the project to the list, click Add. 

To clear all fields, click Clear. 

To return to viewing project information without adding the new project, 
click Cancel. 

Modifying Project Information
You modify project information in the Projects page.

To modify a project’s details:

 1 On the Projects page, select the project whose information you want to 
modify.

 2 Click Edit. The Project Information area switches to Edit mode. 

 3 Modify the information in the editable fields.

 4 Click Save to save changes to the project’s information.

Deleting Performance Center Projects
On the Project’s page, select the project you want to delete and click Delete. 
Click OK to confirm that you want to delete the project.

The project is deleted from the list of projects.
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Using IP Addresses

IP addresses are assigned so that the addresses of all hosts on a given 
network share a common prefix. The common prefix defines the network 
portion of the IP address, and the remainder defines the host portion (also 
referred to as the local portion).

Note that the term "network" in this context refers to a logical network, 
which might span one or more physical networks. The network portion of 
an IP address identifies a site and the local portion identifies a single host at 
that site. 

About Using Subnet Masks 
A site using subnet addressing must specify a 32-bit subnet mask for each 
network. Each bit in the subnet mask is set to 1 if the network treats the 
corresponding bit in the IP address as part of the network address and 0 if it 
treats the corresponding bit in the IP address as part of the host id.

Consider, for example, the subnet mask 11111111 11111111 0000000 
0000000 (or in decimal form, 255.255.0.0). This subnet mask specifies that 
the first two octets identify the network and the last two octets identify the 
host on that network.

The subnet mask 255.255.255.255 (or in binary form, 11111111 11111111 
11111111 11111111), which you add when defining individual IP addresses, 
specifies that all four octets in the IP address identify the network and host 
as if there were no subnet mask. In practice, this means that null will use the 
exact IP address to target load tests.

Defining Target IP Addresses
If a project is set to Use Target IP definitions, you must define a target IP 
address. The project’s load tests are targeted to these addresses. If no 
addresses are defined, the project’s load tests cannot run.

By default, this option is not selected, and the project cannot target its tests 
to any IP address.

To limit your load test to one or more individual IP addresses, type the IP 
addresses along with the following mask address: 255.255.255.255. 
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To limit your load test to a network of target IP addresses, type the correct IP 
and Subnet mask combination that your network administrator has 
provided for your organization. 

To define target IP addresses for a project:

 1 On the Projects page, select the project from the list. The Project 
Information section displays the selected project’s information.

 2 If the Use Target IP Definitions option has not been selected, click Edit to 
switch the Project Information area to edit mode, and select it. The click 
Save.

 3 Below the project Information area, click Define Target IP. The Define Target 
IP Addresses for Project dialog box opens.

 4 Under IP Address, enter a target IP address.

 5 To add another IP address, click New Line and enter the address. 

 6 To edit an address, place the cursor in the box you want to edit, and type the 
new address.

 7 To delete an address, click the Delete button for the relevant IP address.

 8 Click Save to save changes and close the dialog box, or Close to close the 
dialog box without saving changes.
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A
Configuring Performance Center 
System User Manually

This appendix provides instructions for manually configuring the 
Performance Center system user on the Performance Center servers and 
hosts.

Note: Try to configure the Performance Center user using the System 
Identity Utility (see Chapter 2, “Performance Center System User”). Use 
these instructions as a last resort only.

Manual configuration of the Performance Center user on the various servers 
and hosts involves granting the required Performance Center policies, 
updating the Performance Center user, and, for a non-administrative 
Performance Center user, granting the required Performance Center 
permissions. 

Follow all the procedures carefully, noting which procedures are relevant for 
all Performance Center servers and hosts and which for specified machines 
only.

This appendix describes: On page:

Required Policies for the Performance Center System User 242

Performance Center User Configuration 243

Performance Center User Permissions (Non-Administrative  User 
Only)

249
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Required Policies for the Performance Center System User

Note: This section applies to:

➤ An administrative or non-administrative Performance Center user

➤ All Performance Center servers and hosts

Grant the Performance Center user all the required policies as follows:

 Policy Operating System Reason

Act as part of the 
operating system 

 Win2000 For impersonation (required for 
Performance Center system user 
and for the user that runs the 
System Identity Utility)

Create global object Win2000/2003 For Autolab running Vusers on 
the Controller 

Batch logon rights Win2000/2003 The minimum policies required 
to run Web application 

Service logon rights Win2000/2003 The minimum policies required 
to run Web application 

Access this computer 
from the network 

Win2000/2003 The minimum policies required 
to run Web application 

Log on locally Win2000/2003 Required by infra services (for 
instance after reboot it does login 
with Performance Center system 
user) 
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Performance Center User Configuration

Note: This section applies to:

➤ An administrative or non-administrative Performance Center user

➤ All Performance Center servers and hosts

Configuring the Performance Center user includes the following procedures:

➤ “Defining Performance Center User as Admin or Non-Admin User” on 
page 243

➤ “Configuring IIS Settings” on page 244

➤ “Changing Application Pool Identity” on page 246

➤ “Configuring COM Object Identity” on page 248

➤ “Resetting Services” on page 248

Defining Performance Center User as Admin or 
Non-Admin User
The Performance Center system user can have administrative or non-
administrative permissions. You define what type of user it is by adding it to 
the relevant local user group on the server or host.

To add the Performance Center user to a local user group:

 1 Open the Computer Management (Control Panel > Administrative Tools).

 2 Add the user to the appropriate user group. 

Select System Tools > Local Users and Groups > Users.

➤ If the Performance Center user is to be an administrative user: 

Double-click the Performance Center user, and click the Member of tab. 
If Administrators is not listed, click Add, select Administrators, and click 
OK.
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➤ If the Performance Center user is to be an non-administrative user:

Double-click the Performance Center user, and click the Member of tab. 
Change the Performance Center user to belong only to the Users group.

Windows 2003 only: Add the Performance Center user to the Distributed 
Com Users group.

Configuring IIS Settings
This section applies to the Administration Site and User Site (Web) servers 
only. 

➤ When changing the IIS on the Administration Site server, work in the 
Admin virtual directory.

➤ When changing the IIS on the User Site servers, work in the LoadTest 
virtual directory.

To change the IIS settings:

 1 Open Internet Information Service Manager.

 2 In the relevant virtual directory (Admin or LoadTest as mentioned above), 
change the Anonymous user to the Performance Center user as follows:

 a Under Default Web Site, right-click the relevant virtual directory and 
select Properties.

 b Click the Directory Security tab.

 c Under Anonymous access and authentication control, click Edit.
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 d Select Anonymous access and next to Account used for anonymous 
access, click Edit.

 e Change the user to the Performance Center user.

 f Click OK.

 g Click Apply.

 h In the dialog box that opens, select all the virtual directories to apply the 
Anonymous user to all of them.

 3 Change the Connect As user.

 a For each virtual directory under the top virtual directory (that is, under 
Admin or LoadTest), right-click the directory (for example, \Graphs) and 
select Properties.

 b Next to Network Directory, click Connect As.

Note: This option is available when A share located on another 
computer is selected.
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 c Enter the name and password of the Performance Center user, and click 
OK.

Changing Application Pool Identity

Note: This section is relevant for IIS 6.0 only.

For all Performance Center servers and hosts, you need to change the 
application pool identity to the Performance Center user. The following 
table lists which application pool’s identity to change per server or host:

Performance Center Machine Application Pool

Administration Site server AdminAppPool; PCWSAppPool

User Site (Web) servers DefaultAppPool; PCWSAppPool

File server PCWSAppPool
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To change the application pool identity to the Performance Center user:

 1 Open the Internet Information Services Manager.

 2 Under Application pool, right-click the relevant application pool (see the 
table above) and select Properties. 

Note: For the Administration and User site servers, you need to repeat this 
procedure for both application pools listed.)

 3 In the Identity tab, select Configurable, and enter the user name and 
password of the Performance Center user.

 4 Click OK.

Utility PCWSAppPool

Hosts PCWSAppPool

Performance Center Machine Application Pool
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Configuring COM Object Identity
For all Performance Center servers and hosts, you need to change the 
identity of the COM objects to the Performance Center user.

For all the COM objects listed in the 
<Performance Center installation>\bin\MiDCOM.ini file, configure the 
identity to be the Performance Center user as follows:

 1 Run dcomcnfg.

 2 For each COM object, under Properties > Identity, select This user and enter 
the Performance Center user details.

Resetting Services
This section describes resetting services on the servers and hosts. 

For all Performance Center Servers and Hosts

Reset alagentservice as follows:

➤ Reinstall alagentservice using the following commands:

where username and password are those of the Performance Center user.

For Utility Server Only

Reset TaskManagerService:

 a Run services.msc.

 b In the Services folder, right-click Performance Center TaskManager, and 
click Properties.

 c In the Log On tab, select This Account and enter the Performance Center 
user name and password. 

 d Click OK.

%installation folder%\al_agent\bin\alagentservice.exe -remove 

%installation folder%\al_agent\bin\alagentservice.exe -install username password 
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 e In the Services folder, right-click Performance Center TaskManager 
again, and click Restart.

For Performance Center Hosts Only

Reset magentservice:

➤ Reinstall magentservice using the following commands:

where username and password are those of the Performance Center user.

Performance Center User Permissions (Non-Administrative 
User Only)

Note: This section is relevant when configuring a non-administrative 
Performance Center user only.

When configuring a non-administrative Performance Center system user, 
you need to grant it additional Performance Center permissions.

This section describes:

➤ “Configuring Permissions on the Administration Site  Server” on page 250

➤ “Configuring Permissions on the User Site (Web) Servers” on page 251

➤ “Configuring Permissions on the File Server” on page 254

➤ “Configuring Permissions on the Utility Server” on page 256

➤ “Configuring Permissions on the Performance Center Hosts” on page 259

%installation folder%\launch_service\bin\magentservice.exe -remove 

%installation folder%\launch_service\bin\magentservice.exe -install username 
password
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Configuring Permissions on the Administration Site 
Server
Grant the following permissions to the non-administrative Performance 
Center user on the Administration Site server:

Change registry permissions:

 1 Open the Registry Editor (regedt32).

 2 Give the Performance Center user full access to:

➤ HKEY_LOCAL_MACHINE\Software\Mercury Interactive

➤ HKEY_CLASSES_ROOT\interface

➤ HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

Add full control permissions to directories and files:

In the File System folder give the Performance Center user and the 
IWAM_Machine user permissions as follows:

➤ Performance Center user. Grant full control of:

➤ the Performance Center directory (C:\Program Files\HP\Performance 
Center) and all sub-directories

➤ %CommonProgramFiles%

➤ %windir%\TEMP

➤ If the systemroot is on an NTFS partition, grant at least Read access to 
files:

➤ %SystemRoot%\System32\Perfc009.dat

➤ %SystemRoot%\System32\Perfh009.dat

➤ IWAM_Machine user. After installing Web services, give Read permissions to 
%windir%\TEMP.
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Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all folders 
needed to run .NET applications (Web services, and so on):

In a command line, go to

and run 

Configuring Permissions on the User Site (Web) Servers
On the User Site (Web) servers, grant the following permissions to the non-
administrative Performance Center user:

Change registry permissions:

 1 Open the Registry Editor (regedt32).

 2 Give the Performance Center user full access to:

➤ HKEY_LOCAL_MACHINE\Software\Mercury Interactive

➤ HKEY_CLASSES_ROOT\interface

➤ HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO
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Change permissions of the Crypto key:

 1 Open C:\Documents and Settings\All Users\Application Data\Microsoft\
Crypto\RSA\MachineKeys.

 2 Right-click the f9416f003254e6f10da1f9bad8e4c383 file and select 
Properties.

 3 Click the Security tab.

 4 Add the Users Group and grant it full control.
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Add permissions to directories and files:

In the File System folder give the Performance Center user and the 
IWAM_Machine user permissions as follows:

➤ Performance Center user. Grant full control of:

➤ the Performance Center directory (C:\Program Files\HP\Performance 
Center) and all sub-directories

➤ %CommonProgramFiles%

➤ %windir%\TEMP

➤ If the systemroot is on an NTFS partition, grant at least Read access to 
files:

➤ %SystemRoot%\System32\Perfc009.dat

➤ %SystemRoot%\System32\Perfh009.dat

➤ IWAM_Machine user. After installing Web services, give Read permissions to 
%windir%\TEMP.

Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all folders 
needed to run .NET applications (Web services, and so on):

In a command line, go to

and run 

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO
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Configuring Permissions on the File Server
On the File server, grant the following permissions to the non-
administrative Performance Center user:

Change registry permissions:

 1 Open the Registry Editor (regedt32).

 2 Give the Performance Center user full access to:

➤ HKEY_LOCAL_MACHINE\Software\Mercury Interactive

➤ HKEY_CLASSES_ROOT\interface

➤ HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

Add full control permissions to directories and files:

In the File System folder give the Performance Center user and the 
IWAM_Machine user permissions as follows:

➤ Performance Center user. Grant full control of:

➤ the Performance Center directory (C:\Program Files\HP\Performance 
Center) and all sub-directories

➤ %CommonProgramFiles%

➤ %windir%\TEMP

➤ If the systemroot is on an NTFS partition, grant at least Read access to 
files:

➤ %SystemRoot%\System32\Perfc009.dat

➤ %SystemRoot%\System32\Perfh009.dat

➤ IWAM_Machine user. After installing Web services, give Read permissions to 
%windir%\TEMP.
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Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all folders 
needed to run .NET applications (Web services, and so on):

In a command line, go to

and run 

Add full access for the Performance Center user to LRFS security:

 1 In the Performance Center installation directory, double-click LRFS and click 
the Sharing tab.

 2 Click Permissions and give the Performance Center user full control.

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO
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Configuring Permissions on the Utility Server
On the Utility server, grant the following permissions to the non-
administrative Performance Center user:

Change registry permissions:

 1 Open the Registry Editor (regedt32).

 2 Give the Performance Center user full access to:

➤ HKEY_LOCAL_MACHINE\Software\Mercury Interactive

➤ HKEY_CLASSES_ROOT\interface

➤ HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon
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Change permissions of the Crypto key:

 1 Open C:\Documents and Settings\All Users\Application Data\Microsoft\
Crypto\RSA\MachineKeys.

 2 Right-click the f9416f003254e6f10da1f9bad8e4c383 file and select 
Properties.

 3 Click the Security tab.

 4 Add the Users Group and grant it full control.
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Add full control permissions to directories and files:

In the File System folder give the Performance Center user and the 
IWAM_Machine user permissions as follows:

➤ Performance Center user. Grant full control of:

➤ the Performance Center directory (C:\Program Files\HP\Performance 
Center) and all sub-directories

➤ %CommonProgramFiles%

➤ %windir%\TEMP

➤ If the systemroot is on an NTFS partition, grant at least Read access to 
files:

➤ %SystemRoot%\System32\Perfc009.dat

➤ %SystemRoot%\System32\Perfh009.dat

➤ %windir%\mercury.ini. If this file does not exist, create it and give the 
user full access.

➤ IWAM_Machine user. After installing Web services, give Read permissions to 
%windir%\TEMP.

Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all folders 
needed to run .NET applications (Web services, and so on):

In a command line, go to

and run 

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO
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Configuring Permissions on the Performance Center 
Hosts
On the Performance Center hosts, grant the following permissions to the 
non-administrative Performance Center user:

Change registry permissions:

 1 Open the Registry Editor (regedt32).

 2 Give the Performance Center user full access to:

➤ HKEY_LOCAL_MACHINE\Software\Mercury Interactive

➤ HKEY_CLASSES_ROOT\interface

➤ HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

➤ HKLM\SOFTWARE\Microsoft\Jet\4.0\Engines\Text (used by Analysis).
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Change permissions of the Crypto key:

 1 Open C:\Documents and Settings\All Users\Application Data\Microsoft\
Crypto\RSA\MachineKeys.

 2 Right-click the f9416f003254e6f10da1f9bad8e4c383 file and select 
Properties.

 3 Click the Security tab.

 4 Add the Users Group and grant it full control.
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Add full control permissions to directories and files:

In the File System folder give the Performance Center user and the 
IWAM_Machine user permissions as follows:

➤ Performance Center user. Grant full control of:

➤ the Performance Center directory (C:\Program Files\HP\Performance 
Center) and all sub-directories

➤ %CommonProgramFiles%

➤ %windir%\TEMP

➤ If the systemroot is on an NTFS partition, grant at least Read access to 
files:

➤ %SystemRoot%\System32\Perfc009.dat

➤ %SystemRoot%\System32\Perfh009.dat

➤ C:\Documents and Settings\Default User\Local Settings\Temp

➤ %windir%\wlrun7.ini.

➤ %windir%\wlrun5.ini.

➤ %windir%\mercury.ini.

➤ %windir%\collate.txt.

If a file does not exist, create it and give the user full access.

➤ IWAM_Machine user. After installing Web services, give Read permissions to 
%windir%\TEMP.
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Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all folders 
needed to run .NET applications (Web services, and so on):

In a command line, go to

and run 

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO
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B
Troubleshooting Performance Center

This appendix provides troubleshooting for Performance Center problems.

This appendix describes: On page:

Troubleshooting Installation Problems 264

Troubleshooting Load Tests 275

Troubleshooting Hosts 289

Troubleshooting Web Problems 296

Troubleshooting Performance Center Monitors 302

Troubleshooting VuGen and Analysis Integration 303

Troubleshooting System Identity 304

Troubleshooting Web Services Connectivity 310
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Troubleshooting Installation Problems

This section provides troubleshooting for the following Performance Center 
installation errors:

➤ Error: Method '~' of object '~' failed

➤ Login to Oracle Database Hangs

➤ DllHost.exe – Application Error

➤ Login to the Database Failed

➤ User Site Does Not Exist

➤ Cannot Login

➤ Invalid License Was Detected

➤ PCWS Folder was not Installed Correctly

Error: Method '~' of object '~' failed
The following error message is displayed when installing the Administration 
Site: Operation terminated. Error description: Method '~' of object '~' failed.

Troubleshooting:

 1 Check that the server’s System Event log for W3SVC errors.

 2 Verify the configured identity for IWAM_<SERVER NAME> account.

 3 Make sure that the password for the IWAM account is synchronized in all 
three locations:

➤ Internet Information Server (IIS) metabase.

➤ Local Users and Groups (Windows 2000).

➤ Component Services (Windows 2000).

For more information on obtaining or setting the account password, refer 
to: http://support.microsoft.com/default.aspx?scid=kb;en-us;297989.

 4 Verify that the COM+ service is running.
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Login to Oracle Database Hangs 
When configuring initialfs.htm, the connection to the Oracle database 
hangs, and the log displays the message: Trying to login to Database Server.

Troubleshooting

Option 1: Set the Application Protection level to High (isolated)

(IIS 5 only) Make sure that the Application Protection level is set to High 
(isolated) in the Internet Services Manager in both the Administrator Site 
and User Site. 

To set the application protection level: 

 1 Choose Start > Programs > Administrative Tools > Internet Services 
Manager. The Internet Information Services dialog box opens.
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 2 In the Tree directory, expand Default Web Site, and right-click Admin. Click 
Properties to open the Admin Properties dialog box.

 3 Click the Virtual Directory tab.

 4 In the Application Protection box, select High (Isolated).

 5 Repeat steps 2-4 for the User Site. Note that in step 2, right-click LoadTest.
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Option 2: Set the Correct Permissions Level for IWAM_<SERVER> user

This may be caused by a permissions level problem with the 
IWAM_<SERVER> user. By default this account is set to Guest permission 
level. The IWAM_<SERVER> user needs to have read/execute privileges on 
the Oracle home directory and all of its sub-directories.

To set the correct permissions level: 

 1 In Windows Explorer, right-click the Oracle home directory, and choose 
Properties.

 2 Click the Security tab.

 3 Click Add and add the IWAM_<SERVER> user.

 4 Check Read & Execute.

 5 Click OK.
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DllHost.exe – Application Error
Error message: Operation terminated. DllHost.exe – Application Error.

Troubleshooting:

(IIS 5 only) Change the application protection level in the Internet Services 
Manager from High (isolated) to Low (IIS Process).

 1 Choose Start > Programs > Administrative Tools > Internet Services 
Manager to open the Internet Information Services dialog box.

 2 In the Tree directory, expand Default Web Site, and right-click Admin. Click 
Properties to open the Admin Properties dialog box.
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 3 Select the Virtual Directory tab, and in the Application Protection list, select 
Low (IIS Process).

 4 After installation, change the Application Protection back to High (Isolated) 
by repeating the above steps and clicking High (Isolated) in step 3.
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Login to the Database Failed
Error message: Operation terminated. Error description: Login to the 
Database Server failed. Check if user name and password are correct.

Troubleshooting:

 1 Verify that the database host name, type, user name, and password are 
correct. Consult your database administrator if you are unsure.

 2 Check if you can connect to the database from the Administration site 
server using the command line SQL client:

➤ For MSSQL Database:
% osql –U <username> -P <password> -S <serverID>
Example:
% osql –U sa –P manager –S DBSERVER\LRTCDB

If your Microsoft SQL server is configured with integrated security, make 
sure that the Microsoft SQL database server has an operating system 
account for IUSR_METRO (password: MIOrchid#1), and is allowed access 
to the database. IUSR_METRO is the default account under which the 
Performance Center Web server runs.
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➤ For Oracle Database:
% sqlplus <username>/<password>@<connect_string>

Example:
% sqlplus system/manager@LRTCORA

If the above command fails, check your TNS entry in 
%ORACLE_HOME%\network\admin\tnsnames.ora file.

An Example of a TNS entry is shown below:
LRTCORA =

   (DESCRIPTION =

      (ADDRESS_LIST =

      (ADDRESS = (PROTOCOL = TCP)(HOST = TCDBSERVER)(PORT 1521))

      )

(CONNECT_DATA =

            (SERVICE_NAME =LRTCORA)

)

)

 3 To test the ADODB connectivity to the database, download the 
TcIN_AdoDBTester.exe utility from the Customer Support Web site 
(http://support.mercury.com). After you log on to the support site, click 
Knowledge Base, select LoadRunner TestCenter, and search for ID39475.

 a Update the username, password, and server fields in the Connection 
String.

➤ For Microsoft SQL Server, use Provider=SQLOLEDB.1;… connection 
string.

➤ For Oracle Database, use Provider=MSAORA.1;… connection string.

 b Set a valid SQL Statement (based on current DB tables).

 c Execute.

 d Check the response. If an error occurs, address the error message 
appropriately.
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Note: For Oracle Database, check that your Oracle client is installed 
properly:
1. Check if the ORACLE_HOME registry entry is correct under 
[HKEY_LOCAL_MACHINE\Software\Oracle]. It should be pointing to your 
Oracle client installation.
2. Remove SQLPLUS.EXE from the Performance Center/DB directory.

 4 Verify that you MDAC version is 2.8 SP1.

User Site Does Not Exist
Error message: The User Site (http://servername/LoadTest) does not exist 
on Performance Center server. Browser displays a ‘Page Not Found’ error.

After the initial configuration of Performance Center (using 
http://<servername>/admin/initialfs.htm), the Performance Center User Site is 
created through the Server Configuration page in the Administrator Site 
(System Configuration > Server Configuration).

Troubleshooting:

If the Performance Center Web server was corrupted or reinstalled, launch 
Internet Service Manager and check if the LoadTest virtual directory is 
defined.

 1 If LoadTest is defined but points to the wrong directory, delete the LoadTest 
virtual directory, and continue with step 3 below.

 2 If LoadTest is not defined:

 a Log on to the Performance Center Administration Site and check if an 
entry exists for User Site Servers in the Server Configuration page (under 
System Configuration > Server Configuration).

 b If the name of the server does is not displayed under User Site Servers, 
add it and save your changes. Try to log on to the User Site 
(http://<servername>/loadtest).
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 3 If the name of the server does exist, continue with the following steps: 

 a Connect to the database using Microsoft SQL, Oracle Enterprise Manager, 
or any SQL client from the user site machine.

 b Check the Web Server entry in the GlobalData table of MI_LRDB 
tablespace/database.

 c If the Web Server entry contains the name of the server where you want 
to install the Performance Center User Site, remove the server name.

 d Logon into Performance Center Administration Site and define User site 
Servers in the Server Configuration page (under System Configuration > 
Server Configuration).

Cannot Login
Cannot log in with any user or Administrator account.

Troubleshooting:

 1 Make sure that you type the correct user name and password. The password 
is case-sensitive. The default Administrator account is Admin, Admin.

 2 There may be a problem with the encryption and decryption of the 
password.

➤ Open Documents And Settings\All Users\Application 
Data\Microsoft\Crypto\RSA\MachineKeys and delete the entry that 
begins with f9416f003254e610da1f9bad8e4c383_.

➤ Restart IIS. Choose Start > Programs > Administrative Tools > Services. 
Select IIS Admin Service and click Restart Service.

 3 Make sure that both the Administration Site and the User Site are configured 
to run with the same account credentials as the Performance Center Web 
services virtual directories. See “Troubleshooting Web Services 
Connectivity” on page 310 for detailed steps on how to do this.
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 4 Check that you are able to connect to the database from the Utility Server 
and the Web Server. Download the TcIN_AdoDBTester.exe utility from the 
Customer Support Web site (http://support.mercury.com). After you log on to 
the support site, click Knowledge Base, select LoadRunner TestCenter, and 
search for ID39475.

 5 Make sure that the maximum number of connections to the database has 
not been exceeded. Run Perfmon.exe or the database’s management tool to 
verify the number of connections. You should contact your database 
administrator if you need further assistance.

Invalid License Was Detected
Cannot run a load test. Invalid license was detected.

Troubleshooting:

 1 Make sure that you entered the correct host license key in the 
Administration Site (System Configuration > License).

 2 If the license is correct, see “Troubleshooting Web Services Connectivity” on 
page 310.

 3 Make sure that LoadRunner is not installed on the system. If any versions of 
LoadRunner exist on the system, uninstall them, and then reinstall the 
Performance Center Host.

To uninstall LoadRunner, use the Windows Add/Remove Programs utility.

 4 Make sure that the version of Performance Center installed on all servers 
and hosts are the same; otherwise communication between the hosts may 
fail. Check the registry entry under 
[HKEY_LOCAL_MACHINE\SOFTWARE\Mercury 
Interactive\LoadRunner\CurrentVersion] for the following variables:

➤ Major

➤ Minor

➤ ServicePack
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PCWS Folder was not Installed Correctly
If you receive an error in the license page of the Administration site, or if the 
load test fails to run, you may need to reinstall the PCWS folder.

Troubleshooting:

➤ To install the PCWS folder and restore the IIS configuration, run the 
following command:

Troubleshooting Load Tests

This section provides troubleshooting for the following load test errors:

➤ Load Test Failed to Run

➤ Cannot Run a Load Test

➤ Performance Center Failed to Allocate Machines

➤ Over-Utilization of a Controller Machine

➤ Session Activation Failed

➤ Virtual Users are Stuck in Initialization

➤ Virtual Users Replay Fails

➤ Performance Center runs slowly when configured with Oracle 9i and 10g

➤ Web Services Related Errors (Failure to run load test, add host or retrieve 
license key)

➤ License Manager Component Cannot Be Instantiated

➤ Problems in Design Load Test Operations

➤ Cannot Add Load Test

➤ Cannot Open Load Test Page After Installation

d:\Program Files\Mercury\Performance Center\bin\ AdminInstaller.exe" WebService 
IUSR_METRO MIOrchid#1
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➤ Cannot Run Load Test On Controller with Windows XP - Non-Admin 
System User

➤ Controller Does Not Run Load Test - Non-Admin System User

Load Test Failed to Run
Load test failed to run, please consult your administrator.

Troubleshooting:

➤ Make sure that you have enough hosts (Controllers and Load Generators) 
available for your test.

➤ If you are starting a test using the Manual timeslot selection, make sure that 
the hosts you are requesting are currently available and not being utilized by 
another load test. Some load tests may have run beyond their allocated 
timeslot due to a long analysis phase, or by user request.

➤ Check the Hosts page in the Performance Center Administration Site 
(Resources > Hosts), or in the User Site (Project > Hosts) for any hosts in the 
Resource Failure state that belong to the pool that your load test is trying to 
use. For information on troubleshooting hosts, see “Troubleshooting Hosts” 
on page 289. 

Cannot Run a Load Test
Unable to run a load test. The Performance Center error message says there 
is a currently running test, when there is not.

Troubleshooting:

 1 Verify whether there really is a load test running on the target Performance 
Center Controller host. 
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 2 If no test is actively running, reset the host state through the Performance 
Center Administration Site as follows:

 a On the Performance Center left menu, select Site Management > 
Test Runs. The Test Runs page opens.

 b (Optional) Select the test run that is consuming the problematic host.

 c Click Fast Recovery in the lower-right corner. This cleans the state of 
hosts in the database, and makes the problematic host available for 
future load tests. If the host is in Resource Failure state and cannot be 
used in your load test, see “Troubleshooting Hosts” on page 289.
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Performance Center Failed to Allocate Machines
If an analysis or publish operation fails, the machine on which this action 
was performed remains allocated to the analysis/publish action, and the 
machine cannot be used as a Controller.

Note: This only applies to machines with Controller and Data Processor 
purposes. 

Troubleshooting:

You should cancel the allocation to the specified machine(s).

To cancel this allocation:

 1 Check which runs are being analyzed or published in the Test Runs page 
(Site Management > Test Runs). In case of publishing, this might be a few 
runs.

 2 Click Deallocate Hosts in the Test Runs page. The Deallocate Hosts dialog 
box opens.

 3 Select Deallocate Analysis host, type the run ID of the test run from which 
you want to deallocate hosts, and click OK. Repeat this procedure for each 
test run from which you want to deallocate hosts.
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Over-Utilization of a Controller Machine 
All of the following problems are indicative of over-utilization of the 
Controller machine:

➤ Virtual users stop ramping up during a load test

➤ Online graphs stop displaying during a load test

➤ User Site (LoadTest) is sluggish during a load test

Troubleshooting:

 1 Make sure you are not running any virtual users on the Controller machine.

 2 Check that the machine is responsive and CPU utilization on the Controller 
machine during a load test is below 100%.

 3 Disable any software that may interfere with the Performance Center 
Controller, File server, or Web server. This includes any auditing or virus 
scanning software.

 4 If CPU utilization is high, check whether:

➤ the online.exe process is consuming excessive CPU. If it is, this means that 
you might have too many remote viewing sessions active (e.g., many people 
are watching the load test from different browsers). To fix this problem, 
either decrease the frequency at which the load test viewing sessions are 
refreshed (from each individual client browser), or decrease the number of 
concurrent viewing sessions for the current or problematic load test.

➤ the wlrun.exe process is consuming excessive CPU. If it is, check if your load 
test is producing:

➤ many error messages. If it is, reduce the number of error messages 
produced by resolving the reasons for the error messages.

➤ many logging messages (for the Controller). If it is, disable or reduce 
the logging level, or avoid using log statements (e.g., lr_message) that 
send messages to the Controller’s output window.

➤ running scripts without any think times, and thus producing a lot of 
data that is sent back to the Controller.

➤ If CPU consumption cannot be reduced for the load test, consider upgrading 
your Controller hardware.
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Session Activation Failed 
Error message: Session activation failed. Reported from method: 
‘SA:AllocResourcesAndStartSes’; Session ID: #; Reason: 

Troubleshooting:

 1 Check to see if you have network connectivity between the host and the 
Web server. The latency should be less than 20 ms to and from all 
Performance Center machines, excluding the load generators.

 2 Check the Event Viewer administrative tool on both the Web server and 
Controller machines (Start > Settings > Control Panel > Administrative Tools 
> Event Viewer).

Virtual Users are Stuck in Initialization
Virtual users are stuck in initialization, or never run at all. If you made 
modifications to a script and overwrote the existing script in Performance 
Center, Vusers may not run properly. When you upload a script, the new 
run-time logic of the script is not updated for any/all load tests that refer to 
the script.

For example, lets say that you have an existing script, Test, with four 
sections, vuser_init, action1, action2, and vuser_end, and you create a new 
load test, TestLoadTest, and add Test as a script with only three sections, 
vuser_init, action3, and vuser_end. If you upload this script and overwrite 
the current script in Performance Center, the Vusers will not run when you 
run TestLoadTest.

This is because when the new script was uploaded, the old run time logic 
remained. The load test thinks that there are two action sections, action1 
and action2, whereas the updated script has now only one action section, 
action3. When the load test is run with the updated script, a pop-up 
window is displayed in wlrun.exe on the Controller. To verify this, run 
wlrun.exe on the Controller as an interactive user (see “Option 3: Launch 
wlrun.exe manually from the Controller host machine” on page 292 for 
configuration details).
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Troubleshooting:

Option 1:

 1 When modifications are made to a script, change the name of the script by 
adding a version number to it. For example, TestScript_1 can be changed to 
TestScript_2. This way, when you upload the updated script, the current 
script remains, and the load test will still run.

 2 Create a new load test, and add the new version of the script to it.

Option 2:

When modifications are made to a script, remove the script from the load 
test, and add it to the load test again.

Note: It is recommended that you use Option 1, as it enables you to keep 
track of your script and load test configuration changes.

Virtual Users Replay Fails
Virtual users are not picking up the correct environment settings and replay 
fails.

Troubleshooting:

Option 1: Check the environment settings and software installation

The load generator machines on which the test is running must have the 
correct software installed, and the proper environment variables set for the 
user.

For Microsoft Media Player:

 1 Log on to the load generator as the Performance Center system user, and run 
Windows Media Player Install for Windows Media version 7.x or later.

 2 Check the System environment variable Path to ensure that Windows Media 
Player path is set correctly. Reboot if necessary for the correct settings to take 
effect.

 3 On the load generator machine, test the script by running it under VuGen.
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For Java:

 1 Log on to the load generator machine as the Performance Center system 
user.

 2 Make sure that the Path environment variable for both User and System do 
not have an instance of Java Virtual Machine. Performance Center retrieves 
the JVM information from the registry.

 3 If the script replays on the VuGen machine where the script was created, 
then copy its CLASSPATH environment variable and place that in the System 
environment variable area of the load generator machine.

 4 On the load generator machine, run a simple script on VuGen to get the 
environment variable settings. Add the following lines to check that the 
environment variables are set correctly:

char *env;

env = getenv(“PATH”);

lr_output_message(“%s”,env);

Note: Be sure to add the protocol definition: char* getenv(char*); at the top 
of the script file.

For Citrix:

 1 Make sure that the Citrix client is installed on the load generator machine.

 2 Run the script through VuGen on the load generator machine.

For Databases:

Make sure that you have the appropriate database client installed on the 
load generator machine, and the appropriate settings in the System Path 
environment variable.
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For Tuxedo:

 1 Make sure that the Tuxedo client is installed on the load generator machine.

 2 Check that the following environment variables are set under System.

➤ Add the tuxedo\bin directory to the Path variable.

➤ TUXDIR - the root directory of the TUXEDO installation. It is called 
ROOTDIR in TUXEDO 4.2 and earlier versions of TUXEDO. This 
environment variable is mandatory on the NT platform. (For example: 
TUXDIR=D:\PSHr755\tuxedo)

➤ NLSPATH - contains subdirectories to support the localisation of system 
messages along with message catalogues for the default locale (U.S. 
English). This environment variable is also mandatory on the NT 
platform. (For example: NLSPATH=$TUXDIR\locale\c)

➤ WSNADDR (May need to be set) - the address of the TUXEDO server. In 
pre-TUXEDO 6.3 versions this is in hex, e.g. 0x0002ffffc7cb4ebd. The 0002 
means IP, ffff indicates the port number, cbcb4ebd indicates the IP address 
of the machine which contains the server. TUXEDO 6.3 also allows a 
more mnemonic way of indicating the server's address. This 
environment variable is mandatory on the NT platform. (For example: 
WSNADDR=199.35.108.119:7000)

➤ ULOGPFX (May need to be set) - prefix for the TUXEDO log file. The name 
of the log file includes the current date represented as a 6 digit number, 
e.g. 081797 for August 17, 1997. The ULOGPFX can contain a directory 
name as well as part of the file name itself. (For example: 
ULOGPFX=/u/markn/ul.)

Note: Be sure to add the protocol definition: char* getenv(char*); at the top 
of the script file.
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Option 2: Configure the Controller to work as an Interactive User

Running a GUI script in Performance Center may cause WinRunner or 
QuickTest Professional to crash due to the configuration of Wlrun.Engine. 

To configure the Controller to work as an Interactive User:

 1 Make sure wlrun process is not running on the machine.

 2 Select Start > Run and type dcomcnfg.

 3 Press ENTER to display the list of DCOM applications.

 4 In the displayed application list perform the following:
For Windows 2000 machines, click wlrun.LrEngine, and then click 
Properties.
For Windows 2003/XP machines, right-click wlrun.LrEngine and select 
Properties. 

 5 In the Identity tab of the dialog, select The interactive user.

 6 Click OK twice to close both dialog boxes.

 7 Log on to the machine in the Performance Center environment as the 
system user. This is the user installed with Performance Center that is 
displayed in the General Settings page of the Administration Site.
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Performance Center runs slowly when configured with 
Oracle 9i and 10g 
Unable to run the load test. Performance Center runs slowly and an error 
may be displayed in the Administration site stating that the connection to 
database timed out. Performance Center is configured with Oracle 10g 
server.

Unable to run the load test. Performance Center runs slowly when 
Performance Center is it configured with Oracle 10g client. There may be an 
error message: Connection to database timed out.

Troubleshooting:

 1 Make sure that you are accessing the database through TNSNAMES and not 
ONAMES.

 2 There is a noticeable and ever increasing time delay connecting to the 
database while using ONAMES. This time delay does not exist if TNSNAMES 
is used. Change priority of TNSNAMES in the SQLNET.ORA file.

Edit <ORACLE>\network\admin\sqlnet.ora file, and set 
NAMES.DIRECTORY_PATH as follows: NAMES.DIRECTORY_PATH = 
(TNSNAMES,ONAMES). TNSNAMES must be the first entry in the 
DIRECTORY_PATH.

 3 Comment out the line SQLNET.AUTHENTICATION_SERVICES= (NTS). This is 
found in <ORACLE>\network\admin\sqlnet.ora file on the database server 
machine.

 4 Validate connection performance to Performance Center database. Run the 
TcQA_CheckDatabaseConnection.vbs script (available as a download from 
the Customer Support Web site Knowledge Base, ID39475) to quantify the 
performance of the connection to the Performance Center database. Make 
sure that the connect times are constant and low.
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The following is an example of a Sample Output:

Database Connection String: Provider=SQLOLEDB.1;User 
ID=OrchidUser;PWD=orchid;Initial Catalog=MI_LRDB;Data 
Source=samurai\mssqla;QuotedID=No

Statistics:

Attempt #1: Connect= 1 secs,  Query= 2 secs

Attempt #2: Connect= 1 secs,  Query= 1 secs

Attempt #3: Connect= 2 secs,  Query= 1 secs

Attempt #4: Connect= 2 secs,  Query= 1 secs

Attempt #5: Connect= 2 secs,  Query= 1 secs

Web Services Related Errors (Failure to run load test, add 
host or retrieve license key)
Errors related to Web Services may occur as a result of problems with the 
.NET Framework installation.

Troubleshooting:

Repair the .NET Framework installation as follows:

 1 Select Start > Run > 

 2 c:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -i

License Manager Component Cannot Be Instantiated
Error Message: Cannot run the load test. Unable to instantiate License 
Manager Component.

Troubleshooting:

If you receive the above error, remove the PCIMkipper process and perform 
an IIS reset.
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Problems in Design Load Test Operations
Load test design problems are often related to the Apache Tomcat 
Application Server. For example, if you are unable to update Design Groups 
or Scheduler while tests are running. 

Troubleshooting:

Perform the following workaround:

 1 Change the Tomcat service user to IUSR_METRO

 2 Go to Start > Run > services.msc 

 3 Double-click on Apache Tomcat > logon tab > This account 

 4 Insert: IUSR_METRO with MIOrchid#1.

Note: Restarting the Apache Tomcat service can also solve problems in this 
area.

Cannot Add Load Test
An error appeared in the add load test page of the User Site

Troubleshooting:

If the ISAPI filters table does not include a filter by the name of 
"jakartaFilter" (under the inetmgr > default website > properties > ISAPI 
Filters):

From the Performance Center bin directory, run the following command:

IISVirDirIsapi.exe addServerFilter jakartaFilter "<performance center installation 
path>\java\tomcat\bin\iis6\isapi_r edirector2.dll" "jakartatomcat" 0
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Cannot Open Load Test Page After Installation
You cannot open the Load Test page after installation (on an SA User site 
installed with Win2000).

Note: This applies when you cannot open the page after the first installation 
when the User Site is SA.

Troubleshooting:

Choose one of the following options:

 1 Reinstall the Tomcat service. 

 a Remove the service from: <Installation Folder>\java\tomcat\bin, run 
the command: service.bat remove (you may need to restart the machine). 

 b Install the service from: <Installation Folder>\java\tomcat\bin, run the 
command: service.bat install

 2 Change the "Log On" user to IUSR_METRO instead of "Local system 
account" to the Tomcat service.

Cannot Run Load Test On Controller with Windows XP - 
Non-Admin System User
If the system user is a non-administrative user, cannot run a load test on a 
Controller host in a Windows XP environment.

Troubleshooting:

Workaround: Add the system user to the machine’s COM Security settings.

To add the system user to the COM Security settings:

 1 Select Start > Run, and type dcomcnfg. The Components Services window 
opens.

 2 Under Console Root\Component Services\Computers, right-click My 
Computer, and select Properties.

 3 In the My Computer Properties dialog box, click the COM Security tab.
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 4 Under Access Permissions, click Edit Default, and add the system user with 
full access to the Default Security.

 5 Under Launch and Activation Permissions, click Edit Default, and add the 
system user with full access to the Default Security.

 6 In the My Computer Properties dialog box, click OK.

Controller Does Not Run Load Test - Non-Admin System 
User
When the system user is a non-administrative user, if you try to run load test 
on a Controller for the first time, the load test does not run.

Troubleshooting:

Before running load tests on a Controller for the first time, you need to open 
the Controller manually, then close it. The next time you try to run a load 
test on the Controller, the load test should run successfully.

To open the Controller manually:

 1 From the command line, run wlrun. The Controller opens.

 2 Close the Controller.

Troubleshooting Hosts

This section provides troubleshooting for the following Host errors:

➤ Host in Resource Failure

➤ Unable to Add a Load Generator due to High Latency
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Host in Resource Failure
Host is in Resource Failure status.

Troubleshooting:

Option 1: Check the host connections

Check the connections between your project’s hosts and the machines 
within your system using the Check Hosts operation in the Hosts page of 
the Administration Site (Resources > Hosts > Check Hosts) or of the User site 
(Project > Hosts > Check Hosts).

 1 If Ping to Host fails:

➤ Make sure the host is up and running, and is connected to the network. 
Check the routing table (netstat –r) and make sure that requests to this 
host are properly routed.

➤ Make sure that the host’s IP address can be properly resolved.

➤ Verify that the ping from the Performance Center Web server, Utility 
server, and Database to the target host is below 20 ms.
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➤ If your firewalls or hosts ignore ICMP requests (pings), use HTTP requests 
to validate response times from the host to the Web server – a simple 
LoadRunner web_url(…) request to http://<server>/loadtest/. Alternatively, 
open a browser and type http://<server>/loadtest in the address field.

 2 If the File Server fails:

➤ Make sure that the host can ping the File server.

➤ Make sure that the Performance Center system user has access to LRFS 
share on the File server. You can verify this by any of the following ways:

➤ In the command line, execute: net use \\fileserver\LRFS / user: 
<Performance_Center_user><Performance_Center_user_password>

➤ Log on to the host machine as Performance Center system user, and in 
the command line, execute: % net use \\fileserver\LRFS

If the above operation fails, check the error message and resolve the 
problem. Contact your Windows administrator for assistance.

➤ Make sure that the security settings on LRFS share allow Performance 
Center system user Full Control.

➤ Make sure that Performance Center system user can create, update, and 
delete files from LRFS share.

➤ Make sure that the Performance Center Web server can launch 
applications on the host. For more information, see “Troubleshooting 
Web Services Connectivity” on page 310.

 3 If the Database fails:

➤ Check the <Performance Center>/bin/globals.ini file and make sure that 
the connection string is correct for the database you are using.

➤ See the troubleshooting for “Login to Oracle Database Hangs” on 
page 265.

➤ See the troubleshooting for “Login to the Database Failed” on page 270 
to verify ADODB connectivity to the database.
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Option 2: Check the Performance Center version

Make sure that you are using the same version of Performance Center on all 
your host and server machines.

Check the registry entry under 
[HKEY_LOCAL_MACHINE\SOFTWARE\Mercury 
Interactive\LoadRunner\CurrentVersion] for the following variables:

➤ Major

➤ Minor

➤ ServicePack

Note: Any patches applied to one machine must be applied to all machines 
if and when applicable.

Option 3: Launch wlrun.exe manually from the Controller host machine

If the host check succeeds, but the host is still not operational, you should 
launch the Controller manually from the Controller host machine as 
follows:

 1 Log on to host machine.

 2 Configure wlrun.LrEngine application to run as Interactive user: 

➤ Launch dcomcnfg.exe.

➤ Under the application tab, select wlrun.LrEngine from the list of DCOM 
applications.
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➤ Click Properties to view the properties for wlrun.LrEngine

➤ In the Identity tab, set the user account to The interactive user.

➤ Click OK and close the DCOMCNFG window.

Note: When you are finished with this step, set wlrun.LrEngine’s Identity 
back to original. By default it is This User with the Performance Center 
user name and password. If you used a different identity, restore it.

 3 Launch the Controller (wlrun.exe) from the <Performance Center>/bin 
directory (on the Controller host).

 4 If an error message is displayed during the startup of the Controller, resolve 
the error message before continuing. For Performance Center to utilize the 
Controller properly, no error messages should be displayed during startup.

 5 Create a new simple load test and reference the scripts from the LRFS share 
(on the Performance Center File server). Run the load test with one or two 
users to check that the Controller works.

Note: Scripts uploaded to the Performance Center LRFS reside under 
\\fileserver\LRFS\<ProjectID>\Scripts directory. To obtain the <ProjectID>, 
select User Management > Projects.

An example path to the USR file for a script named MyTest is:

\\myserver\LRFS\2\Scripts\MyTest\MyTest.usr

 6 Close the Controller (wlrun.exe).

 7 From the Performance Center User site, launch a simple load test.

➤ Check if the following processes are displayed in the task manager on the 
Controller host:

OrchidActiveSession.exe OR ORCHID~1.exe

WLRUN.EXE
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➤ Check if any dialog box is displayed on the Controller that requires user 
input, before the Controller can proceed with the load test. Address the 
reasons for the dialog box being displayed, and make sure that no dialog 
boxes are displayed when re-running the load test from Performance 
Center.

Examples of dialogs that may be displayed include License has expired, 
monitor not licensed, and host is over utilized.

If you are unsure how to resolve the problem indicated in the dialog box, 
contact the Customer Support site (http://support.mercury.com/) for 
assistance.

Note: When you are finished with this step, set wlrun.LrEngine’s identity 
back to original. By default it is This User with the Performance Center 
user name and password. If you used a different identity, restore it. 

Option 4: Reinstall Performance Center Host on the host machine

If all of the above steps fail to resolve the problem, reinstall the Performance 
Center Host on the host machine.

➤ Uninstall HP Performance Center (Start > Settings > Control Panel > 
Add/Remove Programs). (This is really the Performance Center Host.)

➤ Delete HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive from 
the registry.

➤ Re-install the Performance Center Host. For more information, see the HP 
Performance Center System Configuration and Installation Guide. Make sure 
that you install the same version of Performance Center as is installed on 
your Web Server.

Note: Do not install a Performance Center server (e.g. Utility, Web Server, 
File Server) on the same machine as the Performance Center host (for 
example, data processor, Controller, load generator).
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Unable to Add a Load Generator due to High Latency 
Unable to add a load generator host due to high network latency or the 
network policy.

You may have a problem adding a host to the Performance Center 
Administration Site as a load generator, if the host has a ping time of greater 
than 50 ms. This only applies to hosts added as load generators.

Troubleshooting:

 1 Create a temporary host location over a firewall.

 a In the Host Locations page, click Add Host Location.

 b In the Host Location field, type TempOverFirewall.

 c Set Located over Firewall to Yes. (By using the Located over Firewall 
option, many checks that are performed on host machines will not be 
performed.)

 d Click OK.

 2 Add a new host to the temporary location

 a In the Hosts page, click Add Host.

 b In the Name field, type add.

 c In the Purpose field, select Load Generator.

 d From the Location list, select TempOverFirewall.

 e From the Host Pool list, select the correct host pool.

 f Click Save, and then click OK to confirm.

 g Select the host that was added from the host list.

 h Change the location to the correct location. (Placing the host in the over 
firewall location was done just to bypass some checking that 
Performance Center does when adding host machines.)

 i Click OK. In the next two message boxes that are displayed, click OK.

 3 Repeat Step 2 for all load generators that have high network latency.
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Troubleshooting Web Problems

This section provides troubleshooting for the following Web errors:

➤ HTTP 500.x - Internal Server Error

➤ Cannot Find Server or DNS Error

➤ Administration Site Page cannot be Displayed

➤ Unable to Log on to the Administration/User Site

➤ PC Maintenance Service Causes IIS Resets

➤ HTTP/1.1 100 Continue Randomly Appears

HTTP 500.x - Internal Server Error
Error message: “The page cannot be displayed” – HTTP 500.x Internal Server 
Error.
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Troubleshooting:

 1 Reset IIS (Start > Programs > Administrative Tools > Services). Locate IIS 
Admin Service and click Restart Service.

 2 (IIS 5 only) If you cannot restart IIS, reboot the machine.

Make sure both the Administrator Site and the User Site are set to 
Application protection level High (isolated) in the Internet Services 
Manager. To set the protection level, see “Option 1: Set the Application 
Protection level to High (isolated)” on page 265.

 3 Reset the Tomcat service on the User site server.

 4 The error may be caused by your anti-virus software. Make sure that the 
anti-virus software is not checking the Performance Center Installation 
directory and sub-directories. Also make sure that the anti-virus program is 
not checking the File Server directory (generally LRFS).

 5 If you are still receiving an error, enable App Debugging on the Web server:

 a Choose Start > Programs > Administrative Tools > Internet Services 
Manager.

 b Right-click the Default Web Site, and click Properties.

 c In the Home Directory tab, click Configuration, and click the App 
Debugging tab.

 d Select the Enable ASP server-side script debugging and Enable ASP 
client-side script debugging check boxes.
297



Appendix B • Troubleshooting Performance Center
 e Select Send detailed ASP error messages to client.

 f Click OK to apply your changes.

 g Restart IIS. Choose Start > Programs > Administrative Tools > Services. 
Find IIS Admin Service and click Restart Service.

 h If an error page is displayed again, check the new error message provided 
on the page, and contact Customer Support (http://support.mercury.com/) 
for assistance.
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Cannot Find Server or DNS Error
Error message: The page cannot be displayed – Cannot find server or DNS 
Error.

Troubleshooting:

 1 Make sure that you entered the correct URL address.

 2 Check to see that you have access to the Web server.

➤ Use the ping command if you do not have a firewall blocking ICMP 
requests to your Web servers.

➤ From a command prompt, execute: ping <Web server>

➤ From a command prompt, execute: ping <IP Address of Web server>
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 3 On the Web server, verify that IIS is up and running:

 a Choose Start > Programs > Administrative Tools > Services.

 b Make sure IIS Admin Service is Started and that Startup type is set to 
Automatic.

 c Make sure World Wide Web Publishing Service is Started and that 
Startup type is set to Automatic.

 4 Reset IIS. Choose Start > Programs > Administrative Tools > Services. Find 
IIS Admin Service and click Restart Service.

Administration Site Page cannot be Displayed
The Administration Site is not displayed correctly, or it displays the error 
message: Page cannot be displayed.

Troubleshooting:

➤ If the Administration Site is not displaying correctly, recreate the 
Administration Site by running 
<Performance Center Path>\bin\AdminInstaller.exe 1

➤ If the page cannot be displayed:

➤ Close the current browser. Relaunch the browser, and try to open the 
Administration Site again.

➤ Choose Tools > Internet Options from the menu. In the General tab, click 
Settings. In the Check for newer versions of stored pages section, make 
sure that the Every visit to the page option is selected.

➤ Clear the browser cache and cookies.

➤ If the problem is still not resolved, try to open the Administration Site 
from a different machine.

➤ Reset IIS. (Start > Programs > Administrative Tools > Services). Locate IIS 
Admin Service and click restart service.
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Unable to Log on to the Administration/User Site
Unable to log in to the Administration Site or the User site. The system 
appears to spin.

Troubleshooting:

 1 (IIS 5 only) Make sure both the Administration Site and the User site are set 
to Application protection level High (isolated) in the Internet Services 
Manager. For more information, see “Option 1: Set the Application 
Protection level to High (isolated)” on page 265.

 2 This may be caused by a permissions level problem with the 
IWAM_<SERVER> user. By default this account is set to Guest permission 
level. The IWAM_<SERVER> user needs to have read/execute privileges on 
the Oracle home directory and all of its sub-directories.

 a In Windows Explorer, right-click the Oracle home directory, and choose 
Properties.

 b Click the Security tab.

 c Click Add and add IWAM_<SERVER> user.

 d Check Read & Execute.

 e Click OK.

PC Maintenance Service Causes IIS Resets 
IIS is reset every 10 minutes by the maintenance service. The maintenance 
service log shows that the HTTP call to MemorySize.asp had a timeout (60 
sec.) and after three retries, the service reset IIS (as it was designed to do).

Troubleshooting:

Make sure the Utility Server is not configured to work through a proxy that 
might block the HTTP call. To disable the proxy setting, search the registry 
for the key ProxyEnable in the Internet Setting folders and set it to zero.
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HTTP/1.1 100 Continue Randomly Appears 
Message HTTP/1.1 100 Continue randomly appears in the middle of a 
response stream. 

Troubleshooting:

If you installed the User Site server or Administration Site server on a 
Windows Server 2003 SP1 machine, download the Microsoft patch from the 
the Microsoft Support site (http://support.microsoft.com/kb/898708). This 
patch addresses a known Microsoft issue, when running IIS 6.0 on a 
Windows Server 2003 machine.

Troubleshooting Performance Center Monitors

This section provides troubleshooting for Performance Center monitor 
errors.

Cannot Create a Monitor
Unable to create a specific monitor.

Troubleshooting:

 1 Make sure that the user trying to access the machine to monitor has proper 
privileges and that the user exists on the machine you are trying to monitor. 
Usually IUSR_METRO will be the user attempting to monitor. Make sure that 
IUSR_METRO exists on those machines and has the proper permissions.

➤ For example, trying to add the Windows Resources monitor requires that 
IUSR_METRO exist on the machine to be monitored and that it has 
proper access rights.

 2 Some monitors require certain clients to reside on the Utility Server and the 
Controller.

➤ For BroadVision, you need to have JDK installed.

➤ For WebLogic, you need to have JDK and the weblogic.jar file.
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➤ For Oracle, you need to have the Oracle Client.

➤ For DB2, you need to have the DB2 administrative client. (OS390 is not 
supported.)

 3 Make sure the agent required for a particular monitor is running on the 
machine that you want to monitor.

 4 For COM+, make sure that the COM+ probe is running on the machine that 
you want to monitor.

 5 Some monitors require access to a particular URL for monitoring purposes 
from both the Performance Center Utility server and the Controller:

➤ For Apache: http://<server>:<port>/server-status:auto

➤ For Websphere 4.x & 5.x: 
http://<server>:<port>/wasPerftool/ervlet/perfservlet

Troubleshooting VuGen and Analysis Integration

This section provides troubleshooting for VuGen and Analysis integration 
errors.

Uploading a Script from VuGen Fails
Uploading a script from VuGen fails with an error message.

Troubleshooting:

 1 Make sure the machine is not configured to use a proxy server, and disable it 
if it is. Search the registry for the key ProxyEnable in the Internet Settings 
folders and set it to zero. 

 2 Check if there are upload timeouts due to a slow network connection. In the 
<Performance Center installation>\dat directory there is a configuration file 
called OrchidCommUtils.dat that holds the integration communication 
settings. To change the default timeout (60 sec.), you need to enable the key 
http_timeout_secs and change its value.

 3 If none of the above troubleshooting helps, you can create a log file that 
provides more information and send it to Customer Support 
(http://support.mercury.com/). To create the log file, enable the log_file key.
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Troubleshooting System Identity

This section provides troubleshooting for the following system identity 
issues:

➤ PC-Admin System User - Still Requests Configuration User

➤ Connecting to Admin/User Site - Service Unavailable

➤ Cannot Run Load Test with Non-Admin User

➤ Adding Permissions to Folder/Registry

➤ Identity References Cannot Be Translated

➤ Cannot Add Host as Performance Center Host

➤ Server/Host Configuration Problems

➤ Admin Tasks Take Long Time/Time-Out/ ThreadAbortException

➤ Change User - Conflicting Credentials

➤ Oracle Database - Cannot Change System User to Non-Admin User

➤ Remote Management Agent Service Disabled After Changing System User

➤ SiteScope Server Fails to Retrieve Data from Hosts/Servers

PC-Admin System User - Still Requests Configuration User
Pop up for administrator account comes up even when the Performance 
Center system user is an administrator.

Troubleshooting:

➤ Check that you can reach the Web service using the browser. 

➤ Check that the system user exists on the machine.

➤ Check if the ASP.NET V2.0 extention was installed/allowed in IIS. 

➤ Check that you have the PCWS virtual directory.
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Connecting to Admin/User Site - Service Unavailable 
When trying to connect to the Administration or User site Web servers, get 
"Service unavailable" or "You are not authorized to view this page" error 
pages.

Troubleshooting:

➤ Check that the Administration site virtual directory user exists.

➤ Check that the user has all the required policies.

➤ Check that the application pool is not locked. If it is, check the event viewer 
for the reason.

➤ Check that the security policy configuration of the customer domain is 
compatible with the configuration of Performance Center environment. 

Cannot Run Load Test with Non-Admin User
Cannot run load test after change user or with non-admin system user.

Troubleshooting:

➤ Check that all the required services are running.

➤ Try to run alagentservice and magentservice using the following commands:

➤ alagentservice

where username and password are those of the Performance Center 
system user.

%installation folder%\al_agent\bin\alagentservice.exe -remove 

%installation folder%\al_agent\bin\alagentservice.exe -install username password 
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➤ magentservice

where username and password are those of the Performance Center 
system user.

➤ If the load test fails in the first step, check the LRFS folder. If there is a 
problem with configuring the LRFS folder try to restart the machine. 

➤ Check the identity of the COM objects, especially OrchidActiveSession and 
wlrun.lrengine. The identity should be the Performance Center system user.

Adding Permissions to Folder/Registry
Error when adding permission to one of the file/folders or registry keys. 

Troubleshooting:

➤ Try to reconfigure the use case again (by clicking the Reconfigure button in 
the System Identity utility).

➤ Reboot the machine and click the Reconfigure button in the System Identity 
utility. 

➤ Clean out all the unrecognized users from the folder/registry. 

Identity References Cannot Be Translated
You try to configure the system and you get the following error on some 
servers: Some or all identity references could not be translated.

Troubleshooting:

➤ Check that the configuration user is not the same user with which you are 
logged on to the system. If you are logged on to the system with the 
configuration user, log off and then log on again with a different user. 

➤ Reset IIS on the machine that has the error.

%installation folder%\launch_service\bin\magentservice.exe -remove 

%installation folder%\launch_service\bin\magentservice.exe -install username 
password
306



Appendix B • Troubleshooting Performance Center
Cannot Add Host as Performance Center Host
When trying to add a host and you get an error saying that Performance 
Center can not identify the host as a Performance Center host installation. 

Troubleshooting:

Check that the identity of the ManagmentUtil.exe COM object is the 
Performance Center system user.

Server/Host Configuration Problems
When trying to configure a server or host from the System Identity utililty, 
following error appears: 

“System.Web.Services.Protocols.SoapException: Server was unable to 
process request. ---> Unable to generate a temporary class...”

Troubleshooting:

Grant full access permission for the user IWAM_<Machine_name> on the 
%windir%\temp directory.

Admin Tasks Take Long Time/Time-Out/
ThreadAbortException
When the system user is a non-administration user (lock down mode), 
changing the system user or adding a host takes a long time or a time-out 
event or ThreadAbort exception occurs.

Troubleshooting:

In lock-down mode permissions are granted to specific directories, files and 
registry keys that Performance Center needs in order to run. Check the 
Security tab of these resources for deleted users/groups (SIDs). These deleted 
SIDs increase the time it takes to perform tasks such as granting permissions 
to a resource. To reduce the performance time for these tasks, clean out all 
the deleted SIDs. 
307



Appendix B • Troubleshooting Performance Center
Change User - Conflicting Credentials
When using the System Identity utility to change the system user, get the 
following error: The credentials supplied conflict with an existing set of 
credentials.

Troubleshooting:

Check that the configuration user is not the same user with which you are 
logged on to the system. If you are logged on to the system with the 
configuration user, log off and then log on again with a different user. (This 
problem may be caused due to a Microsoft limitation. For more information, 
see the Microsoft TechNet Web site (http://www.microsoft.com/technet/
prodtechnol/windows2000serv/reskit/w2000Msgs/3860.mspx?mfr=true).

Oracle Database - Cannot Change System User to Non-
Admin User
When working with an Oracle database, you cannot change the system user 
to a non-administrative system user.

Troubleshooting:

Before changing the system user to a non-administrative user, you need to 
disable the sqlnet authentication services option of the Oracle client on 
each of the Performance Center servers and hosts. 

To disable the sqlnet authentication services option:

 1 In the Oracle installation directory, open the sqlnet.ora file. For example, 

 2 Locate the following line:

 3 At the beginning of this line, insert a # symbol.

 4 Save the file.

C:\ORACLE\product\10.2\client_1\network\admin\sqlnet.ora

SQLNET.AUTHENTICATION_SERVICES = (NTS)
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Remote Management Agent Service Disabled After 
Changing System User
After you change the system user to a non-administrative system user, the 
Remote Management Agent service is disabled.

Troubleshooting:

 1 Restart the machine.

 2 Run the Remote Management Agent service using the following command:

where username and password are those of the Performance Center system 
user.

SiteScope Server Fails to Retrieve Data from Hosts/Servers
If you change the system user to a non-administrative user, and then enable 
SiteScope on any of the Performance Center servers or hosts, SiteScope 
cannot retrieve all required data.

Troubleshooting:

Manually configure an administrative user on the SiteScope server so that it 
has permissions to monitor the server/hosts machines and retrieve all the 
required data.

To configure an administrative user on the SiteScope server:

 1 In your browser, enter the URL for SiteScope as follows:

where sitescope_server is the name of your SiteScope server.

 2 At the top of the SiteScope page, click SiteScope.

 3 Click Remote Windows.

 4 From the list, select the relevant machine, and click Edit.

%installation folder%\al_agent\bin\alagentservice.exe -remove 

%installation folder%\al_agent\bin\alagentservice.exe -install username password 

http://<sitescope_server>:8888/sitescope
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 5 In the Login and Password fields, enter the login name and password of an 
system user with administrative privileges.

 6 Click Update.

Troubleshooting Web Services Connectivity

This section provides troubleshooting for Web services connectivity issues. 

Important: The following troubleshooting tips apply to the Web services 
requester agent machine.

After each troubleshooting attempt described below, you can test your Web 
services connectivity using the test described in “Testing Web Services 
Connectivity” on page 311.

To troubleshoot Web services Connectivity:

➤ Check that the PCWS virtual directory exists in IIS.

➤ If you are using IIS 6, check that the ASP.NET V2.0 extention was installed 
and allowed in IIS.

➤ If you are using IIS 6, check that the PCWSAppPool application pool is not 
locked. If it is locked, you can check the event viewer for the reason. 

➤ If you are using IIS 5, grant full access permission for 
IWAM_<Machine_name> on the %windir%\temp directory.

➤ Check that the Performance Center system user exists on the machine.

➤ Check that the following policies are defined for the Performance Center 
system user:

➤ Batch logon rights

➤ Service logon rights

➤ Access this computer from the network
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Testing Web Services Connectivity
After you troubleshoot Web Services connectivity, you can test your Web 
Services connectivity by trying to access the Performance Center ConfigWS 
Web services on the requester agent machine.

To Test Web Services connectivity:

 1 On the requester agent machine, enter the following URL:

http://<provider agent machine>/PCWS/ConfigWS.asmx

 2 In the Enter Network Password box, enter your Performance Center system 
user login details.

The ConfigWS Web service page opens. 

If this page does not open, it means that there is still a problem with the 
Web services connectivity and you should continue to troubleshoot this 
issue.

 3 Click the IsAvailable operation.
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 4 On the IsAvailable operation page, click Invoke.

If this action returns a value of True, the Web services connectivity is 
operational. 
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This document lists terminology that is used throughout HP Performance 
Center.

Administration Site

The Administration Site provides overall resource management and 
technical supervision of the system. The administrator performs 
functions such as assigning user privileges, creating projects, and 
managing resource usage through the Administration Web site.

Agent

See Performance Center Agent.

alert

A notification that HP Performance Center sends to make designated 
users aware of performance issues. Alerts are sent by e-mail.

Analysis

An HP tool for viewing performance analysis data in reports and 
graphs. 

Analysis Integration

Standalone Analysis integrates with Performance Center to let you 
quickly and easily analyze data collected during a Performance Center 
run. Load test data can be analyzed off-line by connecting to 
Performance Center from Standalone Analysis and downloading 
result and session files. After analyzing the data, you can upload the 
session files and reports to Performance Center. 
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authentication

A process that enables access to resources. To authorize access to 
resources, applications first need to authenticate the source of the 
request. Authentication is the process by which the identity of a 
subject is verified, and must be performed in a secure fashion. 
Authentication typically involves the subject demonstrating some 
form of evidence to prove its identity. Such evidence may be a 
password, fingerprint, or signed data using a private key.

Autostart

A feature that starts a load test run automatically. An Autostart test 
automatically begins the run at the start of the timeslot it is associated 
with.

availability

The percentage of time that a business process, monitored 
infrastructure component, or service is up and running.

business process

A series of steps typically performed in applications, which are 
emulated using scripts recorded with HP recording tools and run by 
the HP Performance Center host machines. For example, load 
generators run scripts that describe the activity that is to be monitored 
on the end-user machines. A script consists of transactions—an action 
or a set of actions that you are interested in measuring. By combining 
several transactions, you can define a business process to provide you 
with data for a complete activity.

CA

Certification Authority – A trusted third-party organization or 
company that issues digital certificates used to create digital 
signatures and public-private key pairs.

certificate

A stream of bytes that represent a signed authorization from a trusted 
source that is used to perform an SSL encryption.
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Citrix Agent

An agent installed on the server machine that enhances VuGen’s 
capabilities in identifying Citrix client objects.

Collation

At the conclusion of the test run, the Load Generators send the results 
back to the Controller. The Controller merges all the Load Generator 
results into a single package in a process called “collation”.

Command Line

Using the Command Line interface, you can pass arguments to 
instruct the Controller how to behave. This enables you to configure 
load test settings without having to manually define them using the 
UI.

Container

A Performance Center object that contains Performance Center 
resources, assets, and other Performance Center containers. 

Controller

A machine that is used to design and manage a load test. During a 
test, the Controller issues instructions to the Load Generators 
including which scripts to run, how many Vusers to run per script, 
and Ramp Up timing. At the conclusion of the test run, the Controller 
collates the results. There is only one Controller per load test.

Dashboard 

The HP Performance Center Project Dashboard provides an overview 
of your project's status, as well as the drill-down capability to view 
individual load test performance. The status and performance data are 
relative to the target criteria you establish for your application.

Data Processor

A Data Processor machine is used for publishing information to the 
Project Dashboard. Although it is possible to set a machine as a 
Controller and a Data Processor, it is not recommended. 
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Database Server

The database server forms the infrastructure for persistent data within 
Performance Center. The database server holds information on users, 
projects, host information, and load tests. 

Diagnostics

Performance Center's diagnostics modules provide monitors that 
trace, time, and troubleshoot individual transactions that rapidly 
identify and pinpoint performance problems in J2EE, .NET, Siebel, 
Oracle, and SAP environments. These monitors help you to maximize 
business process performance, scalability, and efficiency.

EJB

Enterprise JavaBeans™ – A component architecture for the 
development and deployment of object-oriented, distributed, 
enterprise-level applications. Applications written using the Enterprise 
JavaBeans architecture are scalable, transactional, and secure. 

File Server

The file server forms the infrastructure for persistent data within 
Performance Center. The file server holds the test scripts and test 
results.

Firewall Agent

An agent that is used for monitoring and running Vusers over a 
firewall. There are two types of agents: the MI Agent and the Monitor 
Over Firewall Agent.
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granularity

Determines how many measurement samples the HP Performance 
Center displays in reports. By default, reports are limited to a 
maximum of 31 samples. Thus, for example, if you select the Day time 
range and the minutes granularity, since there are 1,440 minutes in a 
day and a maximum of 31 samples on a graph, the granularity ranges 
from every 47 minutes (1440/31=46.4, rounded up to 47) to every 59 
minutes (above 59 minutes, you use the hour granularity unit).

Additional examples:

If you select the Day time range and a granularity of every 1 hour, HP 
Performance Center displays the report using 24 samples 
(1 hour x 24 = 1 day).

If you select the Month time range and a granularity of every 1 week, 
HP Performance Center displays the report using 4 samples 
(1 week x 4 = 1 month). 

GUI Vuser

GUI Vusers operate graphical user interface (GUI) applications. These 
applications can run in a Microsoft Windows environment. Each GUI 
Vuser that you develop emulates a real user by submitting input to, 
and receiving output from, GUI applications. GUI Vusers are created 
using HP’s GUI testing tools: WinRunner (for Microsoft Windows 
applications), and Astra QuickTest (for Web applications). You can run 
only a single GUI Vuser on a Windows-based load generator. Use 
terminal sessions to run multiply GUI Vusers.

host

A machine which can be used to control or run Vusers, and process 
collected data. Each host machine can be designated as a Controller, 
Load Generator, or Data Processor.

Host Checkup Service

The Host Checkup Service detects hosts in the resource failure status 
and recovers them (if possible) to the operational status.

Host License

The HP Performance Center license which is automatically installed 
on the hosts as you add them to the system.
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ICF

Windows Firewall, previously known as Internet Connection Firewall 
or ICF. See Personal Firewall.

IIS Maintenance Services

IIS Maintenance Services verify that IIS is operational, performs IIS 
memory checks, and restarts IIS in case of memory leakage or if the 
specified memory limit is exceeded.

IIS Restart

Restarts IIS at a set time every day. Restarting IIS increases 
Performance Center stability and is highly recommended. IIS Restart 
does not affect running tests, and users can reconnect to tests and 
view progress.

INF file

An information file that opens in the Snapshot Viewer, enabling you 
to view a snapshot of an error from the Vuser log. See also SOE file.

Initialization

The state of preparing Vusers and Load Generators for a load test run 
(‘Init”). Initializing Vusers before Ramp Up reduces CPU consumption 
and helps provide more realistic results. The length of the 
initialization state varies between Vusers.

IP address

A unique address that identifies a host on a network. It identifies a 
computer as a 32-bit address that is unique across a Transmission 
Control Protocol/Internet Protocol (TCP/IP) network. An IP address is 
usually represented in dotted-decimal notation, which depicts each 
octet (eight bits, or one byte) of an IP address as its decimal value and 
separates each octet with a period. For example, 172.16.255.255.

IP Spoofing

A feature that enables Vusers running on a single machine to be 
identified by many IP addresses. The server and router recognize the 
Vusers as coming from different machines and as a result, the testing 
environment is more realistic. 
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J2EE

Java 2 Enterprise Edition – The J2EE platform manages the 
infrastructure and supports the Web services to enable development 
of secure, robust, and interoperable business applications.

J2EE application

Any deployable unit of J2EE functionality. This can be a single module 
or a group of modules packaged into an .ear file with a J2EE 
application deployment descriptor. J2EE applications are typically 
engineered to be distributed across multiple computing tiers.

JBoss

An Open Source, standards-compliant application server 
implemented in 100% pure Java that is based on the J2EE 
specification.

JDBC

Java Database Connectivity – An industry standard for database-
independent connectivity between the Java platform and a wide 
range of databases. The JDBC interface provides a call-level API for 
MS SQL-based access.

JNDI

Java Naming and Directory Interface – A standard extension to the 
Java platform, providing Java technology-enabled applications with a 
unified interface to multiple naming and directory services in the 
enterprise. 

JSP

Java Server Page™ – An extension to the Java servlet technology 
developed by Sun.

Layer

A layer is defined as the generic term given to signify J2EE resources 
that can be grouped together for meaningful analysis, and for display 
in the Diagnostics pages. Examples of layers: entity beans, servlets, 
JDBC, and so forth; classes that inherit from a common ancestor; 
components that adhere to a specific API; classes that provide a 
common service; and custom classes with a common significance.
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Load Generator

A machine on which Vusers are run during a load test. There can be 
any number of Load Generators for a given load test. Load Generators 
are configured inside a Host Pool with other Load Generators and at 
least one Controller.

Load Preview

Displays a graph of the load behavior you defined in the Scheduler. 
See also Scheduler.

measurement

A data unit that measures performance.

HP Virtual User Generator

A tool for recording Virtual User scripts. VuGen creates a Vuser script 
by recording the actions that you perform on a client application. 
When you run the recorded script, the resulting Vuser emulates the 
user activity between the client and server. Vuser scripts include 
functions that measure and record system performance during load-
testing sessions. During a load test run, you can monitor application 
performance. 

monitor 

A component used by HP Performance Center to collect data.

Monitor Agent

See Firewall Agent.

Monitor Profile

The server resource monitoring settings for a load test that can be 
used by any test in your project. A monitor profile includes the type of 
monitors to run, the servers whose resources you want to monitor, 
and the measurements you want to monitor on each server. 

MI Agent

An agent that runs Vusers over the firewall. The MI agent reports its 
information to the MI Listener either directly or through a proxy 
server, depending on the system configuration.
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MI Listener

A component that serves as router between the Controller and the 
Monitor Agent. The MI Listener receives data from the Monitor Agent 
at regular intervals. During the course of the load test, the Controller 
solicits the data from the MI Listener to process as run-time data. 

Monitor Over Firewall Agent

An agent that monitors Vusers over the firewall. The Monitor Over 
Firewall agent reports its information to the MI Listener either directly 
or through a proxy server, depending on the system configuration.

Monitor Server

The application under test (AUT) server that you are monitoring.

Net use trust

To monitor the application under test (AUT), you must have a trust 
between the Utility server\Host and the AUT, otherwise you won’t be 
able to take measurements and create a monitor profile. This trust is 
provided by the user supplying an administrator user name and 
password on the AUT.

node

In Dashboard, an entry in a hierarchical tree in the Dashboard, 
representing a group, subgroup, monitor, transaction, and so forth.

Patch

A modification or update to Performance Center that contains bug 
fixes or feature enhancements.

Performance Center Agent

The Performance Center Agent runs on the load generator machines 
and enables communication between the Controller, Load 
Generators, and MI Listeners (in firewall configurations). The agent 
receives instructions from the Controller to initialize, run, pause, and 
stop Vusers. At the same time, the agent also relays data on the status 
of the Vusers back to the Controller. The Performance Center Agent 
also enables communication between the Controller and terminal 
sessions (if the agent is configured with terminal sessions enabled). 
See also Terminal Session.
321



Glossary
Performance Center License

The Performance Center License—a function of your Vuser limit, 
concurrent runs limit, and expiry date—enables you to use the 
Performance Center. You receive the license key when you purchase 
Performance Center, and you enter the license key in the 
Administration Site after installing all Performance Center 
components.

Personal Firewall 

Windows Firewall, previously known as Internet Connection Firewall 
or ICF, is a built–in basic firewall included as a Windows 
2000/Windows XP networking feature. It is a protective boundary 
that monitors and restricts information that travels between your 
computer and a network or the Internet. Note: HP Performance 
Center supports Windows XP Service Pack 2 provided the firewall is 
turned off (the firewall is turned on by default).

Pop-up Blocker

When you install Windows 2003/XP SP2, Pop-up Blocker is turned on 
in Internet Explorer and set to the medium setting, which blocks most 
automatic pop-ups. If Pop-up Blocker blocks pop-up windows that 
you open deliberately in Performance Center by clicking a link, you 
should turn it off when using Performance Center.

Ramp Up

Settings that define how you start running Vusers within a load test.

Ramp Down

Settings that define how you stop Vusers within a load test.

Raw results

The raw results file contains the original raw analysis data which is 
automatically generated by Performance Center during a load test 
run. You cannot delete the raw results file.
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Remote Management Agent

The Remote Management Agent enables you to manage remote 
machines from the Administration site (for example, view login 
information, install patches, and reboot hosts/servers). The Remote 
Management Agent is automatically installed when performing a 
Performance Center Server or Host installation.

Rendezvous Points

Rendezvous points instruct Vusers to wait during test execution for 
multiple Vusers to arrive at a certain point, so that they may 
simultaneously perform a task. Rendezvous points are inserted into 
Vuser scripts to emulate heavy user load on the server. 

report

A presentation of data collected by the HP data collectors. HP 
Performance Center reports display a variety of data that enable you 
to track and analyze the performance of monitored applications and 
infrastructure components.

Run-Time Settings

Settings that enable you to define the way that the script runs, and 
emulate different kinds of user activity. Run-time settings are applied 
to Vusers when a script is run using VuGen or the Controller.

Scheduler

A component that enables you to set the timing aspects of the load 
test run. You can set the start time, the duration of the load test or 
Vuser groups within the load test, and the initialization, ramp up, and 
ramp down time.

script

The actions that a Vuser performs during the load test run are 
described in a Vuser script. An action or a set of actions that you want 
to measure are represented by a transaction. You record and save 
scripts in HP Performance Center recording tools, such as HP Virtual 
User Generator.
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session data

Session data is automatically generated by Performance Center and 
displays information and layout settings for the active graphs. You 
can delete or overwrite the session data file.

SiteScope

A HP Performance Center data collector used for collecting 
performance data from network, application, database, and Web 
servers.

SiteScope measurement

A measured SiteScope value. Transaction time, database query time, 
and CPU utilization are all examples of SiteScope measurements.

SiteScope monitor

A set of configurations that enables the collection of data for one 
aspect of the monitored environment (for example, a specific type of 
server). A monitor reports a status of OK, warning, or error, based on 
criteria that you can control.

Snapshot 

A graphical representation of the Web page, at the point when an 
error occurred during the load test run. If the Vuser log indicates that 
a step has a snapshot, you can view a snapshot of the error from the 
Vuser log, or download the snapshot and view the entire 
page/individual frames in the Snapshot Viewer. You can also view an 
individual frame from an active run. See also Snapshot Viewer. 

Snapshot Viewer

The Snapshot Viewer enables you to view snapshot on error pages 
captured from Web virtual users during load test runs. This viewer 
displays snapshots from files of .SOE and .INF extension. The 
Snapshot Viewer can be downloaded from the Download page of the 
Performance Center User Site.
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SOE file

A Snapshot On Error (.SOE) file is a GNU-Zipped file containing one 
or more snapshots represented by .INF files. Each snapshot can 
contain several frames and sub-frames, and can be viewed using the 
Snapshot Viewer. 

SSL

Secure Sockets Layer, the leading security protocol that encrypts and 
decrypts a message for online transmission and authentication.

System User Account

Performance Center uses the system user to communicate between 
components and activate processes from components on a remote 
machine. The administrator can configure the system user for all 
servers and hosts in the Performance Center environment from the 
General Settings page.

Terminal Session

A client session on a terminal server. A terminal server client can have 
multiple terminal sessions running simultaneously, thereby 
overcoming the limitation of being able to run only a single GUI 
Vuser on a Windows-based load generator. By opening a terminal 
session for each GUI Vuser, you can run multiple GUI Vusers on the 
same application. You can configure terminal sessions during load test 
configuration or at run time.

Timeslot

A timeslot is used to reserve the hosts and Vusers required to run a 
load test for your application. Reserving a timeslot sets aside resources 
to run a load test.

transaction

Any series of steps that an end user performs in an application, whose 
performance you want to monitor. Transactions are recorded using HP 
Virtual User Generator recording tools and saved in scripts. When 
replayed, transaction response time and availability data is collected. 
You view transaction performance data in HP Performance Center 
reports.
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transaction breakdown

A function of HP Performance Center that enables transaction 
response time data to be broken down and viewed according to time 
spent on the network, server, and client.

transaction response time

The time it takes for a prerecorded transaction to be completed.

User Site

The User Site is the window used to design, execute, and monitor load 
tests. The users create tests, reserve resources, run tests, and receive 
analysis information through the User Site.

User Status

User Status is used to determine user access to Performance Center. A 
user with Active status can log in to Performance Center. A user with 
Non-Active status cannot log in to Performance Center. User Status is 
displayed in the Personal Information and Users page of the Privilege 
Manager.

Utility Server

The Utility server provides a centralized location for specific 
information that can exist only once within the system. The License 
Manager, AutoRun schedules, and Monitor Profiles reside on the 
utility server.

Virtual Load Generator

A Virtual Load Generator is an automatically generated placeholder 
name for an actual load generator that will run the script. When 
creating a load test, you can choose automatic or manual distribution 
of scripts to machines. If you select manual script distribution, you 
choose the actual load generator that you want to assign to each 
virtual load generator at run time.

Virtual User Generator

A tool for recording Virtual User scripts. The scripts are run by 
Business Process profiles to emulate end-user experience and monitor 
application performance.
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Vusers

Performance Center replaces human users with virtual users or Vusers. 
When you run a load test, Vusers emulate the actions of human users 
working with your application. See also GUI Vuser.

VM

Virtual Machine – A “machine within a machine” that mimics a real 
Java processor, enabling Java bytecode to be executed as actions or 
operating system calls on any processor regardless of the operating 
system. 

Windows Firewall

See Personal Firewall.
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